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Bienvenido a tu curso 

Revit Structure Fundamentos Concreto y Armado 

  

Al terminar este curso conocerás el concepto de BIM y como implementar Revit en 

proyectos de construcción basados en esta metodología. Los instructores brindan 

capacitación práctica para la creación de modelos utilizando los elementos 

estructurales incluidos en Revit. En la guía encontrarás descripciones, 

consideraciones y recomendaciones clave centradas en la implementación del 

proceso que ayudarán a cumplir las necesidades de tus proyectos. 

 

Al término del curso podrás realizar modificaciones básicas a elementos 

estructurales, adaptarlos a los requisitos de proyecto y modificar la estructura de 

los componentes básicos de un modelo estructural. 

 

Preguntas frecuentes sobre nuestros Cursos Presenciales  

 

Preguntas frecuentes sobre nuestros Cursos Online 

 

https://youtu.be/ZsW2LRKwdzE
https://youtu.be/jpGtRSkx8nE
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Derechos reservados 

© Todos los derechos reservados Darco© 

 
Todos los materiales contenidos en este sitio (incluyendo, pero no limitado a, texto, 
logotipos, contenido, imágenes [animadas y estáticas], iconos videos y fotografías, entre 
otros) están protegidos por las leyes de Derechos de Autor y Propiedad Industrial, tanto 
nacionales como internacionales. 
 
En relación con todo lo contenido en esta guía de estudio, se prohíbe la reproducción, 
uso, copia, impresión, distribución, publicación, traducción, adaptación, reordenación y 
cualquier otro uso o modificación total o parcial de los datos y obras contenidos en esta 
página, por cualquier medio y, de cualquier forma. 
 
Para cualquier asunto relacionado con este aviso, por favor contacte a 
darco@darco.com.mx 
 
Aviso de Privacidad 
 
La privacidad de sus datos personales es de gran importancia para Darco por lo que 
hacemos de su conocimiento nuestro Aviso de Privacidad en 
www.darco.com.mx/privacidad 

 
Darco© es una marca registrada 
Autodesk© es una marca registrada 
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GLOSARIO 
 

• BIM: Building Information Modeling. Es un conjunto de tecnologías, procesos y 
políticas que permiten a múltiples partes interesadas diseñar, construir y operar en 
colaboración un desarrollo en un espacio virtual. Traducción: MIC Modelado de 
Información de la Construcción 

• CAD: Computer-Aided Design. Se refiere al uso de herramientas digitales para 
generar, modificar, analizar u optimizar un objeto o un espacio. 

• Revit Family: Familia de Revit. Una familia es un grupo de elementos con un 
conjunto común de propiedades, llamados parámetros, y una representación 
gráfica relacionada. 

• Family Template: Plantilla de Familia. La plantilla sirve como un bloque de 
construcción, que contiene la información que necesita para comenzar a crear la 
familia y que Revit necesita para colocar a la familia en los proyectos. 

• System Family: Familia de sistema. Las familias de sistema incluyen todo lo que 
está integrado en el software y que el usuario no puede manipular en la interfaz. 
Estas familias no se pueden crear ni eliminar. 

• Component (Loadable) Family: Familia Cargable. Incluyen todo lo que no es una 
familia de sistema. Pueden ser elementos de modelo, anotaciones u otros 
elementos que no sean de modelo. Las familias de componentes pueden estar 
basadas en anfitrión o pueden ser independientes. 

• In-Place Families: Familias In Situ. Son elementos que el usuario crea cuando 
necesita un componente exclusivo y específico de un proyecto. 

• BIM 360: BIM 360™ es un software de gestión de proyectos que ayuda a la 
colaboración entre los diferentes agentes que intervienen. Al ser un software en la 
nube permite acceder a la información en cualquier lugar, momento y por toda 
persona del proyecto. (Para más información: https://www.autodesk.com/bim-360/) 

• BIM Manager: Persona con la experiencia necesaria para una implementación 
exitosa de BIM con respecto al alcance y la complejidad de cualquier proyecto 
dado. 

• BIM Execution Plan: Documento más importante de un proyecto BIM, este ayuda 
a comprender y establecer estándares, criterios organizativos y técnicas de 
modelado para poder extraer de forma rápida y eficiente la información. Es un 
documento transversal a todas las fases de un proyecto (prediseño, diseño, 
licitación, construcción explotación, rehabilitación y demolición). 

https://www.autodesk.com/bim-360/
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Capítulo 1 
 

Introducción 
 
Conceptos BIM 
 
Revit es una plataforma de diseño y documentación que permite realizar el trabajo de 
diseño, dibujo y creación de tablas de planificación necesario para llevar a cabo el 
modelado de información de construcción (BIM). BIM aporta información sobre el diseño, 
la envergadura, las cantidades y las fases de un proyecto cuando se necesita. 
 
En el modelo de Revit, cada plano de dibujo vista 2D/3D y tabla de planificación es una 
presentación de información proveniente del mismo modelo de construcción virtual. 
Mientras trabaja en el modelo de construcción, Revit recopila información sobre el 
proyecto de construcción y la coordina en las demás representaciones del proyecto. El 
motor de cambios paramétricos de Revit coordina automáticamente los cambios 
realizados en cualquier sitio: en vistas de modelo, planos de dibujo, tablas de 
planificación, secciones y planos. 
 
Building Information Modeling (BIM) 
 
Building Information Modeling (BIM) es un método asistido por software para optimizar la 
planificación, construcción y gestión de edificios. Todos los materiales y datos de 
construcción pertinentes se digitalizan, combinan y enlazan. Esto permite un acceso 
rápido a un gran número de detalles asignados directamente a los materiales instalados. 
Siguiendo la planificación 2D clásica con borradores y planos CAD 3D, BIM agrega una 
cuarta dimensión que contiene varios atributos del producto.  
 
BIM se puede considerar como una mejora de las herramientas simples del CAD 3D y los 
modelos 3D de un edificio. Además de todas las representaciones geométricas del 
edificio, los modelos también pueden contener grandes cantidades de su proyecto y 
metadatos. Éstos pueden ser específicos de proyecto, material y producto, y también se 
pueden utilizar en la gestión de instalaciones. Elementos de construcción "inteligentes" 
como paredes y revestimientos de pisos "conocen" sus propiedades y sus modos de 
reacción al ambiente planificado y a otros materiales relacionados. BIM gestiona 
automáticamente estas relaciones de materiales inteligentes. 
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Beneficios BIM 
 

1. Captura de la realidad. 
 

2. El tiempo es oro. 
a. Menos repeticiones de trabajo y duplicados de dibujos. 
b. Modelo con más información que un conjunto de dibujos. 
c. Las herramientas de dibujo BIM son más rápidas que las de dibujo 2D, y 

cada objeto está conectado a una base de datos. 
 

3. Control en todo momento. 
a. El flujo de trabajo digital basado en modelos cuenta con funciones como el 

guardado automático o las conexiones con el historial del proyecto; evita 
que se pierdan datos o se dañen archivos 

 
4. Mejora de la colaboración. 

a. Los especialistas de c/disciplina pueden acceder a la nube para compartir 
sus modelos de proyecto complejos y coordinar la integración con el resto 
de los profesionales. Gracias a los pasos de revisión y anotación, todos son 
partícipes de la evolución del diseño, de modo que están preparados para 
la ejecución al finalizar el concepto y pasar a la construcción 

 
5. Simulación y visualización. 

a. El software saca más partido al análisis y al modelado, sintetizando datos 
para ejecutar con “un solo” botón cálculos rendimientos. 

 
6. Resolución de conflictos. 

a. Conductos o las redes eléctricas que pasan por una viga. 
 

7. Secuenciación de los procedimientos. 
a. Con un modelo y un conjunto preciso de submodelos para cada fase de la 

construcción, el siguiente paso es una secuenciación coordinada de las 
actividades, los materiales y el personal para conseguir un proceso de 
construcción más eficaz. 

 
8. Profundización en los detalles. 

a. El modelo es un magnífico punto de encuentro para la transferencia de 
conocimiento, pero también es necesario compartir planos, secciones y 
alzados tradicionales. 

 
9. Presentación perfecta. 

a. Con el diseño completado en una captura que permite modificaciones de la 
realidad, el modelo es la herramienta de comunicación definitiva para 
mostrar el ámbito del proyecto, los pasos que implica y sus resultados. 

 
10. Disponibilidad en cualquier lugar. 

a. Detalles del proyecto desde cualquier lugar y en cualquier dispositivo. 
 

11. Reduce la fragmentación. 



10 
 

 
Interfaz de Usuario 

 
 
 

1. Revit Home/ Inicio de Revit 
2. File Tab / Ficha de Archivo 
3. Quick Access toolbar / Barra de herramientas de Acceso Rápido 
4. InfoCenter 
5. Options Bar / Barra de Opciones 
6. Properties Palette / Paleta de Propiedades 
7. Project Browser / Navegador de Proyectos  
8. Status Bar / Barra de estado 
9. View Control Bar / Barra de controles de vista 
10. Drawing Area / Área de Dibujo 
11. Ribbon / Cinta de Opciones  
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Revit Home / Inicio de Revit (1) 
 
Se despliega al abrir el programa. Utilizar el Inicio de Revit para localizar crear y abrir 
todos los archivos de los recursos locales o de los proyectos de BIM 360 como proyectos 
y familias, o acceder a las opciones de ayuda. 
 

 
 
 

1. Los modelos utilizados recientemente. 
2. Las familias usadas recientemente. 
3. Distintivo que indica que el modelo se ha almacenado en un proyecto de BIM 360. 
4. Controles para abrir otros modelos y familias o para crear otros nuevos mediante 

una plantilla. 
5. Iniciar sesión en cuenta de Autodesk Account. 
6. Acceso a los modelos alojados en BIM 360. 

 
Regresar a la Interfaz. 



12 
 

 
File Tab / Pestaña de Archivo (2) 
 
Permite acceder a acciones habituales de archivo como Nuevo, Abrir y Guardar. También 
se puede administrar los archivos mediante herramientas más avanzadas, como 
personalizar las configuraciones de exportación. 
 

 
Regresar a la Interfaz. 
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Quick Access toolbar / Barra de herramientas de Acceso Rápido (3) 
 
La barra de herramientas de acceso rápido contiene un conjunto de herramientas por 
defecto. Es posible personalizar esta barra de herramientas para que muestre las 
herramientas utilizadas con mayor frecuencia. 
 
 
 
 
Para activar o desactivar funciones de Quick Access Bar: 
 

1. Hacer Clic sobre el icono desplegable  
2. Seleccionar el comando que desea mostrar u ocultar en la barra.  

 
Para añadir herramientas a la barra de acceso rápido: 
 

1. Navegar por el Ribbon para visualizar la herramienta que va a requerir. 
2. Hacer Click con el botón derecho en la herramienta y seleccionar “Añadir a barra 

de herramientas de acceso rápido. 
 

 
 
 
Nota: Algunas herramientas no se pueden añadir a la barra de herramientas de acceso 
rápido. 
 
Para editar la barra de acceso rápido: 
 

1. Hacer Click derecho sobre la barra y seleccionar “Personalizar barra de 
herramientas de acceso rápido”. 

2. Seleccionar la herramienta en la lista y hacer click en  (Subir) o  (Bajar) 
para desplazar la herramienta a la ubicación deseada. 

3. Seleccionar la herramienta en la lista que desea mostrar encima (a la izquierda si 

vemos la barra de forma horizontal) de la línea de separación y hacer click en 
(Añadir separador). 

4. Seleccionar la herramienta o línea y hacer click en (Eliminar). 
 
Regresar a la Interfaz. 
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InfoCenter (4) 
 
Proporciona un conjunto de herramientas que le permiten acceder a fuentes de 
información relacionadas con el producto. 
 
 
 
 
Nota: InfoCenter siempre usará Internet Explorer incluso si configura su navegador 
predeterminado con algún otro. 
 
Para utilizar la barra Infocenter: 
 

• Escribir en la casilla seguido del botón “Buscar” para buscar información 
rápidamente en la Ayuda en línea. 
 
 

 
 

• Iniciar sesión para acceder a los mismos servicios que Autodesk Account, pero con 
los beneficios adicionales de movilidad y colaboración de Autodesk 360. 
 
 

 
 
 
Options Bar / Barra de Opciones (5) 
 
La barra de opciones se encuentra debajo del Ribbon. Muestra herramientas 
condicionantes que dependen de la herramienta activa o del elemento seleccionado. 
 

 
La barra de opciones la podemos mover encima de la Status Bar o debajo del Ribbon: 
 

1. Hacer Click derecho sobre la barra y seleccione “fijar a parte inferior” y viceversa. 
 
 
Regresar a la Interfaz. 
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Properties Palette / Paleta de Propiedades (6) 
 
La Paleta de Propiedades es un cuadro de diálogo que permite visualizar y modificar los 
parámetros que definen las propiedades de los elementos. 
 

 
 

1. Type Selector / Selector de Tipos 
2. Properties Filter / Filtro de Propiedades 
3. Edit Type button./ Botón de Editar Tipo 
4. Instance Properties / Propiedades de ejemplar (dividido en Parameters Groups / 

Grupos de Parámetros, ej: Constraints, Construction, Dimensions, etc.) 
 

1. Type Selector: Identifica el tipo de familia que está seleccionado y proporciona un 
menú desplegable que permite cambiar de tipo. 
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2. Properties Filter: Debajo del selector de tipo hay un filtro que identifica la 
categoría de los elementos que va a colocar una herramienta o la categoría y el 
número de elementos seleccionados en el área de dibujo. Si se seleccionan varios 
tipos o categorías, la paleta solo muestra las propiedades de ejemplar comunes a 
todos los elementos. 

 

 
 

3. Edit Type Button: A menos que se seleccionen elementos de distintos tipos, el 
botón Editar tipo abre un cuadro de diálogo que permite visualizar y modificar las 
propiedades de tipo del elemento seleccionado (o las propiedades de la vista, 
según se haya configurado el filtro de propiedades). 

4. Instance Properties: Muestra propiedades de ejemplar tanto modificables como 
de solo lectura (sombreadas). Las propiedades son de sólo lectura cuando su 
valor se calcula o asigna automáticamente mediante el software o depende de la 
configuración de otra propiedad. 

 
Desde la Paleta de Propiedades puede efectuar las siguientes acciones: 
 

• Seleccionar el tipo de elemento que va a colocar en el área de dibujo o cambiar el 
tipo de los elementos ya colocados desde el Type Selector. 

• Ver y modificar las propiedades de la vista activa. 

• Acceder a las Type Properties / Propiedades de tipo desde el Edit Type button que 
se aplican a todos los ejemplares de un tipo de elemento. 

 
Si no hay ninguna herramienta de colocación de elementos activa ni ningún elemento 
seleccionado, la paleta muestra las propiedades de la vista activa. También es posible 
acceder a las propiedades de una vista seleccionándola con Click derecho en el Project 
Browser. 
Si cierra la paleta Propiedades, podrá volver a abrirla mediante cualquiera de los métodos 
siguientes: 
 

• En Pestaña Modify → Panel Properties → Properties  

• En Pestaña View → Panel Windows → User Interface 

• Hacer Click derecho en el área de dibujo y seleccionar “Properties” 
 
Regresar a la Interfaz. 
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Project Browser / Navegador de proyectos (7) 
 
El Navegador de proyectos muestra una jerarquía lógica de todas las vistas, tablas, 
planos, grupos y otras partes del proyecto actual. Al expandir o contraer una rama, 
aparecen o se ocultan los elementos de niveles inferiores. 
El Project Browser está conformado de varias secciones o grupos que guardan las vistas 
que se generan en el proyecto, algunos de estos grupos son: 
 

• Floor plans / Vistas de planta: se despliegan todos los niveles de los edificios 
(plantas) 

• Ceiling Plans / Vistas de techo: muestra las vistas de entre piso. 

• 3D View / Vistas 3D: despliega las Vistas 3D creadas. 

• Elevations / Fachadas o elevaciones: muestra las vistas de elevación del edificio 
desde Norte, Sur, Este y Oeste. 

• Schedule-Quantities / Listados de cuantificación y materiales: guarda las 
tablas de cuantificación y materiales. 

• Sheets / Planos: guarda las vistas de láminas de impresión creadas en el proyecto 

• Families / Familias: muestra el listado de familias que están cargadas en el 
proyecto 

• Groups / Grupos: guarda los grupos creados en el proyecto 
 
Puede personalizar la organización del Project Browser para ayudarlo a navegar por las 
vistas, planos y tablas de su proyecto. Cuando personaliza el Project Browser, puede 
ordenar las vistas, planos y tablas en grupos o filtrarlas. 
 
Consideraciones: 
 

• Configurar el Navegador de proyectos antes del inicio del proceso de creación del 
modelo. Cuando los usuarios obtienen sus archivos de modelo del BIM Manager 
ya preparado, pasarán menos tiempo en la configuración ellos mismos. 

• Definir las configuraciones organizativas específicas del Navegador de proyectos 
en las plantillas de proyecto 

 
Recomendaciones: 
 

• Cambiar la Organización del navegador para que coincida con las tareas actuales 
de creación de modelos. 

• Usar el navegador de proyectos junto con las Tablas de Vistas para limpiar las 
vistas de trabajo en progreso del usuario. Las vistas de los usuarios, cuando no se 
gestionan, pueden dificultar la navegación del proyecto por parte de otros usuarios 
cuando no entienden el uso de una vista específica. Todas las vistas ocupan 
espacio dentro del modelo del proyecto, lo que posteriormente afectará el 
rendimiento del archivo. 

• Crear dos listas de vistas distintas; uno para vistas de 'trabajo en progreso' (no 
insertadas en planos) y otro para vistas en planos, es decir, “Documentadas”. Este 
enfoque simplificará el mantenimiento y la gestión de las vistas del navegador del 
proyecto. 

 
Regresar a la Interfaz. 
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Status Bar / Barra de estado (8) 
 
La barra de estado ofrece consejos y sugerencias sobre qué hacer. Cuando se resalta un 
elemento o un componente, la barra de estado muestra el nombre de la familia y el tipo. 
La barra de estado se encuentra en la parte inferior de la ventana de la aplicación. 
 

 
 

• Worksets : permite el acceso rápido al cuadro de diálogo Worksets 
(Subproyectos) de un modelo compartido. 

• Editing Requests : para los modelos compartidos, indica el número de 
solicitudes de edición que están pendientes. 

• Design Options : permite acceso rápido al cuadro de diálogo Design Options. 

• Select Links : permite seleccionar un archivo vinculado y sus elementos 

• Select Underlay elements : permite seleccionar elementos que están debajo 
de la vista 

• Select Pinned elements : permite seleccionar elementos que están bloquados 

• Select Element by face : permite seleccionar elementos por caras 

• Drag elements on Selection : activada permite desplazar elementos sin que 
los haya seleccionado previamente (al estar resaltados se podrán desplazar) 

• Filter : muestra el cuadro de dialogo Filter que permite refinar la selección 
por categoría. 

• Exclude Options: esta opción permite excluir de una selección todos los 
componentes que son parte de una opción de diseño (para que esta opción se 
active es necesario tener creadas opciones de diseño). 

• Editable Only: genera un filtro de selección que permite seleccionar solo los 
componentes de un workset Editable (esta función sólo se muestra cuando se está 
trabajando con worksets). 

 
 
Regresar a la Interfaz. 
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View Control Bar / Barra de controles de vista (9) 
 
La barra de controles de vista se encuentra en la parte inferior de la ventana de la vista, 
encima de la barra de estado, e incluye las siguientes herramientas: 
 

 
 

• Scale : La escala de vista es el sistema proporcional utilizado para 
representar objetos en un dibujo. Esta se puede personalizar a otra escala que no 
este señalada en la lista desplegable, en la parte superior. 
 

 
 

• Detail Level : Una columna se puede mostrar de forma diferente según el 
nivel de detalle: Coarse (bajo), Medium (medio) o Fine (alto). Esto se predefine en 
la misma familia. Ej. 
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• Visual Style : Puede especificar múltiples estilos de gráficos para una vista de 
proyecto. Los estilos visuales se agrupan en model display, shadows, lighting, 
photographic exposure, y background. 
El estilo visual se puede cambiar en la primera lista desplegable o desde el 
apartado de Model Display en Graphic Display Options, como se muestra 
acontinuación.  

 

 
 

o Wireframe: Muestra la imagen del modelo con todos los bordes y líneas 
dibujados, pero sin las superficies. 
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o Hidden Line: Muestra la imagen con todos los bordes y líneas dibujados, 

excepto los obstruidos por superficies. 
 

 
 

o Shaded: Muestra la imagen en modo sombreado y permite mostrar luz 
indirecta y sus sombras. Seleccione Show Ambient Shadows en el cuadro 
de diálogo Graphic Display Options visto anteriormentede gráficos para 
simular el bloqueo de la luz ambiental. 
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o Consistent Colors: Muestra la imagen con todas las superficies 
sombreadas según la configuración de color de sus materiales. 
 

 
 

o Realistic: Muestra las apariencias de material en vistas editables. 
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o Ray Trace: Es un modo de renderización fotorrealista que permite aplicar 
zoom y encuadrar el modelo. Cuando se utiliza este estilo visual, la 
renderización del modelo comienza en una resolución baja, pero se 
aumenta rápidamente la fidelidad para que sea más fotorrealista. Puede 
definir “lighting”, “photographic exposure”, y “background”, en el cuadro de 
diálogo Graphic Display Options. 
 

 
 

 

• Sun Path On/Off : Tanto Sun Path y Shadows se complementan para generar 
mucha más información sobre la iluminación natural del proyecto, por lo tanto 
active ambas y de esta forma obtendrá mejores resultados para estudiar el efecto 
de la luz y las sombras en un edificio. 
Al activar esta opción le permitira elegir si crear: 

 
o Condiciones de iluminación según la ubicación del proyecto, la fecha y la 

hora. 
o Condiciones que tal vez no existan en el mundo real. 

• Shadows On/Off : Se pueden encender las sombras con este comando o 
desde el cuadro de diálogo Graphic Display Options. 

• Show/Hide Rendering : (Disponible solo cuando el área de dibujo muestra 
una vista 3D) Antes de renderizar una vista 3D, defina los parámetros que 
controlan la iluminación, la exposición, la resolución, el fondo y la calidad de la 
imagen. 

• Crop View : La región de recorte define los contornos de una vista de 
proyecto. También para trabajar con regiones de recorte puede: 
 

o Crear regiones de recorte poligonales. 
o Mostrar u ocultar regiones de recorte de modelo y anotación. 
o Cambiar el tamaño de las regiones de recorte. 
 

• Show/Hide Crop Region : Puede mostrar u ocultar regiones de recorte según 
sea necesario. 
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• Unlocked/Locked 3D View : Puede bloquear la orientación de una vista 3D 
para etiquetar elementos y añadir key notes (notas clave) en la vista. Al hacer click 
en la herramienta se deseplegarán las siguientes opciones. 
 

 
 

o Save Orientation and Lock View : Bloquea la vista en la orientación 
actual. No se puede orbitar el modelo en este modo. 

o Restore Orientation and Lock View : Restituye la orientación 
bloqueada que tenía previamente una vista. Se mostrarán las etiquetas y 
las key notes colocadas en la orientación original. 

o Unlock View : Desbloquea la orientación actual, lo que permite navegar 
y orbitar la vista 3D. Si hay etiquetas o notas clave colocadas en la vista, no 
se mostrarán hasta que haga clic en el comando Restore Orientation y 
Lock View. 

 

• Temporary View Properties : Oculta o aisla elementos o categorías de 
elementos temporalmente a fin de ver o editar solo algunos elementos de una 
categoría concreta de una vista. Al hacer click en la herramienta se deseplegarán 
las siguientes opciones. 

 

 
 

o Isolate Category: Por ejemplo, si selecciona algunos muros y puertas, solo 
los muros y las puertas permanecerán visibles en la vista. 

o Hide Category: Oculta todas las categorías seleccionadas en la vista. Por 
ejemplo, si selecciona algunos muros y puertas, todos los muros y las 
puertas se ocultarán en la vista. 

o Isolate Element: Aísla solo los elementos seleccionados. 
o Hide Element: Oculta solo los elementos seleccionados. 
 
Nota:. Al ocultar temporalmente un elemento o una categoría de elemento, el 
icono Aislar/Ocultar temporalmente se muestra con un borde ( ). 
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• Reveal Hidden Elements : Permite visualizar a los elementos ocultos de 
forma temporal o mostrarlos permanentemente. 
 
Para mostrar elementos ocultos: 
 

1. Con la herramienta activada seleccionar el elemento que desea mostrar. 
2. Seguir la siguiente ruta: 

 
▪ Pestaña Modify → Panel Reveal Hidden Elements → Unhide 

Element / Category 
 

 
 

• Worksharing Display : (Solo está disponible cuando el proyecto ha sido 
compartido) Facilita la identificación visual de elementos compartidos en un proyecto. 
 
Estos modos de visualización se pueden utilizar para mostrar: 
 

 
 

o Check Status: El estado de propiedad de los elementos. 
o Owners: Los propietarios de elementos. 
o Model Updates: Elementos que no están sincronizados con el modelo 

central oque se han suprimido en dicho modelo, 
o Worksets: Elementos asignados a Worksets predeterminados. 
 
Nota: Los colores de visualización se pueden editar desde la opción 
“Worksharing Display Settings”. 
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• Temporary View Properties : Permite realizar un cambio temporal en la 
visibilidad y los gráficos de una vista sin que esto afecte a la configuración de la 
plantilla. Seleccione la herramienta para mostrar un alista de las opciones de 
visualización disponibles. 
 

 
 

o Enable Temporary View Properties: Seleccionar esta opción para 
especificar el modo de vista temporal. Los cambios realizados en las 
propiedades de la vista serán visibles hasta que se selecciona “Restore 
View Properties”. 

o Temporarily Apply Template Properties: Seleccionar esta opción para 
asignar o crear una plantilla de vista. 

o Recent Templates: Muestra una lista de las últimas 5 plantillas de vista 
que ha utilizado. Seleccione una plantilla si desea volver a aplicarla a una 
vista temporal. 

o Restore View Properties: Seleccionar esta opción para cerrar el modo de 
vista temporal y mostrar la vista de proyecto activa. 

 

• Show/Hide the Analytical Model : Puede visualizar el modelo analítico en 
cualquier vista. Al activar la herramienta muestra  la configuración del modelo 
analítico según lo especificado en el cuadro de diálogo Visibility/Graphics. 

• Highlight Displacement Sets : En una vista desplazada (Displaced View) 
resalta los elementos desplazados para la comprensión del diseño. Ej. 
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• Reveal Constraints : Permite ver rápidamente todas las restricciones de 
alineación y restricción de cotas en la vista. 

 
Nota: Las restricciones creadas en boceto (sketch) se muestran en un color más 
claro como se muestra en la siguiente imagen. 

 

 

• Preview Visibility : (Disponible en el Editor de Familias) Permite visualizar 
una vista previa de los efectos de la configuración de visibilidad y los parámetros 
de geometría de una familia sin salir del Editor de familias. 

 
Regresar a la Interfaz. 
 
Drawing Area / Área de dibujo (10) 
 
Las ventanas del área de dibujo de Revit se denominan vistas. Cada vez que se abre una 
vista en un proyecto, por defecto esta se despliega en el área de dibujo. Las vistas 
muestran la geometría del modelo tanto en 2D como 3D, además de los planos y los 
listados de cuantificación. 
 
Cada vez que se abre una vista se activa una pestaña (tab) que se muestra en la parte 
superior de la ventana de dibujo. Para pasar de una vista a otra, se debe hacer clic sobre 
la pestaña que corresponda al nombre de la vista que se quiere activar. 
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Para gestionar sus vistas en el área de dibujo puede seguir la siguiente ruta Pestaña View 
→ Panel Windows donde encontrará las siguientes herramientas: 
 

 
 

• Switch Windows: Permite visualizar otra vista abierta (pero oculta) en el área de 
dibujo. 

• Close Inactive: Cierra todas las vistas abiertas, excepto la vista activa. 

• Tab Views: Organiza todas las vistas como fichas en una ventana del área de 
dibujo. 

• Tile Views: Permite ver todas las vistas abiertas a la vez. 
 
Ribbon / Cinta de Opciones (11) 
 
Proporciona todas las herramientas necesarias para crear un proyecto o una familia. Se 
compone de la siguiente forma: 
 

 
1. TABS (Fichas) 
2. PANELS (paneles) 
3. TOOLS / CONTROLS (Herramientas y Controles) 

 
Regresar a la Interfaz. 
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Tipos de Objetos en Revit 
 
Existen tres tipos de elementos definidos en Revit:  
 

1. Modelo 
2. Referencia (Datum) 
3. Específicos de vista 

 
Elementos de modelo 
 
Representan toda la geometría 3D real de un edificio. Aparecen en vistas relevantes del 
modelo. Ejemplos; Muros, ventanas, puertas, cubiertas, Muros estructurales, losas, 
rampas. Mobiliarios o equipos como; fregaderos, calderas, conductos, rociadores y 
paneles eléctricos. 
 
A su vez los elementos modelo se clasifican en dos tipos de elementos: 
  

• Anfitriones (host):  estos son los elementos construidos en el sitio de la 
construcción. Por ejemplo: Muros, techos, cubiertas, muros estructurales. 

 

• Componentes de modelo, éstos son todos los demás tipos de elementos en el 
modelo de construcción. Por ejemplo: ventanas, puertas, armarios, vigas, 
columnas estructurales, etc.  

 
Elementos de referencia 
 
Definen el contexto del proyecto. Estos elementos son; ejes, niveles y planos de 
referencia. 
 
Elementos específicos de vista 
 
 Aparecen solo en las vistas en que se crearon. Son útiles para describir o documentar un 
modelo. Las cotas, tags, textos son ejemplos de específicos de vista. Los elementos 
específicos de vista se clasifican en: 
 
 

• Elementos de anotación: componentes 2D que documentan el modelo y 
mantiene la escala en papel. Por ejemplo; cotas, etiquetas y notas clave son 
ejemplos de elementos de anotación.  

 

• Detalles: elementos 2D que proporcionan detalles sobre el modelo de 
construcción en una vista particular. Líneas de detalle, regiones rellenadas y 
componentes de detalle 2D son ejemplos de detalles.  
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Diagrama elementos en Revit 
 

 
 
Nota: Todos los elementos en Revit están organizados por categorías, familias y tipos. 
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Tipos de familias 
 
Todo lo que se crea en Revit es parte de una familia (Revit Family); en consecuencia, 
comprender a las familias y lo que se necesita para manipularlas es una parte vital del 
aprendizaje del software. Comenzando con la diferencia entre las familias de sistema y 
componentes y el uso de las plantillas de familias (Family Template). 
 
Los tres tipos de familia en Revit son: familias de sistema, familias cargables y familias de 
sitio. 
 

TIPO DE FAMILIA CARACTERÍSTICAS 

Familia de Sistema No están disponibles para ser creadas o 
cargadas como archivos separados del 
proyecto de forma predefinida Revit ya 
tiene configurados un conjunto de 
propiedades y la representación gráfica 
puede usar los tipos predefinidos y/o 
generar nuevos tipos dentro del proyecto o 
plantilla. 
 
Nota: Las familias de sistema pueden ser 
transferidos entre proyectos desde: 
 
Pestaña Manage → Panel Settings → 
Transfer Project Standards. 
 
Véase Transferir Estándares de Proyectos 
 

Familias Cargables Son aquellas que se pueden cargar al 
proyecto y son creadas a partir de plantillas 
de familia. Se puede determinar un 
conjunto de propiedades y la 
representación gráfica. Estas familias están 
definidas en archivos con extensión *.RFA 
y son independientes al proyecto. Ejemplos 
de familias cargables son: puertas, 
ventanas, mobiliario, columnas, vigas, etc. 

Familias In Situ Define elementos personalizados que se 
crean en el contexto del proyecto las 
familias en sitio se generan cuando se 
necesita una geometría única para el 
proyecto, es decir que no será usada para 
otros proyectos. Debido a que el uso de 
estas familias es limitado, solo contienen 
un tipo, pero pueden ser copiadas varias 
veces en el mismo proyecto. 
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Tipos de Plantillas de Familias 
 
Si bien la mayoría de las plantillas de familias se nombran de acuerdo con el tipo de 
familia de elementos creada a partir de ellas, Ej. “Metric Structural Column” para columnas 
estructurales; hay una serie de plantillas que incluyen uno de los siguientes descriptores 
después del nombre de la familia: 
 

• Basada en muro (Wall-based) 

• Basada en techo (Ceiling-based) 

• Basada en suelo (Floor-based) 

• Basada en cubierta (Roof based) 

• Basada en línea (Line based) 

• Basada en cara (Face based) 
 
Wall-based, ceiling-based, floor-based y roof-based son conocidas como “plantillas 
basadas en anfitrión” (host-based templates). Una familia basada en anfitrión solo se 
puede colocar en un proyecto si contiene un elemento de su tipo de anfitrión. También se 
les puede incluir huecos para cortar el anfitrión una vez colocado en él 
 

PLANTILLA DESCRIPCIÓN 

Basadas en muro Para crear componentes que se insertarán 
en muros. Hay componentes de muro 
(como puertas y ventanas). Estas plantillas 
tienen un muro, necesario para mostrar 
cómo encaja el componente en él. 

Basadas en techo Para crear componentes que se insertarán 
en techos. Algunos ejemplos de familias 
basadas en techo son los aspersores 
automáticos y las luminarias empotradas. 

Basadas en suelo Para componentes que se insertarán en 
suelos. Hay componentes de suelo (por 
ejemplo, rejillas de calefacción). 

Basadas en cubierta Para componentes que se insertarán en 
cubiertas. Las claraboyas y los ventiladores 
de techo son ejemplos de familias basadas 
en cubiertas. 

Basadas en línea Para crear familias de modelos y detalles 
que utilicen 2 puntos de colocación. 

Basada en cara Para crear familias basadas en un plano de 
trabajo, pueden cambiar sus hosts, hacer 
cortes complejos en los hosts y se pueden 
colocar en cualquier superficie, 
independientemente de su orientación. 
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PLANTILLA DESCRIPCIÓN 

Independientes Para componentes que no dependen de un 
anfitrión. Un componente independiente se 
puede colocar en cualquier lugar de un 
modelo y puede estar acotado por otro 
componente independiente o por 
componentes basados en un anfitrión. Ej. 
mobiliario, accesorios, los conductos y las 
uniones (fittings). 

Adaptativas Para crear componentes que necesiten 
adaptarse con flexibilidad a muchas 
condiciones contextuales únicas. Por 
ejemplo, los componentes adaptativos 
podrían usarse en sistemas repetitivos 
generados mediante la disposición de 
múltiples componentes que cumplen con 
las restricciones definidas por el usuario. 
Cuando selecciona una plantilla adaptativa, 
está creando una familia de masas 
utilizando un editor de familias especial en 
el entorno de diseño conceptual. 

Especialidad Use una plantilla especial cuando la familia 
requiera una interacción única con el 
modelo. Estas plantillas de familias son 
específicas para un solo tipo de familia. 
Por ejemplo, la plantilla de “Armazón 
Estructural” (Structural Framing) solo se 
puede usar para crear contenido de 
armazones estructurales. 

 
No limite la categoría del elemento a la plantilla elegida. Puede seleccionar el tipo de 
anfitrión (host) en la plantilla y después cambiar la categoría que necesita desde: 
 

Pestaña Tab → Panel Properties → Herramienta Family Category and Parameters  
 
 
Adicionalmente algunos tipos de familias requieren una plantilla para funcionar 
apropiadamente. 
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Parámetros 
 
Prácticamente todos los elementos dentro del entorno de Revit utilizan parámetros para 
su definición, estos comprenden dos tipos fundamentales que existen dentro del entorno 
de Revit; Type Parameters (Parámetros de tipo) e Instance Parameters (Parámetros de 
instancia). Ambas son contenedores de valores. Los parámetros de tipo afectan a todas 
las familias asociadas que se han colocado dentro de un entorno de proyecto, mientras 
que los parámetros de instancia afectan solo a una instancia de familia particular cuando 
se selecciona y modifica en la paleta Propiedades. Los parámetros Tipo e Instancia 
pueden definirse directamente dentro del proyecto como Parámetros del proyecto, o 
cargarse al proyecto como Parámetros compartidos. Existe un tercer punto de definición 
de parámetro, que es Parámetros globales, los parámetros globales se definen dentro del 
entorno del proyecto. En las siguientes secciones, cada una de estas; Los parámetros 
Proyecto, Compartido y Global se describen con más detalle. 
 
Project Parameters 
 
Los parámetros del proyecto agregan campos de datos de información personalizados al 
modelo, a la información analítica e información del proyecto. Un usuario puede usar los 
parámetros del proyecto para las familias del sistema que están integradas en el entorno 
del proyecto (por ejemplo, paredes, pisos) además de agregar más propiedades a las 
familias cargables, una vez que se colocan en el proyecto. 
 
Para crear parámetros de proyecto: 
 

1. Ir a la Pestaña Manage → Panel Settings → Project Parameters. 
2. Elegir el Parámetro disponible necesario y dar Click en “OK”, o crear uno nuevo al 

hacer Click en “Add”. 
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3. Definir el tipo de parámetro entre Project Parameter (Puede aparecer en tablas, 
pero no en tags / etiquetas) o Shared Parameter (Puede utilizarse en múltiples 
proyectos y familias, se muestra en tablas y etiquetas), en la sección Parameter 
Type. 

4. Definir en la sección de Parameter Data lo siguiente: 
a. Nombre del parámetro, disciplina, tipo de parámetro y Grupo de parámetro. 
b. Descripción de parámetro en el Tooltip 
c. Si el parámetro es de Tipo o de Instancia 

5. En la sección Categories seleccionar la categoría de elemento al que se le 
asignará el parámetro creado. 

6. Una vez terminada la configuración del parámetro de proyecto hacer click en “OK”. 
 

 
 
Los Parámetros del Proyecto, aunque están disponibles para las tablas dentro del 
proyecto para las categorías de elementos seleccionadas, no están disponibles para los 
elementos de anotación como Etiquetas que representan los datos de propiedad del 
elemento, cuando se encuentran en una vista. Al igual que con los proyectos, los 
parámetros personalizados también se pueden agregar directamente a los elementos 
dentro del editor de familias, imitando efectivamente los parámetros del proyecto, a estos 
se los conoce más comúnmente como Family Parameters, estos parámetros son visibles 
cuando la familia se carga y se coloca en el proyecto. 
 
Consideraciones: 
 

• Los parámetros del proyecto se agregan a nivel de categoría y se pueden agregar 
a varias categorías. 

• Los parámetros del proyecto se gestionan internamente dentro del proyecto Revit. 

• Los parámetros del proyecto pueden usarse en filtros gráficos de visibilidad. 

• Los parámetros del proyecto no se pueden usar para etiquetar, pero pueden 
aparecer en tablas. 
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Shared Parameters 
 
Los parámetros compartidos son definiciones de parámetros, almacenados externamente 
al proyecto y a los archivos de familia que se pueden agregar a ambos, la información 
compartida puede reflejarse en todos los elementos del proyecto, y visualizarse en tablas 
y etiquetas. 
 
La definición de parámetros como parámetros compartidos tiene el beneficio de no solo 
permitir que las familias cargables reconozcan los valores de los parámetros 
correspondientes dentro del proyecto, sino que también mantiene la coherencia entre 
múltiples proyectos / familias. Esto asegura que los valores puedan ser reportados o 
extraídos consistentemente de múltiples proyectos. 
 
Las definiciones de parámetros compartidos se almacenan en un archivo de texto externo 
(TXT) independiente de cualquier archivo de familias o proyecto de Revit. Esto permite a 
los usuarios acceder al archivo desde diferentes familias o proyectos. 
 
Consideraciones: 
 

• Es fundamental establecer y mantener un régimen estricto para la gestión de 
archivos de parámetros compartidos. Esto garantizará la coherencia de las 
definiciones de parámetros en múltiples proyectos, plantillas de proyectos y 
archivos familiares. Garantizar que los elementos se puedan estandarizar y 
compartir entre archivos de proyecto y archivos de plantilla. Esta estandarización 
de las definiciones de parámetros garantizará que las familias o el contenido 
puedan reutilizar los campos preexistentes sin confusión ni incertidumbre. 

• La información definida en el valor del parámetro en una familia o proyecto que 
usa un parámetro compartido no se aplica automáticamente a otra familia o 
proyecto que usa el mismo nombre de parámetro compartido. 

• Los parámetros compartidos pueden ser parámetros de tipo (cada puerta obtendrá 
el mismo valor para la resistencia al fuego) o parámetros de instancia (cada puerta 
puede tener su propio valor para la resistencia al fuego). 

• Los parámetros definidos en el archivo de parámetros compartidos no pueden 
modificarse. es decir, sus propiedades no se pueden modificar, solo se pueden 
eliminar y volver a crear. 
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Global Parameters 
 
Los parámetros globales se definen dentro del entorno del proyecto. Los parámetros 
globales pueden usarse efectivamente para lo siguiente: 
 

• Asociar el valor a una dimensión o restricción. 

• Estar asociado a una instancia de elemento o propiedad de tipo  

• Asociar con un parámetro de instancia o un parámetro de tipo. 

• Puede informar el valor de una dimensión y usar su valor dentro de fórmulas de 
otros parámetros globales, como se muestra a continuación: 

 

 
 
Consideraciones: 
 

• Los parámetros globales deben usarse con moderación para aprovechar al 
máximo el modelo. 

• Los parámetros globales no son accesibles para las tablas. 

• Cualquier parámetro que se cree (Proyecto, Compartido o Global) requiere que su 
Disciplina y Tipo se definan correctamente si se van a utilizar de manera efectiva, 
sin errores. Tenga en cuenta que las listas de agrupación de parámetros para 
Disciplina y Tipo no son accesibles para el usuario y no se pueden agregar ni 
modificar. 

• Las convenciones de nomenclatura de la compañía para los parámetros son 
críticas para garantizar la coherencia entre los proyectos. 

 
Recomendaciones: 
 

• Utilizar la descripción de la información “Tooltip” sobre herramientas para aportar 
más claridad al uso y la función del parámetro. Tenga en cuenta que esta 
descripción está limitada a 250 caracteres. 

• Evitar el uso de nombres de grupo ambiguos como 'General': esto generalmente 
puede causar confusión al ubicar y crear parámetros y, posiblemente, causar la 
duplicación de las definiciones de parámetros (nombre). 
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• Donde los valores de los parámetros potencialmente abarcan múltiples disciplinas; 
Esto es típico de las definiciones dimensionales. Considere la convención de 
nomenclatura ligeramente más flexible; por ejemplo, 'Ancho' podría abarcar el 
Ancho de una placa base, el Ancho del cartabón o el Ancho de la placa inferior de 
un ancla. 

• Definir claramente una estrategia sobre cómo y cuándo se deben usar, crear y 
cambiar definiciones de parámetros compartidos de la compañía y cómo los 
usuarios pueden y deben cambiar el archivo de parámetros compartidos adjuntos 
de las sesiones para acomodarlos. 

• Usar Multicategory Schedules (Tablas de multi-categoría) para enumerar 
diferentes familias que contienen el mismo parámetro compartido. 

 
Transferir Estándares de Proyecto 
 
La herramienta Transferir Estándares de proyecto requiere que se abra un archivo de 
Revit (RVT / RTE / RFA) en segundo plano, es decir, dos archivos se abren 
simultáneamente en la misma sesión de Revit. Se recomienda que en todos los usos de la 
herramienta Transferir Estándares de proyecto se utilice la opción Check None. Luego 
transfiera selectivamente los estándares requeridos. 
 
No es inusual cuando se transfieren estándares que aparezca el cuadro de diálogo de 
advertencia cuando la operación intenta sobrescribir las configuraciones existentes. Leer 
la información en el cuadro de diálogo para determinar la acción correcta. 
 
Se recomienda que cuando se inicia un proyecto, la plantilla que se utiliza para iniciar el 
proyecto se guarde y se archive en una ubicación de solo lectura. Esto es para evitar que 
se editen inadvertidamente, y también para poder saber qué plantilla se usó para iniciar 
un archivo de proyecto, en caso de que ocurra algún problema y tener una copia de la 
plantilla original puede ayudar a identificar la causa. 
 
Los estándares de proyecto incluyen: 
 

• Tipos de familia (incluidas las familias de sistema, pero no las familias cargadas) 

• Parámetros globales (si al transferir los parámetros globales hay otros con el 
mismo nombre en el proyecto de destino, se les añade un número [1] para indicar 
el duplicado) 

• Grosores de línea, materiales, plantillas de vista y estilos de objeto 

• Configuración mecánica, tuberías y configuración eléctrica 

• Estilos de anotación, esquemas de relleno de color, y patrones de relleno 

• Configuración de impresión 
 
Para transferir los estándares de proyecto: 
 

1. Abrir ambos archivos, el archivo con los estándares y el archivo que los recibirá. 

2. Ir a la Pestaña Manage → Panel Settings → Transfer Project Standards  
3. En el cuadro de Diálogo Select Items to Copy, seleccione el proyecto de origen en 

Copy From. 
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4. Seleccionar los estándares de proyecto deseados. Para seleccionar todos los 
estándares de proyecto, hacer click en Check All. 

5. Hacer Click en OK. 
6. Si se abre el cuadro de Diálogo Duplicate Types: 

a. Overwrite: Transfiere todos los estándares nuevos y sobrescribe los tipos 
duplicados 

b. New Only: Transfiere todos los estándares de proyecto nuevos y omite los 
tipos duplicados. 

c. Cancelar: Cancela la operación. 
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Control de Visibilidad en vistas 
 
En Revit, la visualización de elementos se controla mediante una serie de factores. Los 
estilos de objeto (Object Styles) del proyecto y las modificaciones de visibilidad y gráficos 
(Visibility and Graphics) de la vista son los controles principales que permiten modificar la 
visualización de objetos. 
 
Control de Propiedades de las Categorías en vistas 
 
Object Styles (Globales para el proyecto) 
 
Los estilos de objeto son muy similares a las capas o niveles en el software CAD. Se 
puede acceder a ellos desde: 
 

Pestaña Manage → Panel Settings → Object Styles. 
 

 
 
Los estilos de objeto especifican el grosor de línea (Line Weight), el patrón de línea (Line 
Pattern), el color de línea (Line Color) y los materiales para los elementos de modelo, 
anotación, analíticos e importados dentro de Revit. Estos estilos de objeto también 
pueden contener subcategorías para ramificar aún más los componentes de un objeto en 
una vista. Las propiedades de vista de los objetos se establecen primero globalmente, 
pero luego se pueden ajustar vista por vista. 
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La apariencia de los objetos también está controlada por el Nivel de detalle de una vista. 
 
Ejemplo: 
 

Las trabes pueden aparecer como una sola línea o los bordes de la geometría 
según el nivel de detalle de la vista que se aplica. 

 
Hay subcategorías de estilos de objeto para controlar la visibilidad y los gráficos de partes 
del objeto. Los estilos de objeto se pueden asignar para exportar a capas o niveles 
específicos a otro software CAD. El uso de subcategorías es especialmente útil para 
asignar estilos de objetos a capas o niveles. 
 
Consideraciones: 
 

• Los estilos de objeto se aplican a todas las vistas. 

• La creación de una subcategoría en una familia también se importará al proyecto 
después de su inserción. Es importante que el BIM Manager organice una buena 
convención de nomenclatura. 

• Los nombres de subcategorías distinguen entre mayúsculas y minúsculas (p. Ej.: 
Radiador no es lo mismo que radiador). 

• Incluso si modifica en el editor de familia para categorías o subcategorías, la 
proyección de grosor de línea, corte o color de línea, patrón de línea, cuando lo 
importe en el proyecto, se mantendrá la definición de estilos de objeto del 
proyecto. 

• No es posible eliminar o cambiar el nombre de una categoría o subcategoría 
incorporada. 

• Los filtros y los sistemas de conductos / tuberías anularán los estilos de objetos 
o Filtros en la vista donde se agregó 
o Sistemas en todo el proyecto 
o Nota: Los filtros tienen prioridad sobre los sistemas en las vistas donde se 

agregó 
 
Visibility and Graphics (Vista por vista) 
 
Controla la visibilidad y la presentación de gráficos de elementos de modelo, elementos 
de referencia y elementos específicos de vista para cada vista de un proyecto. 
 
Se puede acceder al control de visibilidad y gráficos con cualquiera de las siguientes 
rutas: 
 

• Pestaña View → Panel Graphics → Visibility / Graphics 

• Paleta de Propiedades → Grupo Graphics → Visibility / Graphics 
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Se puede usar para controlar la visibilidad de las categorías, la visibilidad de líneas, 
patrones, transparencia, medio tono y nivel de detalle de las categorías y subcategorías 
respectivamente; de categorías de modelo, anotación, modelo analítico e importados. 
También  
 
Los parámetros que se modifican son los especificados en el nivel del proyecto. La 
configuración del nivel del proyecto se realiza en el cuadro de Object Styles mencionado 
anteriormente. 
 
Creación de Filtros para manejar la visibilidad y propiedades de los objetos 
 
Los filtros de vista se usan invariablemente junto con las plantillas de vista para definir los 
entregables del proyecto, es decir, Planos y Vistas asociadas. Se utilizan para controlar la 
apariencia (o no apariencia) de elementos dentro de la vista, o más frecuentemente, en un 
valor de parámetro asociado con el elemento. Se puede acceder a ellos con cualquiera de 
las siguientes rutas: 
 

• Pestaña View → Panel Graphics → Filters. 

• Pestaña View → Panel Graphics → Visibility / Graphics → Filters 
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Los filtros se basan en reglas o conjuntos de reglas, cada conjunto de reglas utiliza la 
condición AND u OR: 
 

 
 

• AND: Todas las reglas y conjuntos de reglas anidados dentro de este conjunto 
deben evaluarse como verdaderos. 

• OR: Una o varias reglas o conjuntos de reglas anidados dentro de este conjunto 
deben evaluarse como verdaderos. 

 
Cuando las reglas de filtros incluyen conjuntos de reglas anidados, utilice las condiciones 
AND y OR cuidadosamente, en el orden correcto y con el anidamiento adecuado. 
En algunos resultados, debe utilizar AND con una condición OR anidada. En otros 
resultados, debe utilizar OR con una condición AND anidada. Los resultados pueden 
variar en gran medida, y debe asegurarse de usar las reglas de filtro adecuadas para 
lograr sus objetivos. 
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Consideraciones: 
 

• Convenciones de nomenclatura que proporcionan una indicación descriptiva clara 
de para qué se utilizará el filtro de vista, ya que no hay disponible un campo 
descriptivo / comentario adicional. 

• La configuración del filtro de vista anulará todas las configuraciones de estilo de 
objeto para la vista donde se aplique. 

 
Recomendaciones: 
 

• Utilizar los filtros de vista para agregar color / patrones a los elementos del modelo 
para proporcionar una mejor claridad a las vistas de diseño. 

• Utilizar los filtros de vista junto con las Plantillas de vista para obtener un mejor 
control y garantizar la coherencia en las vistas en los planos documentados. 

 
Con la información vista anteriormente estas son las consideraciones y recomendaciones 
generales para el control de visibilidad y gráficos del proyecto. 
 
Consideraciones: 
 

• Mediante el cuadro de diálogo visibilidad / gráficos o en una selección de elemento 
en una vista se anularán cualquier configuración aplicada a través de los estilos de 
objeto. 

• Ajustar las vistas de forma individual puede llevar mucho tiempo y ser propenso a 
incoherencias cuando se ve en varias vistas. Considere la posibilidad de definir 
ajustes que pueden o se utilizarán varias veces en una plantilla de vista. 

• Con respecto a la visualización gráfica de elementos de modelo individuales, 
existe una jerarquía predeterminada de anulaciones, cuyo orden aproximado es el 
siguiente, si se aplicaran todas las anulaciones. Tenga en cuenta que esto es para 
anulaciones gráficas, no visibilidad: 
 

1. Estilos de objeto 
2. Sistema MEP (Los gráficos de sistema solo tendrán prioridad sobre el 

siguiente) 
3. Visibilidad / Gráficos de vista (categoría de elemento) 
4. Filtros de vista (líneas y patrones) 
5. Anulaciones del elemento individual. (Override graphics in View by 

Elements) 
 
Recomendaciones: 
 

• Utilizar las plantillas de vista junto con los filtros de vista como base para el control 
de visualización de la vista. 

• Evitar el uso del control de elementos individuales (gráficos o visibilidad) cuando 
sea posible, aunque es útil (y a veces inevitable) para vistas documentadas, es 
bastante difícil para otros usuarios del archivo del proyecto interpretar y 
comprender el contexto en el que se ha utilizado. 

• Cuando se va a ejercer un mayor grado de control en una vista, se recomienda el 
uso de filtros de vista, ya que estos pueden ser impulsados por categorías y / o 
parámetros. 
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Manejo de Snaps 
 
Al colocar un elemento o crear un boceto de una línea, utilice los “Snaps” para lograr la 
alineación con la geometría existente. Se puede acceder a la configuración de los Snaps 
desde: 
 

Pestaña Manage → Panel Settings → Snaps. 
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En esta pestaña puede configurar lo siguiente: 
 

• Snaps Off: Para desactivar todos los Snaps 

• Length / Angular dimensions snap increments: A medida que cambia el nivel 
de zoom en una vista, los incrementos de ajuste cambian. Cuando se acerca, los 
incrementos de ajuste son más pequeños. Cuando se aleja, los incrementos de 
ajuste son mayores. Defina incrementos de ajuste para longitudes y ángulos de 
dimensión que se adapten a sus necesidades. Separe los valores con punto y 
coma. 

• Object Snaps: Seleccionar las casillas de verificación para habilitar las referencias 
a Snaps, o desactivar las casillas de verificación para deshabitarlas. 

 
o SE: Se ajusta al punto final de un elemento. 
o SM: Se ajusta al punto medio de un elemento. Al colocar un elemento en la 

pared (como una ventana, puerta o abertura), puede usar el Snap del punto 
medio, SM, para ajustar la colocación al punto medio del segmento de 
pared. 

o SN: Identifica al elemento más cercano. Si desactiva esta opción el 
software permite forzados de cursor de “salto” (jump snaps) a puntos 
finales, puntos medios y centros. Un forzado de cursor de salto es un punto 
de forzado a más de 2 mm del cursor en pantalla. 

o SW: Identifica las rejillas de los planos de trabajo. 
o SQ: Identifica un punto cuadrante de un arco, círculo, elipse o arco elíptico. 
o SI: Identifica las intersecciones. 
o SC: Identifica el centro de un arco. 
o SP: Identifica elementos perpendiculares. 
o ST: Identifica tangente de un arco. 
o SX: Identifica los puntos del emplazamiento. (Survey point / Project base 

point) 
o SR: Permite forzados de cursor de salto (jumps snaps) a objetos que no 

están cerca del elemento. 
o PC: Identifica puntos o superficies en una nube de puntos. 

 
Configuración de Dimensiones Temporales 
 
Conforme crea o selecciona una geometría, Revit añade cotas temporales al elemento. 
Utilice las cotas temporales para controlar de forma dinámica la colocación de los 
elementos en el modelo. 
 

 



47 
 

Una vez colocado el elemento, Revit muestra las cotas temporales. Si se coloca otro 
elemento, las cotas temporales del elemento anterior desaparecen. Cuando se 
seleccionan varios elementos en Revit, no se muestran las cotas temporales ni las 
restricciones. Puede utilizar la opción Activar cotas para visualizarlas. 
 

1. Seleccionar varios elementos en el área de dibujo. 
2. En la barra de opciones, hacer click en Activate Dimensions. 
 

 
 
Puede cambiar el tamaño del texto y el fondo que se utiliza para mostrar las cotas 
temporales: 
 

1. Hacer click en la pestaña File → Options. 
2. En el cuadro de diálogo Options, hacer click en la pestaña Graphics. 
3. En Temporary dimension text appearance especificar el tamaño de letra y el 

fondo (transparente u opaco). 
 

 
 
Nota: Si no se muestran las cotas temporales ni las restricciones, el rendimiento del 
sistema aumenta de forma considerable. 
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Ejes y Niveles 
 
Niveles 
 
Los niveles son planos horizontales infinitos que determinan la altura vertical del edificio. 
 
Al crear elementos en un piso, como paredes o columnas, se requiere un nivel inicial y 
final. Los objetos se ligan a estos planos. Por lo tanto, los cambios realizados a la 
localización de un plano propagan automáticamente a los objetos ligados. Por ejemplo, un 
muro podría empezar en el primer nivel y terminar en el nivel de la azotea. Si cualquiera 
de los dos niveles cambia, el muro se actualizará automáticamente en todas las vistas del 
proyecto. 
 
Para añadir niveles, es preciso estar en una vista de alzado o sección. 
 

 
 
Similar a la creación de los Ejes, la creación de niveles en Revit es algo básico que debe 
hacerse al principio del proceso de modelado. Cuando los niveles se definen desde el 
principio, el modelador puede aprovechar las opciones que ofrece Revit, como los 
elementos de conexión a los niveles (de piso) o copiando un cierto diseño de un nivel a 
otro. 
 
Para crear niveles: 
 

1. Activar cualquier vista de elevación o corte. 

2. En la Pestaña Structure → Panel Datum → Level   
3. En la Pestaña Modify → Panel Draw escoger la opción requerida para dibujar el 

nivel. 
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• Elegir la opción “Line”  para dibujar el nivel como una línea definiendo un 
punto inicial y punto final. 

• Elegir la opción “Pick Line”  para colocar un nivel con respecto al elemento 
que usará como referencia. 

 

4. Definir si crear un vista del nivel activando  de ser así, que tipo de 

vista en . 

5. Establecer un “Offset” (Desfase)  con respecto al punto (con 
opción line) o el elemento (con opción Pick Line) de colocación, en la barra de 
opciones. 

 

 
 
Nota: Al crear un nivel con la herramienta Pick Line y con el desfase definido podemos 
visualizar una línea de proyección donde se colocará, con respecto al elemento 
identificado por el cursor. 
 
Consideraciones: 
 

• Los niveles deben basarse en convenciones de nomenclatura claras. Esto dejará 
en claro a todos los usuarios lo que denota el nivel. 

• Mantener los mismos niveles, tanto en altura como en nombre, en varios archivos 
de proyecto, reduce los problemas de coordinación que surgen debido a los 
niveles variables. 
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Ejes 
 
Mientras que los niveles se utilizan para dividir el modelo horizontalmente (pisos), las 
cuadrículas proporcionan una referencia vertical continua a través de un edificio y 
generalmente coincidirían con la cuadrícula de columnas tradicional. Las cuadrículas 
dividen el modelo en coordenadas X y. Las rejillas determinan el ritmo general del edificio. 
Las cuadrículas más comunes son de naturaleza rectangular, sin embargo, también 
existen cuadrículas más complejas. Independientemente de la complejidad, el objetivo es 
tener un marco de referencia que se pueda utilizar durante la fase de diseño y 
construcción. Durante la fase de modelado, la colocación semiautomática de columnas se 
puede hacer en función de la cuadrícula. Además, se puede colocar un muro y adjuntarlo 
a las líneas de la cuadrícula. Si se ajusta la cuadrícula, también se ajusta todo lo que se 
adjunta a la cuadrícula. 
 

 
 
Para crear Ejes: 
 

1. Activar una vista en planta. 

2. Escoger Pestaña Structure → Panel Datum → Grid  
3. Definir punto inicial y final del eje. 

 
Podemos crear los ejes con las herramientas de dibujo de líneas y “Pick Line” 
mencionados anteriormente. 
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Ejes Multisegmento 
 
Los ejes multisegmento permiten crear más de un segmento de línea haciendo flexible 
la dirección y forma del eje. 
 
Para crear ejes multisegmento: 
 

1. Escoger en la Pestaña Structure → Panel Datum → Grid  

2. Se activa la herramienta Multi-Segmento  en la Pestaña Modify → Panel 
Draw. 

3. Dibujar el recorrido del eje. 
 

 

4. Presionar el botón (Finish Edit Mode). 
 

 
 
Consideraciones: 
 

• La orientación hacia el Norte del Proyecto. 

• Las cuadrículas se pueden usar para la creación de elementos como las 
columnas. 

 
Recomendación: 
 

• Si un proyecto consta de varios edificios, configure una cuadrícula para cada uno 
independientemente del otro. 
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Capítulo 2 
 

Plantillas 
 
Plantillas de proyecto 
 
Las plantillas de proyecto son un componente clave al iniciar cualquier modelo de 
proyecto. El tiempo y el esfuerzo invertidos en la configuración correcta de las plantillas 
del proyecto proporcionarán "Retorno de la inversión" para cada proyecto en el que se 
utilicen posteriormente. Una plantilla de proyecto bien definida proporciona confianza para 
que los usuarios puedan navegar, ubicar contenido y producir las entregas del proyecto 
como se describe en el BIM Execution Plan (Plan de ejecución BIM) del proyecto sin 
requerir un esfuerzo excesivo al final del desarrollo del proyecto para alinearse con los 
resultados esperados. 
 
Se deben considerar muchos aspectos en la producción de una buena plantilla de 
proyecto. Estos pueden variar debido a los requisitos específicos del proyecto o del 
cliente. Sin embargo, muchas de estas variantes pueden basarse en una plantilla de inicio 
(de empresa) bien definida. A medida que el tiempo, las habilidades y la experiencia del 
usuario maduren, se aprenderán muchas lecciones, tanto buenas como malas, y es 
importante que estas lecciones, y los cambios consiguientes, se reflejen en las plantillas 
del proyecto, y que estas plantillas también maduren con el tiempo. El siguiente flujo de 
trabajo resalta muchos de los componentes principales de la plantilla del proyecto. 
 
El flujo de trabajo para la definición de plantilla cubre el proceso para crear archivos de 
plantilla de Revit (.RTE) para los requisitos de la empresa y del proyecto. Este flujo de 
trabajo se divide en varios temas que deben tenerse en cuenta al definir un archivo de 
plantilla de proyecto. Estos pasos (no en un orden específico) se describen a 
continuación: 
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Manejo de plantillas 
 
Puede crear plantillas personalizadas para satisfacer necesidades específicas o 
garantizar el cumplimiento de las normas de la empresa 
 
Para crear una plantilla de proyecto: 
 

1. Seleccionar en la Pestaña File → Opción New → Project 
 

 
 

2. En la caja de diálogo “New Project”, en la sección Template File desplegar lista y 
seleccionar plantilla base deseada. Revit proporciona varias plantillas para 
diferentes disciplinas y tipos de proyectos de construcción. (También puede 
presionar “Browse” para escoger la plantilla base que usará) 
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3. En la sección Create New escoger Project template. 

 

 
 

4. Presionar “OK” para crear archivo. 
 
Para guardar los cambios en la plantilla base: 
 

1. Escoger la Pestaña File → Save As → Template. 
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Configurar listado de plantillas 
 
Es posible especificar los archivos de plantilla que se usan con más frecuencia en una 
lista que se mostrará en la ventana “New Project” bajo la sección de Template File vista 
anteriormente. Para configurar el listado de plantillas: 
 

1. Hacer click en la pestaña File → Options. 
2. En el cuadro de diálogo Options, hacer click en la pestaña File Locations. 

3. En la sección Project templates hacer click sobre el botón  (Add Value) 
4. Buscar y seleccionar la plantilla que se requiere agregar a los listados. 

 

 
 
Recomendaciones sobre plantillas de proyectos 
 
Las plantillas de proyecto proporcionan un entorno inicial y normas para los modelos 
nuevos. A continuación, se indican algunas recomendaciones y pautas al crear plantillas 
de proyecto personalizadas: 
 

• Ubicación del contenido: 
Una plantilla de proyecto puede contener familias personalizadas, como; cuadros 
de rotulación, elementos de modelo, como puertas y ventanas, y elementos de 
anotación, como, etiquetas de elementos y referencias a vistas. Antes de crear 
una plantilla de proyecto, designe una ubicación para almacenar las familias 
personalizadas; de esta forma podrá acceder a ellas fácilmente. Se recomienda 
conservar el contenido personalizado por separado del contenido proporcionado 
por Autodesk. 
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• Estándares de Nomenclatura: 
Utilizar estándares de nomenclatura claros le ayudará a tener la plantilla 
organizada y contribuirá a hacerla fácil de utilizar. Cuando avance por los 
elementos de esta lista de comprobación, piense sobre los estándares de 
nomenclatura que utilizará para todos los elementos (familias, vistas, materiales, 
etc.) 
 

• Anotaciones: 
Una plantilla de proyecto debe incluir las familias de anotación que vaya a utilizar 
en el modelo. Debido a que las anotaciones se cargan en la plantilla, no será 
necesario cargarlas la primera vez que se utilicen en el modelo. Este método 
permite ahorrar tiempo y reducir los errores causados por cargar una familia 
incorrecta. 
 

• Ubicación y orientación del proyecto: 
Al comenzar un nuevo proyecto, la ubicación debe establecerse correctamente 
para evitar estudios solares incorrectos o información meteorológica errónea. 
 

• Estilos de línea: 
Los estilos de línea definidos en la plantilla se deberían generar de forma 
específica para su uso en el proyecto. Los tipos de línea creados específicamente 
reducirán los posibles errores al seleccionar un tipo de línea para su uso. 
Crear un plano de detalle de muestra usando elementos de diferentes categorías 
que usan diferentes estilos de objeto. 
Comparar la apariencia impresa y en pantalla y ajuste la configuración del estilo 
del objeto, según sea necesario. 
Después de definir los estilos de objeto, realizar ajustes en los grosores de línea 
de estilo de objeto para cada escala para garantizar la salida requerida. 
 

• Materiales y Patrones de relleno 
Crear una biblioteca de materiales habituales en la plantilla del proyecto. Cuando 
cree materiales, no tenga en cuenta solo su aspecto, sino también cómo les 
añadirá las notas clave o cómo los utilizará para el cómputo de materiales. Los 
patrones de relleno para superficies de materiales y patrones de corte también se 
definen en la plantilla y se deberían generar de forma específica para cada 
material. Esto le ayudará a reducir errores al seleccionar patrones de relleno para 
nuevos materiales. 
 

• Tipos de texto: 
Es necesario considerar qué fuente se utilizará en su proyecto. El contenido 
predeterminado actual de Revit se crea con la fuente Arial. 
 

• Contenido / Familias: 
No sobre desarrollar plantillas. Estas están destinadas a ser un punto de partida 
para proyectos, por lo que solo deben incluir contenido general. Considerar qué 
contenido es relevante para toda la empresa y qué contenido es específico del 
proyecto. 
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Los elementos tales como segmentos y tamaños de tuberías / conductos, tipos de 
cables, etc. pueden variar entre proyectos. Además, es posible que se hayan 
agregado tipos adicionales durante la vida útil de la plantilla anterior que no se 
incluirán en la nueva plantilla. Por lo tanto, el uso de la Herramienta Transfer 
Project Parameters debe considerarse con precaución al actualizar las plantillas 
MEP para evitar sobrescribir las configuraciones. 
 
Cargar solo contenido y familias estándar en plantillas. El resto del contenido se 
puede cargar a medida que avanza el proyecto. Para mantener la coherencia, se 
recomienda el uso de tablas estándar de la compañía, pero deben sobre escribirse 
según se requiera en las plantillas del proyecto o a medida que el proyecto avance 
en los archivos reales del proyecto. 
 
Incluir los pies de plano estándar de la compañía en un archivo de plantilla. Se 
pueden cargar tamaños de hoja adicionales y pies de plano específicos del 
proyecto según se requiera en el cuadro de diálogo New Sheet desde un archivo 
RFA externo. 
 
El contenido estándar de Revit tiene diferentes plantillas para diferentes disciplinas 
(arquitectura, mecánica, eléctrica, etc.). Autodesk recomienda que las plantillas de 
empresa y proyecto diferencien entre disciplinas y que cada disciplina tenga su 
propio archivo de plantilla. 
 

• Unidades de proyecto: 
Las unidades de proyecto se agrupan por disciplinas: común, estructura y Mep. 
Cuando se cambia de disciplina, hay disponibles tipos de unidades diferentes. En 
el cuadro de diálogo Unidades de proyecto, cada tipo de unidad tiene una vista 
previa del formato de visualización. Para proyectos arquitectónicos la disciplina 
Común es la que se usa como base. 
 
Para configurar unidades de medida: 
 

1. Escoger Pestaña Manage → Panel Settings → Project Units 
2. La caja de diálogo de unidades de medida muestra el formato actual de 

unidad de medida que se está usando. 
3. Bajo la columna Units se encuentran las unidades de medida que se 

pueden configurar en Revit. 
4. Bajo la columna Format, se puede hacer el click en cada botón que esta 

frente a la opción de unidad y configurar el formato de la unidad de medida. 
 
En la caja de dialogo Format se configuran unidades, cantidad de decimales, 
simbología y el formato para separación de dígitos. Esto mismo se aplica para 
cada una de las diferentes unidades de medida. 
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Nota: Revisar las recomendaciones sobre los estilos de objeto, plantillas de vistas, filtros y 
navegador de proyecto explicadas anteriormente. 
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Capítulo 3 
Creación de Familias 
 
Introducción a las Familias 
 
Para comenzar con el Editor de Familias, es importante comprender algunos conceptos 
básicos y terminología. Todos los elementos en la plataforma de Revit son parte de una 
familia y encajan en una jerarquía claramente definida. En el nivel superior de esta 
jerarquía, se encuentran las Categorías. Las categorías están predefinidas dentro del 
software y no se pueden agregar, eliminar o renombrar. Se incluye una amplia variedad 
de categorías en Revit y se distribuyen entre unos pocos grupos maestros generales que 
incluyen: modelo y anotación (pero hay algunos otros). Las categorías de modelos 
incluyen todos los elementos que componen su modelo de construcción, tales como: 
muros, puertas, pisos, escaleras y vigas. Las categorías de anotación incluyen elementos 
como Texto, Dimensiones y Etiquetas. 
 
Las categorías son, por definición, muy amplias. No sería suficiente tener simplemente 
una categoría de Muros o Puertas. Estos artículos vienen en todas las formas, tamaños y 
comportamientos. Por lo tanto, el siguiente nivel de la jerarquía es la Familia. Revit incluye 
muchas familias como la familia de muro "Basic Wall" entre otras, y muchas familias de 
anotaciones como "Text" o "Linear Dimension Style". Incluso las vistas en sí mismas, 
como vistas de planta y secciones, son familias de sistemas en Revit. Las familias se 
dividen en dos tipos principales: la familia del sistema (System Family) y la familia de 
componentes (Loadable / Cargables). Además de las familias de sistema y cargables 
tenemos u tercer tipo de familia llamada familia en sitio (In-Place Family). 
 
Las familias pueden tener más de un: Tipo. Un tipo es nuestra siguiente jerarquía en 
Revit. En ellos encontramos tamaños, materiales u otras configuraciones. Una familia 
puede contener uno o más tipos; cada uno con su propia configuración única editable por 
el usuario. Entonces, si bien, por ejemplo, no podemos crear o eliminar familias de muros, 
podemos agregar, eliminar y editar los tipos asociados con cada una de las familias de 
sistema. 
 
Procedimiento recomendado para la creación de Familias 
 

1. Crear un archivo de familia a partir de la plantilla adecuada. 
La elección de la plantilla es importante ya que contienen configuraciones básicas, 
comportamientos y en muchos casos, geometría simple o planos de referencia. 

2. Definir el punto de inserción. 
La intersección de dos planos de referencia en una vista define el origen de una 
familia. Puede controlar qué planos de referencia definen el origen 
seleccionándolos y cambiando sus propiedades. Muchas plantillas de familia crean 
familias con orígenes predefinidos, pero quizás sea preciso definir el de algunas. 

3. Agregar planos de referencia, parámetros y geometría. 
Los planos de referencia proporcionan la base para la familia, Algunas plantillas ya 
los contienen y se usan o modifican. Una vez creados o adecuados opcionalmente 
se restringen o se asginan parámetros a ellos, y luego se crea la geometría 
bloqueándola a los planos de referencia. 
De esta manera, los planos de referencia realmente controlan la geometría. 
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Tipos de geometría de forma sólida y vacía 
 
La geometría en las familias consiste en formas sólidas y vacías. Las formas sólidas 
representan las partes físicas reales de la familia y las formas vacías se utilizan para 
cortar porciones de las formas sólidas. Ambas formas sólidas y vacías vienen en cinco 
variedades. Estos incluyen: Extrusion, Blend, Revolve, Sweep y Swept Blend. 
 

 
 

• Extrusion: Es una forma de un boceto empujada a lo largo de una distancia 
perpendiicular al plano donde se dubijo el boceto. 

• Blend: Es similar a la extrusión, exceptuando que la fomra superior e inferior puede 
variar. 

• Revolve: Gira una forma de boceto alrededor de un eje. 

• Sweep: Empuja una forma de boceto o perfil cargado a lo largo de una ruta 
especificada. 

• Swept  Mezcla las propiedades de blend y sweep. A diferencia de sweep solo 
contiene un segmento de línea. 

 
Familias anidadas 
 
Manejar una forma compleja puede volverse complicado. En muchos casos, tiene sentido 
dividir las familias por piezas e insertar estas piezas en una familia que represente el todo 
del objeto. A esto se le conoce como familias anidadas. Administrar familias complejas de 
esta manera otorga más control y flexibilidad. 
 
Subcategorías y Parámetros de visibilidad. 
 
Cada uno de los elementos dentro de una familia puede pertenecer a una subcategoría. 
Las subcategorías proporcionan un nivel adicional de visbilidad y control gráfico sobre las 
partes de una familia. 
 
Los parámetros de visibilidad son otra forma de controlar elementos dentro de una familia. 
Estos parámetros otrogan al usuario la posibilidad de activar y desactivar la visbilidad de 
un elemento dependiendo si es necesario mostrarlo o no según una situación dada. 
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Capítulo 4 
 

Cimentación Estructural 
 
Hay tres tipos de cimentaciones estructurales en Revit: 
 

1. Isolated Foundation (Zapata Aislada): Representan una cimentación debajo de 
una columna, además de poder colocarse en cualquier otro lugar. 

2. Wall Foundation (Zapata de Muro): Representan una cimentación debajo de un 
muro, estos elementos solo se pueden colocar en muros. 

3. Slab Foundation: Representa una losa de cimentación. 
 
Todos los elementos solo se pueden crear desde la Pestaña Structure y tienen elementos 
analíticos que se crean con ellos. 
 
Creación y Colocación de Zapatas Aisladas 
 
Creación de zapatas aisladas 
 
Tipo de Familia: Familia de Componente (Cargable). 
 
Utilizar la cimentación estructural aislada para colocar una zapata debajo de una columna 
estructural. Para crear una zapata aislada: 
 

1. Hacer Click en Pestaña File → Opción New → Family 
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2. Elegir la plantilla con el nombre “Metric Structural Foundation” y hacer click en 
Open. 

 

 
 

3. Definir la ubicación del punto de inserción en planta y elevación. Por defecto las 
plantillas cuentan con una vista de alzado de los lados: izquierdo, derecho, frente y 
detrás, y su punto de inserción se encuentra en el cruce de los planos de 
referencia “Center (Front/Back)” y “Center (Left/Right)” como se muestra a 
continuación: 
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4. Crear los planos de referencia con la herramienta ubicada en la Pestaña Create → 

Panel Datum → Reference Plane. . 
 

Nota: Podemos cambiar el punto de inserción cambiando el punto de origen de la 
familia, seleccionando los planos de referencia y activando la casilla “Defines 
Origin”. Una vez hecho esto se recomienda bloquear la posición de los planos de 

referencia que definen el nuevo origen con la herramienta Pin . 
 

 
 

5. Crear los parámetros necesarios para controlar la familia. 
 

a. Pestaña Create → Panel Properties → Family Types . 
b. Utilizar las siguientes herramientas para gestionar el cuadro de diálogo 

Family Types: 
 

▪ Type Name: Selecciona el tipo en el que se van a editar los valores 
de los parámetros. 

 

•  
 

▪ New Type  : Agrega un tipo a la familia. El tipo recién creado 
copia todos los valores de parámetros y fórmulas del tipo 
seleccionado actualmente. 

 

▪ Rename Type  : Abre un cuadro de diálogo en el que se puede 
ingresar un nuevo nombre para el tipo de familia. 
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▪ Delete Type  : Elimina el tipo de familia actualmente 
seleccionado. 

 

▪ Search  : Acepta cadenas de texto para limitar la lista de 
parámetros del tipo de familia. El campo de búsqueda coincide con 
cadenas de texto en los campos Parámetro, Valor y Fórmula. Por 
ejemplo, ingrese el grosor para mostrar solo los parámetros que 
contienen la palabra grosor. 

 

•  
 

▪ Borrar Búsqueda  : Borra la cadena de texto de búsqueda para 
revelar todos los parámetros disponibles. 

 
▪ Columnas de tabla: 

 

• Parameter: Para editar este campo, haga Click en el botón 

 (Edit Parameter) 

• Value: Edita el valor asociado con el parámetro. 

• Formula: Muestra la fórmula que puede generar el valor del 
parámetro. Las fórmulas se pueden usar para calcular 
valores basados en los valores de otros parámetros. 

• Lock: Restringe el parámetro al valor actual. 
 

▪ Edit Parameter  : Abre el cuadro de diálogo Propiedades del 
parámetro para modificar el parámetro seleccionado actualmente. 
Tenga en cuenta que hay parámetros integrados que no se pueden 
editar en la mayoría de las familias de Revit. 

 

▪ New Parameter  : Abre el cuadro de diálogo Propiedades de 
parámetro para crear un nuevo parámetro para la familia. 

 

▪ Delete Parameter  : Elimina el parámetro actualmente 
seleccionado de la familia. Tenga en cuenta que hay parámetros 
integrados que no se pueden eliminar en la mayoría de las familias 
de Revit. 

 

▪ Move Parameter Up  : Reposiciona el parámetro uno arriba en la 
lista de parámetros de diálogo dentro de su grupo. 

 

▪ Move Parameter Down : Reposiciona el parámetro uno abajo en 
la lista de parámetros de diálogo dentro de su grupo. 

 

▪ Sort Parameters in ascending order  : Ordena la lista de 
parámetros de diálogo en orden alfabético dentro de cada grupo. 
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▪ Sort Parameters in descending order  : Ordena la lista de 
parámetros de diálogo en orden alfabético inverso dentro de cada 
grupo. 

 
c. Crear o identificar los parámetros necesarios: 

 
i. Hacer Click en New parameter. 
ii. En el cuadro de diálogo Propiedades de Parámetro establecer: 

 
1. En el apartado Parameter Type definir si será un Parámetro 

de Familia o un Parámetro compartido. 
 

 
 

2. En el apartado Parameter Data definir: 
 

• Nombre del parámetro. 

• Disciplina del parámetro y Tipo de parámetro, según 
su disciplina desplegará los tipos de parámetros: 

 

• Common: Text, Number, Length, Area, 
Volume, Angle, Mass Density, URL, Material, 
etc. 

• Structural: Force, Moment, Unit Weight, 
Mass, Velocity, Acceleration, Moment of 
Inertia, etc. 

• HVAC: Density, Friction, Power, Pressure, 
Temperature, Velocity, Air Flow, Duct size, 
etc. 
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• Electrical: Current, Electrical Potencial, 
Illuminance, Luminous Flux, Luminous 
Intensity, Wattage, etc. 

• Piping: Density, Flow, Friction, Pressure, 
Temperature, Velocity, etc. 

• Energy: Thermal Resistance, Thermal Mass, 
Thermal Conductivity, Specific Heat, etc. 

 

• Grupo de parámetro bajo el cual se debe mostrar el 
parámetro en la Paleta de Propiedades. (Group 
Parameter Under) 

• Descripción del parámetro en el apartado Tooltip, está 
información solo puede contener 250 caracteres y es 
opcional de llenar. 

• Elegir si el parámetro se almacena por instancia o 
tipo. 

 

 
 

iii. Hacer Click en OK. 
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6. Crear una relación entre los parámetros y los planos de referencia por medio de 

una cota: 
 

a. Crear una cota a los planos de referencia que controlarán la geometría de 
la familia. 

 

 
 

b. Para asignar un parámetro a una cota: 
Seleccionar la cota que se le asignará el parámetro → Pestaña Modify → 
Panel Label Dimensión → Desplegar catálogo de parámetros → 
Seleccionar el que se necesita. 
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Nota: Se recomienda restringir la geometría a un crecimiento proporcional 
respecto a su origen con cotas tomadas a los planos de referencia 
extremos y al centro de la familia para un mejor comportamiento de la 
familia, como muestra la imagen. (Cotas EQ) 

 
7. Crear la geometría necesaria con las herramientas de Extrusion, Blend, Revolve, 

Sweep y Swept Blend, y anclar su boceto o la geometría misma a los planos de 
referencia. 

 

a. Activar herramienta Align: Pestaña Modify → Panel Modify → Align . 
b. Seleccionar el plano de referencia al que se desea alinear. 
c. Seleccionar la línea de boceto o borde de geometría que se desea alinear. 

d. Dar click en el candado abierto para cerrarlo  → . 
 

8. Asignar un material a la geometría generada: 
 

a. Crear materiales de Revit: 
 

 Pestaña Manage → Panel Settings → Materials  
 

 
 

1. Project Materials Filter :Filtra los materiales del proyecto 
por clase. 

Show / Hide Project Materials Settings Menu  : 
Permite modificar la vista de los materiales del proyecto y el 
panel de la biblioteca en la ventana del Explorador de 
materiales. Puede utilizar el menú de configuración de los 
materiales del proyecto para filtrar la visualización de los 
materiales en la lista de materiales del proyecto. 
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2. Project Materials List: muestra los materiales del proyecto 

actual, independientemente de si están o no aplicados a 
objetos. Haga clic con el botón derecho en un material de la 
lista para acceder a un menú de tareas comunes, como 
Cambiar nombre, Duplicar y Añadir a la biblioteca. 

 
3. Material Libraries Toolbar: Proporciona controles para 

gestionar bibliotecas, o abrir y cerrar el Explorador de 
materiales. 

Show / Hide Library Tree : Para mostrar u ocultar la 
visualización de la biblioteca. Es posible que deba ocultar la 
visualización de la biblioteca para proporcionar más espacio 
para ver los materiales de la biblioteca. 

Library Settings Menu : Para filtrar la visualización de 
los materiales presentados en la lista de materiales de la 
biblioteca. 
 

4. Library List: Muestra bibliotecas y categorías abiertas 
(clases) dentro de bibliotecas. 

 
5. Library Materials List: Muestra materiales en la biblioteca o 

categoría (clase) seleccionados en la lista de la biblioteca. 
(Library List) 

 
6. Material Browser Toolbar: Proporciona controles para 

administrar bibliotecas, crear materiales nuevos o duplicados 
existentes, o abrir y cerrar el navegador de activos (Asset 
Browser). 

 
7. Material Editor:  

 

• Identity: Información como descripción, fabricante, 
costo y keynotes. 

• Graphics: Controla la apariencia del material en una 
vista no renderizada, como: Color en una vista 
sombreada en el proyecto, color y patrón que se 
muestra en una superficie de un elemento; y color y 
patrón de relleno que se muestra cuando se corta el 
elemento. 

• Appearance: Muestra en una vista renderizada, una 
vista realista o una vista de trazado de rayos (Ray 
Trace). 

• Physical: Utilizadas para el análisis estructural. 

• Thermal: Utilizadas para el análisis energético. 
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b. Asignar Material a la geometría: 

 
i. Seleccionar extrusión → Paleta de Propiedades → Grupo de 

Parámetros Material and Finishes → Parámetro Material → . 
ii. Seleccionar el Material deseado en el cuadro de diálogo “Material 

Browser”. 
iii. Dar Click en OK.  

 

 
 

c. Asignar Material a la geometría por parámetro 
 

i. Seleccionar Pestaña Modify → Panel Properties → Family Types 
ii. Crear un Parámetro de tipo Material. 
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iii. Asignar un material al parámetro: 

1.  Dar click en  dentro del valor del parámetro. 
2. Seleccionar material deseado. 
3. Dar click en OK. 

 

 
 

iv. Seleccionar extrusión → Paleta de Propiedades → Grupo de 
Parámetros Material and Finishes → Parámetro Material → 
Associate Family Parameter. 

v. Seleccionar Parámetro creado anteriormente para asociarse. 
vi. Dar click en OK. 
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9. Definir material para el comportamiento en modelo (Material for model Behavior): 

 
a. Paleta de propiedades → Grupo Structural → Desplegar parámetro Material 

for model Behavior → Seleccionar Concrete 
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11. Cargar Familia al Proyecto 

 
Después de trabajar en el Editor de familias para crear o modificar una familia, 
puede cargar la familia en uno o más proyectos abiertos: 

 
a. En el Editor de Familias, hacer click en la Pestaña Create → Panel Family 

Editor: 
 

• Load into Project  : La familia permanecerá abierta 

• Load into Project and Close  : Advierte de guardar el archivo  
que cerrará después de que se cargue en el proyecto 
seleccionado. 

 
Nota: En cualquier caso, si solo hay un proyecto actualmente abierto, la familia se 
carga en ese proyecto. 

 
Colocación de zapatas aisladas 
 
Para colocar una familia de zapata aislada: 
 

1. Dirigirse a Pestaña Structure →  Panel Foundation → Isolated  
2. En la Paleta de Propiedades seleccionar el tipo de zapata aislada desde el 

Selector de Tipos. 
 

 
 

Nota: En caso de no tener cargada la familia que se necesita, se puede cargar 

desde la Pestaña Modify → Panel Mode → Load Family . 
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3. Para colocar la familia de zapata aislada: 

 
a. De forma individual: 

 
i. Definir en la Barra de Opciones: 

 

 
 

• Rotate after Placement: Seleccionar esta opción para rotar 
la zapata inmediatamente después de colocarla. 

• Level. (Solo vistas 3D): Seleccionar un nivel donde se 
colocará la zapata. Para las vistas de planta, el nivel de la 
vista es el nivel base de la zapata. 

ii. Hacer click en el área de dibujo donde se ubicará la zapata. 
iii. Si se activó la casilla de Rotate after placement, definir ángulo de 

rotación de forma manual o utilizar la casilla de Angle en la barra de 

opciones . 
 

b. Múltiples zapatas en intersección de ejes. 
 

i. Dirigirse a la Pestaña Modify → Panel Multiple → At Grids  
ii. Seleccionar los ejes donde se colocarán las zapatas aisladas. (Se 

mostrará una previsualización de la zapata que se insertará) 

iii. Hacer click en Finish  para confirmar su colocación. 
 

c. Múltiples zapatas debajo de columnas: 
 

i. Dirigirse a la Pestaña Modify → Panel Multiple → At Columns  
ii. Seleccionar las columnas donde se colocarán las zapatas aisladas. 

(Se mostrará una previsualización de la zapata que se insertará) 

iii. Hacer click en Finish  para confirmar su colocación. 
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Edición y Colocación de Zapatas en Muro 
 
Tipo de Familia: Familia de Sistema 
 
Usar la herramienta Wall Foundation para colocar una zapata de muro debajo de un muro 
estructural. La zapata del muro permanecerá unida y se moverá con él 
 
Edición de una Zapata de Muro 
 

1. Buscar en el Navegador de Proyectos, en el apartado de familias, la categoría Wall 

Foundation y desplegar las familias y tipos con click en el ícono . 
2. Dar Click derecho en el tipo y seleccionar la opción Type Properties... 

 

 
 

3. En el cuadro de diálogo Propiedades de Tipo Duplicar el tipo y nombrar. 
4. Una vez Duplicado el tipo, modificar las propiedades: 

 

• Structural Material: Para cambiar el material de la zapata de muro. 

• Structural Usage: Especifica el tipo de uso del muro: Retaining 
(Contención), Bearing (Carga). 

• Toe Length: Únicamente para los muros de contención. Especifica la 
distancia entre el borde de la cara interior del muro y el borde de la 
cimentación. 

• Heel Length: Únicamente para los muros de contención. Especifica la 
distancia entre el borde de la cara exterior del muro y el borde de la 
cimentación. 

• Width: Únicamente para los muros de carga. Especifica el ancho total de la 
cimentación del muro. 

• Foundation Thickness: Especifica el peralte de la cimentación. 
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• Default End Extension Length: Especifica la distancia que se extenderá la 
cimentación más allá del extremo del muro. 

 

 
• Do not Break at Inserts: Especifica si la cimentación es continua o si se 

divide bajo inserciones como puertas o ventanas que se extienden hasta la 
base del muro. 

 

 
 
Nota: En la Paleta de Propiedades se puede modificar el parámetro Eccentricity 
(disponible solo para cimentaciones de muro de carga) para especificar el desface entre el 
centro del muro y el centro de la zapata de muro. 
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Colocación de una Zapata de Muro 
 
Para colocar una familia de zapata de muro: 
 

1. Dirigirse a Pestaña Structure →  Panel Foundation → Wall . 
2. Seleccionar el tipo de zapata a colocar en el Selector de Tipo. 
3. Seleccionar el muro que va a recibir la cimentación de muro. 
 
La zapata de muro se colocará debajo de los muros seleccionados. 
 
4. De ser necesario se puede ajustar la extensión de la zapata de muro de forma 

manual, arrastrando los puntos de control que se muestran al seleccionar la 
zapata en una vista. 

 

 
 
Edición y Colocación de Losas de Cimentación 
 
Tipo de Familia: Familia de Sistema 
 
Las losas de cimentación se crean de la misma manera que las losas estructurales. 
 
Edición de una Losa de Cimentación 
 

1. Buscar en el Navegador de Proyectos, en el apartado de familias, la categoría 

Foundation Slab y desplegar las familias y tipos con click en el ícono . 
2. Dar Click derecho en el tipo y seleccionar la opción Type Properties... 
3. En el cuadro de diálogo Propiedades de Tipo Duplicar el tipo y nombrar. 
4. Una vez Duplicado el tipo, modificar las propiedades: 

 

• Structure: Especifica la composición de una losa, muro o techo; para 
agregar, editar o eliminar alguna de las capas que la componen, hacer click 
en Edit para abrir el cuadro de diálogo Edit Assembly. 
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• Insert: Inserta una capa, para editar la capa se debe seleccionar. 

• Delete: Elimina una capa. 

• Up / Down: Cambia el orden de las capas. 
 

• Function: Determina la función y prioridad de las capas al unirse 
con otro elemento. 

 
Capas: 

• Structure [1]: Capa que soporta el resto de la pared, el piso 
o el techo. 

• Substrate [2]: Material, como madera contrachapada o 
panel de yeso, que actúa como base para otro material. 

• Thermal / Air Layer [3]: Proporciona aislamiento y evita la 
penetración de aire. 

• Membrane Layer: Una membrana que comúnmente evita la 
penetración de vapor de agua. La capa de membrana debe 
tener espesor cero. 

• Finish 1 [4]: El acabado 1 es típicamente la capa exterior. 

• Finish 2 [5]: El acabado 2 es típicamente para la capa 
interior. 

 
La siguiente ilustración muestra capas de mayor prioridad 
uniéndose antes que las capas de menor prioridad. La capa de 
CMU de Prioridad 1 del muro horizontal pasa a través de todas las 
capas, hasta que alcanza la capa Stud de Prioridad 1 de la pared 
vertical. 
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Consideraciones al aplicar las capas en los elementos: 
 

• Cuando las capas se unen, la unión se limpia si las 2 capas tienen el mismo 
material. Si las 2 capas tienen materiales diferentes, aparece una línea en la 
unión. 

• Cada capa debe tener una función asignada para que Revit coincida las capas con 
precisión. 

 
La siguiente ilustración muestra cómo una capa de menor prioridad dentro del núcleo 
(Core) pasa a través de capas de mayor prioridad fuera del núcleo (Core). La capa de 
aislamiento (Insulation) de la pared horizontal se ha movido dentro del núcleo. La capa 
de aislamiento ahora puede pasar a través de cualquier capa fuera del núcleo, 
independientemente de su prioridad. 
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• Material: Para asignar un material a la capa creada. 

• Thickness: Para determinar el grosor de la capa creada. 

• Wraps (Disponible solo para muros): Permite especificar las 
preferencias de ajuste de capas en los extremos, como al término 
del muro (At Ends) y vanos creados por elementos que lo corten (At 
Inserts). 

• Structural Material (Disponible para muros y techos): Aplicar 
para capas dentro del núcleo del elemento, que necesiten adoptar 
las características establecidas en la configuración del material en 
el apartado de Physical en el modelo analítico estructural. 

 

• Coarse Scale Fill Pattern: Especifica un patrón de relleno para un 
elemento en corte por la vista, con un Nivel de Detalle Coarse. 

• Coarse Scale Fill Color: Especifica el color de un patrón de relleno para 
un elemento en corte por la vista, con un Nivel de Detalle Coarse. 

 
Colocación de una Losa de Cimentación 
 
Las losas de cimentación son elementos basados en bocetos que contienen cualquier 
número de capas de material según lo definido por el usuario, la parte superior del objeto 
de piso es su referencia, con respecto al nivel en el que se creó. Como tal, los cambios en 
la estructura de un piso afectarán su profundidad hacia abajo del nivel, de manera similar 
a cómo se ajusta el grosor de un muro en relación con sus líneas de ubicación (Location 
lines). 
 

 
 
Para colocar una Losa de Cimentación: 
 

1. Dirigirse a Pestaña Structure →  Panel Foundation → Slab  
2. Especificar un tipo de losa de cimentación del Selector de Tipo. 
3. Dirigirse a Pestaña Modify | Create Floor Boundary → Panel Draw → Boundary 

Line . 
 

a. Elegir entre cualquiera de las líneas de boceto para definir el contorno de la 
losa de cimentación. 

b. Elegir Pick Walls  para seleccionar los muros de su modelo. 
 

• En la barra de opciones, activar la casilla Extend into wall (to core) 

 si desea que el borde de la losa se 
coloque al núcleo del muro. 
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• En la barra de opciones, especificar un desface respecto a la cara 
del muro donde se desea colocar el borde de losa. 

 
 

4. Especificar la dirección de la losacero con la herramienta Span Direction. 
5. Definir pendiente bajo cualquiera de los siguientes métodos: 

 
a. Slope Arrow: Cuando dibuja una flecha de pendiente, puede ingresar 

valores para especificar la altura en su cabeza y cola, o un valor de 
pendiente, al modificar sus parámetros en la Paleta de Propiedades 

 

• Specify: Para configurar una altura en cada extremo de la flecha 
(Height at Tail) o indicar una pendiente (Slope). 

• Level at Tail: Nivel referido en la cola de la flecha. 

• Height Offset at Tail: Desfase respecto al nivel indicado en Level at 
Tail. 

• Level at Head: Nivel referido en la cabeza de la flecha. 

• Height Offset at Head: Desfase respecto al nivel indicado en Level 
at Head. 

• Slope (Disponible solo si se elige Slope en el parámetro 
Specify): Define los grados de la pendiente. 

 

 
 

b. Parallel Sketch Lines: En el modo de boceto, seleccionar líneas de borde 
paralelas y activar la casilla Defines Constant Height en la Paleta de 
Propiedades. Después definir los siguientes parámetros en la Paleta de 
Propiedades: 

 

• Level: Nivel referido en la línea seleccionada. 

• Offset From Base: Desfase respecto al nivel referido. 
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c. Defines Slope: En el modo de boceto, seleccionar una sola línea de boceto 

y activar la casilla Defines Slope en la Barra de Opciones . 
Una vez activada la casilla definir los siguientes parámetros en la Paleta de 
Propiedades: 

 

• Level: Nivel referido en la línea seleccionada. 

• Offset From Base: Desfase respecto al nivel referido. 

• Slope: Define los grados de la pendiente. 
 

6. Hacer click en Finish  para confirmar su colocación. 
 
Consideraciones de Losas de Cimentación. 
 

• • Las losas de cimentación solo pueden inclinarse en una dirección. 

• • No es posible modificar las subelementos de las losas de cimentación como la 
categoría de losas. 

 

 
 
 
Edición y Colocación de Bordes de Losas de Cimentación 
 
Tipo de Familia: Familia de Sistema 
 
Slab Edges es una herramienta que permite crear porciones gruesas de losas ubicadas 
típicamente en los bordes de las losas. Un tipo de borde de losa se compone de una 
familia de perfil y una asignación de material. Es importante que la asignación de material 
del borde de la losa coincida con la del piso al que se aplicará la losa para garantizar la 
correcta unión de la geometría. 
 
Edición de un Borde de Losa 
 

1. Buscar en el Navegador de Proyectos, en el apartado de familias, la categoría 

Floors y desplegar las familias Slab Edge y tipos con click en el ícono . 
2. Dar Click derecho en el tipo y seleccionar la opción Type Properties... 
3. En el cuadro de diálogo Propiedades de Tipo Duplicar el tipo y nombrar. 
4. Una vez Duplicado el tipo, modificar las propiedades: 

 

• Profile: Para elegir la forma del perfil para el borde de la losa. Seleccione 
de una lista de perfiles predefinidos o cree su propio perfil utilizando la 
plantilla profile-hosting.rft. 

• Material:  Especifica la apariencia del borde de losa. 
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Colocación de Borde de Losa 
 
Para colocar un Borde de Losa: 
 

1. Dirigirse a Pestaña Structure →  Panel Foundation → Floor Slab Edge  
2. Especificar un tipo de borde de losa del Selector de Tipo. 
3. Seleccionar borde de la losa donde se colocará. 
4. Especificar en la Paleta de Propiedades: 

 

• Vertical Profile Offset: Mueve el borde de la losa por encima o por debajo 
del borde en el que lo creó. 

• Horizontal Profile Offset: Mueve el borde de la losa hacia adelante o 
hacia atrás desde el borde en el que lo creó. 

• Angle: Gira el borde de la losa al ángulo deseado. 
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Capítulo 5 
 

Columnas Estructurales 
 
Las Columnas Estructurales traen consigo el modelo analítico que se requiere al vincular 
el modelo con un software de Análisis estructural, como Robot Structural Analysis. 
 

 
 
 
Además, las columnas no estructurales no alojarán ninguna carga ni soportarán otros 
componentes estructurales, por lo tanto, las columnas arquitectónicas no deben usarse en 
un modelo estructural. 
 
Creación y Colocación de Columnas Estructurales 
 
Creación de Columnas Estructurales 
 
Tipo de Familia: Familia de Componente (Cargable). 
 

1. Hacer Click en la Pestaña File → Opción New → Family 
2. Elegir la plantilla con el nombre “Metric Structural Column” y hacer click en Open. 
3. Definir la ubicación del punto de inserción en planta y elevación.  
4. Crear los planos de referencia con la herramienta ubicada en la Pestaña Create → 

Panel Datum → Reference Plane. . 
5. Crear o identificar los parámetros necesarios para controlar la familia. 
6. Crear una relación entre los parámetros y los planos de referencia por medio de 

una cota: 
7. Crear la geometría necesaria con las herramientas de Extrusion, Blend, Revolve, 

Sweep y Swept Blend, y anclar su boceto o la geometría misma a los planos de 
referencia. Incluyendo a los niveles (superior / Inferior) 

 



85 
 

 
 
8. Asignar un material a la geometría generada: 
9. Definir material para el comportamiento en modelo (Material for model Behavior): 

 
 

Colocación de Columnas Estructurales 
 
Para colocar las columnas estructurales: 
 

1. Dirigirse a Pestaña Structure →  Panel Structure → Column  
2. En la Paleta de Propiedades seleccionar el tipo de columna desde el Selector de 

Tipos. 
 
Nota: En caso de no tener cargada la familia que se necesita, se puede cargar 

desde la Pestaña Modify → Panel Mode → Load Family . 
 

3. Para colocar la familia de Columna Estructural: 
 

a. Colocación manual de forma vertical: 
 

i. Elegir en la Pestaña Modify | Place Structural Column → Panel 
Placement → Vertical Column. 
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ii. Definir en la Barra de Opciones: 
 

 

• Rotate after placement: Seleccionar esta opción para rotar 
la columna inmediatamente después de colocarla. 

• Level. (Solo vistas 3D): Seleccionar un nivel para la base 
de la columna. Para las vistas de planta, el nivel de la vista 
es el nivel base de la columna. 

• Depth / Height: Seleccionar Depth para dibujar la columna 
hacia abajo a partir de su base. Seleccionar Height para 
dibujar la columna hacia arriba desde su base. 

• Level / Unconnected: Seleccionar un nivel para la parte 
superior de la columna, o seleccionar No conectada 
(Unconnected) y especificar la altura de la columna. 

 

iv. Hacer click en el área de dibujo donde se ubicará la columna. 
v. Si se activó la casilla de Rotate after placement, definir ángulo de 

rotación de forma manual o utilizar la casilla de Angle en la barra de 

opciones . 
 

Nota: Mientras se colocan las columnas se puede utilizar la barra 
espaciadora para cambiar la orientación de la columna. Cada vez que se 
pulse la barra espaciadora, el componente rotará para alinearse con ejes y 
en caso de no haber ejes, la columna se rotará 90 grados. 
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b. Colocación manual de forma inclinada. 
 

i. Elegir en la Pestaña Modify | Place Structural Column → Panel 
Placement → Slanted Column. 

 

  
 

ii. Definir en la Barra de Opciones: 
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• 1st Click: Seleccionar el nivel para el punto de inicio de la 
columna. De ser necesario especificar un desfase respecto 
al nivel especificado y la columna en el cuadro de texto. 

• 2nd Click: Seleccionar el nivel para el punto final de la 
columna. De ser necesario especificar un desfase respecto 
al nivel especificado y la columna en el cuadro de texto. 

• 3D Snapping: Activar casilla si desea que uno o ambos 
extremos de la columna se ajusten a elementos previamente 
colocados, Este método de colocación proporciona precisión 
cuando se coloca en secciones, elevaciones o vistas 3D. 

 
iii. Hacer el primer y segundo click en el área de dibujo donde se 

ubicará la columna. 
 
Nota: Si se coloca la columna inclinada en una sección o elevación 
se abrirá una ventana nueva donde se tiene que especificar el plano 
de trabajo (Work Plane) donde se desea colocar la columna 
 

 
 

Una vez especificado el plano de trabajo permitirá hacer el primer y 
segundo click en el área de dibujo. 

 
iv. Especificar en la Paleta de Propiedades → Grupo de parámetros 

Constraints: 
 

• Column Style: Define cómo la columna se ajusta al modelo. 
 

 



89 
 

 
a. Slanted–Angle: Este estilo permite controlar la 

inclinación de la columna por medio de un ángulo fijo, 
manteniendo el mismo cuando se cambia la posición 
de los componentes enlazados a la columna. 
Ej. La columna está enlazada en la parte superior 
con una losa, al cambiar el nivel de la losa la 
columna se moverá con ella respetando el ángulo de 
inclinación de 50°. 
 

 
 

b. Slanted-End Point Driven: Este estilo permite 
mantener la posición de los extremos unidos cuando 
se cambia la posición de los componentes 
enlazados. 
Ej. La columna está enlazada en la parte superior 
con una losa, al cambiar el nivel de la losa la 
columna se moverá con ella respetando la relación 
de sus puntos de control finales. 
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• Move Top With Grids: El punto de control final superior de 
la columna se mueve cuando se mueve un eje que lo 
intercepta. Los ejes que pasan a través del punto de control 
final superior de la columna establecen una relación con la 
columna. Cuando se mueve el eje, el punto de control final 
superior de la columna se moverá para mantener la relación. 
Las columnas se pueden mover independientemente de los 
ejes al desactivar la casilla. 

 

• Move Base With Grids: El punto de control final inferior de 
la columna se mueve cuando se mueve un eje que lo 
intercepta. Los ejes que pasan a través del punto de control 
final inferior de la columna establecen una relación con la 
columna. Cuando se mueve el eje, el punto de control final 
inferior de la columna se moverá para mantener la relación. 
Las columnas se pueden mover independientemente de los 
ejes al desactivar la casilla. 

 

• Cross-Section Rotation: Al presionar la barra espaciadora 
la columna seleccionada rotará 90° alrededor de su centro 
en el sentido de las agujas del reloj. Para realizar ajustes 
más finitos a esta rotación en columnas inclinadas, puede 
editar esta propiedad. 

 
v. Especificar en la Paleta de Propiedades → Grupo de parámetros 

Construction: 
En caso de que las columnas inclinadas no estén enlazadas a 
ningún componente, se puede cortar o ajustar la geometría de la 
columna por medio de la herramienta Cut Style. 
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En caso de que las columnas inclinadas estén enlazadas a un 
componente, se puede cortar o ajustar la geometría de la columna 
por medio de la herramienta Attachment Justification. 
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c. Colocación en intersección de ejes. 

 
i. Elegir en la Pestaña Modify | Place Structural Column → Panel 

Multiple → At Grids.  
ii. Seleccionar los ejes donde se colocarán las columnas. (Se mostrará 

una previsualización de la columna que se insertará como se 
muestra en la imagen). 

 

 
 

iii. Presionar la barra espaciadora para rotar las columnas que se están 
creando. 

iv. Hacer click en Finish  para confirmar su colocación. 
 

d. -Colocación dentro de columnas arquitectónicas. 
 

i. Elegir en la Pestaña Modify | Place Structural Column → Panel 

Multiple → At Columns.  
ii. Seleccionar las columnas arquitectónicas donde se colocarán las 

columnas estructurales. (Se mostrará una previsualización de la 
columna que se insertará) 

iii. Hacer click en Finish  para confirmar su colocación. 
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Herramientas de ajuste manual 
 
Las columnas inclinadas incorporan controles de arrastre y cambio de tamaño para 
modificaciones manuales. 
 

1. Controles de Flecha vertical: Los controles de flecha vertical aparecen como 
flechas azules en cualquier extremo de la columna inclinada controlada por el 
punto final. Arrastre estos controles para ajustar la elevación de la parte superior o 
la base de la columna. 

 

 
 

Estos controladores están disponibles cuando la columna tiene la propiedad de 
Column Style en Slanted – End Point Driven y pueden desaparecer cuando la 
columna esta enlazada a un componente como vigas y losas o a un plano de 
referencia. 

 
2. Controles de Punto: Los controles de punto aparecen como un punto azul en 

cualquier extremo de la columna. Arrastre estos controles para ajustar la posición 
de la parte superior o base de la columna. 
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3. Controles de Texto: Los controladores de texto ajustan de forma directa el 

parámetro de desfase. Nos permite ingresar un valor manualmente. 
 

 
 

Los controles de texto se desactivan cuando la columna esta enlazada a un 
componente como vigas y losas o a un plano de referencia. 

 
Consideraciones y recomendaciones de Columnas Estructurales 
 
Consideraciones: 
 

• Al colocar una columna, es importante tener en cuenta la dirección de la columna, 
ya sea profundidad o altura (hacia abajo desde el nivel actual o hacia arriba desde 
el nivel actual). 

• Es importante, cuando sea posible, colocar columnas en ejes y niveles. Esto 
permitirá que las columnas se muevan con los ejes y aumente / disminuya la altura 
a medida que se modifiquen los niveles. 

 
Recomendaciones: 
 

• Las columnas, como con todos los demás elementos estructurales, deben 
modelarse como cabría esperar que se construyan en el "mundo real", es decir, no 
construiría una columna desde la parte superior de los cimientos hasta la parte 
inferior del techo, por lo tanto, no debería ser modelado de esta manera en su 
proyecto en Revit. 
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Capítulo 6 
 

Trabes 
 
Existe una biblioteca completa de Vigas de Acero, Madera y Concreto en tamaños 
imperiales y métricos. Los usuarios también pueden crear familias de vigas 
personalizadas según sea necesario. Los marcos estructurales se pueden crear utilizando 
los comandos de Sistema de Viga (Beam System), Armadura (Truss), Contraventeo 
(Brace) y Viga (Beam). El sistema de vigas y el comando de armadura crearán un grupo 
de componentes de vigas y es posible administrar el modelo analítico de cada 
componente incluido dentro de ese grupo. Se puede acceder a estos comandos desde la 
Pestaña Structure → Panel Structure. 
 

 
 
Creación y Colocación de Trabes 
 
Creación de Trabes 
 
Tipo de Familia: Familia de Componente (Cargable). 
 

1. Hacer Click en la Pestaña File → Opción New → Family 
2. Elegir la plantilla con el nombre “Metric Structural Framing- Beams and Braces” y 

hacer click en Open. 
3. Definir la ubicación del punto de inserción en planta y elevación.  
4. Crear los planos de referencia con la herramienta ubicada en la Pestaña Create → 

Panel Datum → Reference Plane. . 
 

Nota: La plantilla Structural Framing cuenta con planos de referencia que nos 
ayudan a la creación de la geometría. 
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5. Crear o identificar los parámetros necesarios para controlar la familia. 
6. Crear una relación entre los parámetros y los planos de referencia por medio de 

una cota: 
7. Crear la geometría necesaria con las herramientas de Extrusion, Blend, Revolve, 

Sweep y Swept Blend, y anclar su boceto o la geometría misma a los planos de 
referencia. Incluyendo Stick Symbol, Member (Left / Right) y Left /Right mostrados 
en la imagen anterior. 

 

 
 
8. Asignar un material a la geometría generada: 
9. Definir material para el comportamiento en modelo (Material for model Behavior): 
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Colocación de Trabes 
 
Para colocar una familia de Trabe: 
 

1. Dirigirse a Pestaña Structure →  Panel Structure → Beam  
2. En la Paleta de Propiedades seleccionar el tipo de viga desde el Selector de Tipos. 

Nota: En caso de no tener cargada la familia que se necesita, se puede cargar 

desde la Pestaña Modify → Panel Mode → Load Family . 
 

3. Para colocar la familia de Trabe: 
 

a. De forma individual: 
 

i. Definir en la Pestaña Modify → Panel Draw la línea de boceto 
deseada. 

ii. Definir en la Barra de Opciones: 
 

 
 

• Placement Plane: Define el nivel donde se ubicará la viga. 
En una vista en planta, todos los niveles y planos de 
referencia horizontales nombrados aparecen en esta lista. 
En una vista 3D, esta lista también muestra ejes para ayudar 
a restringir la colocación de las vigas. 

•  Structural Usage: Es una forma de categorizar diferentes 
tipos de elementos, también es útil para filtrar tablas de 
cuantificación o controlar la visibilidad. Igualmente es 
información relevante cuando el modelo estructural se 
exporta a un software de análisis estructural. La mejor 
práctica es dejar este apartado en "Automático" 

 
La herramienta contempla cinco usos estructurales para las trabes: 

 

Girder Trabe Principal 

Joist Trabe Secundaria 

Purlin Largueros 

Horizontal Bracing Contraventeo Horizontal 

Other Uso definido por el usuario 
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Para la colocación automática, el programa define el uso estructural 
basado en los elementos que conectan con la trabe. 

 

 Columna Contraventeo Contraventeo 
Horizontal 

Girder Joist Purlin Other 

Muro G O HB G J P O 

Columna G O HB G J P O 

Brace  O O O O O O 

Horizontal 
Bracing 

  HB HB HB HB O 

Girder    J J P O 

Joist     P P O 

Purlin      P O 

Other       O 

 

• 3D Snapping: Activar casilla si desea que uno o ambos 
extremos de la trabe se ajusten a elementos previamente 
colocados, Este método de colocación proporciona precisión 
cuando se coloca en secciones, elevaciones o vistas 3D. 

• Chain: Esta herramienta permite colocar trabes de forma 
sucesiva. El segundo clic al colocar una trabe determinará el 
inicio de la siguiente y así sucesivamente. Pulsar “Esc” para 
finalizar la colocación de trabes en cadena. 

 
iii. Hacer el primer click para el punto inicial y segundo click para el 

punto final de la trabe en el área de dibujo donde se ubicará. 
 

Nota 1: Antes de dar el segundo clic del punto final, la herramienta 
nos permite ingresar un valor numérico para la longitud de la viga. El 
valor se puede asignar desde el teclado numérico. 
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Nota 2: Si el modelo cuenta con otros componentes estructurales 
(muros y columnas) el cursor se fuerza hacia estos componentes. 
Este forzado de cursor también ocurre en ejes y en la intersección de 
ejes. 

 

 
 

b. Colocación en ejes. 
 

i. Elegir en la Pestaña Modify | Place Beam → Panel Multiple → On 

Grids.  
ii. Seleccione el eje en el cual se colocará a lo largo una trabe. 

Nota: Se generarán automáticamente entre todas las columnas, 
muros y trabes. 

iii. Hacer click en Finish  para confirmar su colocación. 
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Propiedades de Trabes 
 
La elevación de las trabes se puede modificar de manera paramétrica desde las 
siguientes formas: 
 

1. Paleta de Propiedades → Grupo de Parámetros Structural → Start / End 
Attachment Type 

 

 
 
Este parámetro da la oportunidad de escoger entre dos opciones: End Elevation (por 
defecto) y Distance. 
 

• End Elevation: Orienta los extremos de la trabe hacia la elevación en que se 
ha modelado la trabe. 
Ej. La trabe modelada está conectada a las columnas y al cambiar la elevación 
de las columnas la trabe mantiene su elevación en los extremos de forma 
independiente. 
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• Distance: Orienta los extremos de la trabe a la ubicación de la unión de las 
columnas. 
Ej. La trabe modelada está conectada a las columnas y al cambiar la elevación 
de las columnas la trabe moverá su elevación en los extremos junto con las 
columnas. 

 

 
 

2. También se puede modificar con la línea de ubicación, la línea de ubicación 
(Location Line) se puede visualizar en todas las vistas en todo momento solo se 
debe encender desde la pestaña Visibility Graphics. 

 
Para editar la línea de ubicación es necesario utilizar las herramientas en la Paleta 
de Propiedades → Grupo de Parámetros Geometric Position 
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• Justificación en Y: Este parámetro da la posibilidad de modificar la posición 
de la geometría en el eje Y, dando cuatro posibilidades de posición: Origin, 
Left, Center y Right. 

 

 
 
 

Nota: La distancia que tiene de desfase con respecto a la línea de ubicación va a 
ser “0.00” por defecto, este valor se puede modificar a cualquier valor numérico 
con el parámetro de y Offset Value. 

 
 

• Justificación en Z: Este parámetro da la posibilidad de modificar la posición 
de la geometría en el eje Z, dando cuatro posibilidades de posición: Origin, 
Top, Center y Bottom. 

 

 
 

Nota: La distancia que tiene de desfase con respecto a la línea de ubicación va a 
ser “0.00” por defecto, este valor se puede modificar a cualquier valor numérico 
con el parámetro de Z Offset Value. 
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Colocación de Sistema de Trabes 

 
Para crear un sistema de trabes, la herramienta permite colocarla de manera automática y 
dibujo por boceto. Los parámetros de sistema de trabes se adaptan a cambios en el 
diseño. Si cambia la ubicación de una columna, los parámetros de sistema de trabes 
reflejarán el cambio automáticamente. 

 
Sistema de Trabes Automático 

 
Se deben cumplir con las condiciones siguientes: 

 

• El sistema de trabes automático debe de ser creado en una vista en planta. 

• Se debe contar con elementos de soporte (muros, columnas y trabes) en un bucle 
cerrado. 

 
Procedimiento: 

 
i. Escoger en la Pestaña Structure → Panel Structure → Beam 

System.  
ii. Elegir en la Pestaña Modify | Place Structural Beam System → 

Panel Beam System → Automatic Beam System  
 

iii. Definir en la barra de opciones: 
 

• Beam Type: Tipo de trabe que usará el sistema. 

• Justification: Posición que tendrá la trabe con respecto a la línea 
de ubicación. 

• Layout Rule: Regla de colocación que tendrá el sistema. 
 
Estos parámetros también se encontrarán en la Paleta de propiedades bajo 
el Grupo de Parámetros Pattern. 
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iv. Seleccionar el tablero donde se colocará el sistema de manera 

automática. 
 

Nota: Si el cursor se coloca sobre un componente dentro del bucle 
que este orientado horizontalmente, todas las vigas del sistema se 
orientaran en esa dirección; mismo caso si el cursor se coloca sobre 
un elemento vertical. 

 

 
 

v. Hacer click para finalizar el comando. 
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Sistema de Trabes por Sketch 
 

Consideraciones: 
 

• No es necesario contar con un bucle cerrado de componentes. 

• Esta opción es ideal para ajustar el sistema a elementos curvos. 
 

Procedimiento: 
 

1. Escoger en la Pestaña Structure → Panel Structure → Beam System. 

 
2. Elegir en la Pestaña Modify | Place Structural Beam System → Panel Beam 

System → Sketch Beam System  
 

3. Definir en la Paleta de Propiedades el tipo de trabe que se colocará, posición y 
regla de colocación como se hizo anteriormente con el modelado automático: 

4. Dibujar o seleccionar las líneas que definirán el contorno del sistema de trabes. 
5. Definir la dirección de las trabes con el comando Beam Direction 

 

 
 

6. Hacer click en Finish  para confirmar su colocación. 
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Sistema de Trabes Inclinado 
 
Los sistemas de vigas pueden ajustarse a diferentes inclinaciones de componentes. 
 

1. Activar el parámetro “3D” en la Paleta de Propiedades 
 

 
 

2. Dibujar su boceto con la Herramienta Pick Supports . 
 

Para identificar que nuestro sistema de trabes será inclinado una nueva simbología 
debe mostrarse como en la siguiente imagen: 

 

 
3. Hacer click en Finish  para confirmar su colocación. 
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Contraventeos 
 
Los contraventeos son miembros diagonales conectados a trabes y columnas. Puede 
añadir contraventeos en vistas de plano o en vistas de alzado. 
Los contraventeos se enlazan ellas mismas a trabes y columnas, y se ajustan 
paramétricamente a los cambios que se dan en el diseño de la construcción. Cuando 
están enlazadas a una trabe, se puede especificar el tipo de enlace, la distancia o la 
proporción. También se puede indicar el extremo del elemento con referencia respecto al 
cual se establece la distancia o la proporción; si el extremo está enlazado a una columna 
o a un muro, se puede definir el nivel y el desfase de la altura del punto. 
 
Colocación de Contraventeos 
 
Los contraventeos se pueden copiar, mover, reflejar y rotar fuera del plano vertical en que 
se hayan creado. Estas operaciones se realizan en vistas de plano y 3D. 
 
Nota: Los contraventeos se pueden colocar en vitas en planta y en alzados/secciones. 
Estos contraventeos trabajan con las familias de Structural Framing. 
 
Para colocar una familia de Cotraventeo: 
 

1. Dirigirse a Pestaña Structure →  Panel Structure → Brace  
2. En la Paleta de Propiedades seleccionar el tipo de viga desde el Selector de Tipos. 

Nota: En caso de no tener cargada la familia que se necesita, se puede cargar 

desde la Pestaña Modify → Panel Mode → Load Family . 
 

3. Para colocar la familia de Contraventeo: 
 

a. En una vista en planta: 
 

i. Definir en la Pestaña Modify → Panel Draw la línea de boceto 
deseada. 

ii. Definir en la Barra de Opciones: 
 

 
 
Esta barra de opciones permite personalizar la altura de referencia que tendrá el punto 
inicial (Start) y el punto final (End) del contraventeo. Por defecto estos valores estarán 
referenciados al nivel con un desfase de cero. 



108 
 

 
iii. Dibujar punto inicial y punto final del contraventeo. 

 

 
 

b. En una vista de alzado: 
 

i. Definir el plano de trabajo donde se colocará en el cuadro de diálogo 
Work Plane. 

 

 
 

ii. Dibujar punto inicial y punto final del contraventeo. 
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4. Finalizar el comando. 

 

 
 
Modificación de Contraventeos 
 
Con el comando Brace usamos trabes estructurales para su creación, por lo tanto, 
tenemos las mismas opciones para modificar sus propiedades, como las siguientes: 
 

• Justificación de Geometría: Los contraventeos tienen parámetros de justificación 
de posición, lo cual los hará cambiar con respecto a la línea de ubicación del 
contraventeo. 

• Uso estructural: Al crear un contraventeo este cuenta con un uso estructural 
definido como Other, este se puede visualizar en la paleta de propiedades al 
seleccionar el contraventeo. Este valor se puede cambiar por dos opciones que 
vienen definidos en la herramienta: 
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Recomendaciones de Trabes 
 

• La estructura, como con todos los demás elementos estructurales, debe modelarse 
como se esperaría que se construyeran en el 'mundo real', es decir, no esperaría 
que se fabricara una viga de acero de 20 metros de largo, por lo tanto, no debe 
modelarse de esta manera en el proyecto de Revit. 

 

• Revisar las advertencias de Revit con frecuencia cuando se ajuste manualmente 
los miembros de la estructura. Los ajustes manuales pueden provocar 
involuntariamente que los miembros estructurales estén ligeramente fuera del eje. 
Esta advertencia puede afectar el rendimiento del modelo. 
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Capítulo 7 
 

Muros Estructurales 
 
Los muros estructurales contienen información analítica que Revit y otros programas de 
análisis estructural pueden utilizar para completar el proceso de diseño. Los muros 
estructurales también contienen un elemento analítico que no existe en los muros 
arquitectónicos. 
 
Edición y Colocación de Muros Estructurales 
 
Edición de un Muro Estructural 
 
Tipo de Familia: Familia de Sistema 
 

1. Buscar en el Navegador de Proyectos, en el apartado de familias, la categoría 

Walls y desplegar las familias y tipos con click en el ícono . 
2. Dar Click derecho en el tipo y seleccionar la opción Type Properties... 
3. En el cuadro de diálogo Propiedades de Tipo Duplicar el tipo y nombrar. 
4. Una vez Duplicado el tipo, modificar las propiedades: 

 

• Structure: Especifica la composición de una losa, muro o techo; para 
agregar, editar o eliminar alguna de las capas que la componen, hacer click 
en Edit para abrir el cuadro de diálogo Edit Assembly. Dentro se 
encuentran las siguientes herramientas: 

 

• Insert: Inserta una capa, para editar la capa se debe seleccionar. 

• Delete: Elimina una capa. 

• Up / Down: Cambia el orden de las capas. 

• Function: Determina la función y prioridad de las capas al unirse 
con otro elemento. 

 
Capas: 

• Structure [1]: Capa que soporta el resto de la pared, el piso 
o el techo. 

• Substrate [2]: Material, como madera contrachapada o 
panel de yeso, que actúa como base para otro material. 

• Thermal / Air Layer [3]: Proporciona aislamiento y evita la 
penetración de aire. 

• Membrane Layer: Una membrana que comúnmente evita la 
penetración de vapor de agua. La capa de membrana debe 
tener espesor cero. 

• Finish 1 [4]: El acabado 1 es típicamente la capa exterior. 

• Finish 2 [5]: El acabado 2 es típicamente para la capa 
interior. 

 
La siguiente ilustración muestra capas de mayor prioridad 
uniéndose antes que las capas de menor prioridad. La capa de 
CMU de Prioridad 1 del muro horizontal pasa a través de todas las 
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capas, hasta que alcanza la capa Stud de Prioridad 1 de la pared 
vertical.

 
 
Consideraciones al aplicar las capas en los elementos: 
 

• Cuando las capas se unen, la unión se limpia si las 2 capas tienen el mismo 
material. Si las 2 capas tienen materiales diferentes, aparece una línea en la 
unión. 

• Cada capa debe tener una función asignada para que Revit coincida las capas con 
precisión. 
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La siguiente ilustración muestra cómo una capa de menor prioridad dentro del núcleo 
(Core) pasa a través de capas de mayor prioridad fuera del núcleo (Core). La capa de 
aislamiento (Insulation) de la pared horizontal se ha movido dentro del núcleo. La capa 
de aislamiento ahora puede pasar a través de cualquier capa fuera del núcleo, 
independientemente de su prioridad. 

 

 
 

• Material: Para asignar un material a la capa creada. 

• Thickness: Para determinar el grosor de la capa creada. 

• Wraps (Disponible solo para muros): Permite especificar las 
preferencias de ajuste de capas en los extremos, como al término 
del muro (At Ends) y vanos creados por elementos que lo corten (At 
Inserts). 

• Structural Material (Disponible para muros y techos): Aplicar 
para capas dentro del núcleo del elemento, que necesiten adoptar 
las características establecidas en la configuración del material en 
el apartado de Physical en el modelo analítico estructural. 

 

 
 

• Coarse Scale Fill Pattern: Especifica un patrón de relleno para un 
elemento en corte por la vista, con un Nivel de Detalle Coarse. 

• Coarse Scale Fill Color: Especifica el color de un patrón de relleno para 
un elemento en corte por la vista, con un Nivel de Detalle Coarse. 
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Colocación de un Muro Estructural 
 
Los muros estructurales se crean utilizando el comando Wall: Structural de la Pestaña 
Structure en el Ribbon. Este comando también está disponible en la pestaña Architecture. 
 
Al seleccionar un muro, es fácil determinar si el muro es un elemento arquitectónico o 
estructural observando los parámetros disponibles en la Paleta de Propiedades. 
El muro arquitectónico tiene la casilla de verificación “Structural” desmarcada en el grupo 
de parámetros Structural e incluye menos propiedades: 
 

 
 
Nota: La categoría de ambos muros es la misma y se llama “Walls". 
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Para colocar Muros estructurales: 
 

1. Dirigirse a Pestaña Structure →  Panel Structure → Wall  
2. En la Paleta de Propiedades seleccionar el tipo de muro desde el Selector de 

Tipos. 
3. Dirigirse a Pestaña Modify | Place Structural Wall → Panel Draw → Elegir entre 

cualquiera de las líneas de boceto para definir el perímetro de muros o muro. 
4. Definir en la Barra de Opciones: 

 

 

• Depth / Height: Seleccionar Depth para dibujar el muro hacia abajo a partir 
de su base. Seleccionar Height para dibujar el muro hacia arriba desde su 
base. 

• Level / Unconnected: Seleccionar un nivel para la parte superior del muro, 
o seleccionar No conectado (Unconnected) y especificar la altura al muro. 

• Location line: Seleccionar qué plano vertical del muro se desea alinear 
con el cursor mientras se dibuja el sketch. 

• Chain: Seleccionar esta opción para dibujar una serie de segmentos de 
muro conectados en sus puntos finales. 

• Offset: Opcionalmente, ingresar una distancia para especificar qué tan 
lejos se desplazará la línea de ubicación del muro desde la posición del 
cursor o desde una línea o cara seleccionada. 

• Join Status: Activar herramienta para crear automáticamente una unión 
donde los muros se cruzan. Desactivar para evitar que los muros se unan 
cuando se encuentran. 

5. Hacer el primer click en el área de dibujo donde iniciará el muro y el segundo click 
para indicar el término de este. 
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Modificación de un Perfil de Muro Estructural 
 
Si el diseño requiere una forma diferente de perfil o aberturas en el muro, se puede editar 
el perfil de elevación del muro en una vista en sección, alzado o una vista en 3D. 
 
Para editar el Perfil del Muro: 
 

1. Seleccionar el Muro en el área de dibujo e ir a la Pestaña Modify | Walls → Panel 
Mode → Edit Profile. 

 
Nota: Si la vista activa es una vista en planta, aparece el cuadro de diálogo “Go To 
View”, que solicita seleccionar una vista de elevación o sección adecuada. 
Cuando se abre una vista adecuada, el perfil del muro se muestra en líneas de modelo 
magenta. 

 

 
 

2. Dirigirse a Pestaña Modify | Walls > Edit Profile → Panel Draw → Elegir entre 
cualquiera de las líneas de boceto para definir el perímetro de la(s) abertura(s) en 
el muro. 

3. Hacer click en Finish  para confirmar su colocación. 
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Edición de un Muro Apilado 
 
Tipo de Familia: Familia de Sistema 
 

1. Buscar en el Navegador de Proyectos, en el apartado de familias, la categoría 

Walls y desplegar las familias y tipos con click en el ícono . 
2. Dar Click derecho en el tipo dentro de una familia Stacked Wall y seleccionar la 

opción Type Properties... 
3. En el cuadro de diálogo Propiedades de Tipo Duplicar el tipo y nombrar. 
4. Una vez Duplicado el tipo, modificar las propiedades: 

 

• Structure: Especifica la composición de una losa, muro o techo; para 
agregar, editar o eliminar alguna de las capas que la componen, hacer click 
en Edit para abrir el cuadro de diálogo Edit Assembly. Dentro se 
encuentran las siguientes herramientas: 

 

• Insert: Inserta una capa, para editar la capa se debe seleccionar. 

• Delete: Elimina una capa. 

• Up / Down: Cambia el orden de las capas. 
 

• Name: Determina el tipo de muro. 

• Height: Especifica una altura para el tipo de muro. 

• Offset: Especifica una distancia a desplazar la línea de ubicación, un valor 
positivo mueve el tipo de muro hacia el lado exterior 
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Consideraciones y recomendaciones de Muros Estructurales. 
 
Consideraciones: 
 

• Establecer una convención de nomenclatura estructurada para una fácil 
identificación. 

• Revisar cómo modelar aberturas de muro para obtener resultados correctos en las 
tablas. 

• Establecer la línea de ubicación correcta para el muro, esto asegurará que el muro 
se comportará según lo previsto si se realizan cambios. 

• Conocer la diferencia entre unir / no unir muros a las losas. 

• Es importante trabajar en estrecha colaboración con el modelo arquitectónico para 
garantizar que los muros estructurales coincidan con los muros arquitectónicos. 

• Los muros estructurales se pueden crear a partir de líneas de trabajo o de masas. 
 
Recomendaciones: 
 

• Definir nombres claros para los diferentes tipos de muro para ayudar a los 
miembros del proyecto a comprender qué tipo de muro se está utilizando. 

• Los muros, como con todos los demás elementos estructurales, deben modelarse 
como se esperaría que se construyeran en el 'mundo real', es decir, no se 
construiría un muro desde la parte superior de los cimientos hasta la parte inferior 
del techo, por lo tanto, no debería ser modelado de esta manera en su proyecto 
Revit. 
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Capítulo 8 
 

Pisos y Losas de Concreto 
 
Al igual que con los muros, las columnas, etc. Los pisos arquitectónicos no tendrán datos 
estructurales, no podrán usarse para calcular cargas, no interactuarán con otros 
componentes estructurales y no tendrán líneas de modelos analíticos. 
 
Al seleccionar la losa, es fácil determinar si es un elemento arquitectónico o estructural 
observando los parámetros disponibles en la Paleta de Propiedades. 
La losa arquitectónica tiene la casilla de verificación “Structural” desmarcada en el grupo 
de parámetros Structural e incluye menos propiedades: 
 
Edición y Colocación de Losas de Concreto 
 
Edición de una Losa de Concreto 
 
Tipo de Familia: Familia de Sistema 
 

1. Buscar en el Navegador de Proyectos, en el apartado de familias, la categoría 

Floors y desplegar las familias y tipos con click en el ícono . 
2. Dar Click derecho en el tipo y seleccionar la opción Type Properties... 
3. En el cuadro de diálogo Propiedades de Tipo Duplicar el tipo y nombrar. 
4. Una vez Duplicado el tipo, modificar las propiedades: 

• Structure: Especifica la composición de una losa, muro o techo; para 
agregar, editar o eliminar alguna de las capas que la componen, hacer click 
en Edit para abrir el cuadro de diálogo Edit Assembly. 

• Coarse Scale Fill Pattern: Especifica un patrón de relleno para un 
elemento en corte por la vista, con un Nivel de Detalle Coarse. 

• Coarse Scale Fill Color: Especifica el color de un patrón de relleno para 
un elemento en corte por la vista, con un Nivel de Detalle Coarse. 

 
Colocación de una Losa de Concreto 
 
Las losas se crean mediante bocetos. Se puede crear un boceto de líneas para los bordes 
de la losa seleccionando los muros o utilizando las herramientas de líneas. 
 
Para colocar una Losa de Concreto: 
 

1. Dirigirse a Pestaña Structure →  Panel Structure → Floor  
2. Especificar un tipo de losa del Selector de Tipo. 
3. Dirigirse a Pestaña Modify | Create Floor Boundary → Panel Draw → Boundary 

Line . 
 

a. Elegir entre cualquiera de las líneas de boceto para definir el contorno de la 
losa de concreto. 

b. Elegir Pick Walls  para seleccionar los muros de su modelo. 
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• En la barra de opciones, activar la casilla Extend into wall (to core) 

 si desea que el borde de la losa se 
coloque al núcleo del muro. 

 

• En la barra de opciones, especificar un desface respecto a la cara 
del muro donde se desea colocar el borde de losa. 

 
 

4. Especificar la dirección de la losacero con la herramienta Span Direction. 
5. Definir pendiente bajo cualquiera de los siguientes métodos: 

 
a. Slope Arrow: Cuando dibuja una flecha de pendiente, puede ingresar 

valores para especificar la altura en su cabeza y cola, o un valor de 
pendiente, al modificar sus parámetros en la Paleta de Propiedades 

b. Parallel Sketch Lines: En el modo de boceto, seleccionar líneas de borde 
paralelas y activar la casilla Defines Constant Height en la Paleta de 
Propiedades. Después definir los siguientes parámetros en la Paleta de 
Propiedades: 

c. Defines Slope: En el modo de boceto, seleccionar una sola línea de boceto 

y activar la casilla Defines Slope en la Barra de Opciones . 
Una vez activada la casilla definir los siguientes parámetros en la Paleta de 
Propiedades: 

 

7. Hacer click en Finish  para confirmar su colocación. 
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Edición de Forma de una Losa de Concreto 
 
Se puede usar las herramientas de edición de formas para manipular la superficie de una 
losa o techo no inclinado definiendo puntos altos y bajos para el drenaje. 
 
Al especificar la elevación de estos puntos, se divide la superficie en subregiones que 
pueden inclinarse independientemente. Para habilitar las herramientas de edición de 
formas, se deben cumplir las siguientes condiciones: 
 

• Las losas deben ser planas y en un plano horizontal. 

• Un techo no puede adherirse a otro techo, y el techo no puede ser un techo de 
cortina. Si alguna de estas condiciones no se cumple, no puede usar los botones 
de edición de forma de losa. 
 
Nota: Si estas condiciones se violan posteriormente, mediante la edición de 
elementos, la edición de la forma de losa provocará un error con una devolución 
de llamada, lo que permitirá al usuario restablecer la edición de la forma de losa. 

 
Las herramientas se encuentran en la Pestaña Modify → Panel Shape Editing 
 

 
 
Para editar la forma de una Losa de Concreto: 
 

1. Seleccionar la losa a modificar. 
2. Hacer click en la Pestaña Modify → Panel Shape Editing → Modify Sub 

Elements  
3. Arrastrar un punto o borde, o hacer click en el control de texto para ingresar un 

valor de altura y así modificar la ubicación o elevación. 
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Para agregar un punto a una Losa de Concreto: 
 

1. Seleccionar la losa a modificar. 

2. Hacer click en la Pestaña Modify → Panel Shape Editing → Add Point  
3. Hacer click en la cara o los bordes de la losa para agregar puntos que definan una 

pendiente. 
 

 
 
Para dividir una Losa de Concreto: 
 
Se puede usar la herramienta Agregar línea dividida (Add Split Line) para agregar bordes 
lineales y dividir la cara existente de un Techo o Losa Estructural en subregiones más 
pequeñas. 
 

1. Seleccionar la losa a modificar. 

2. Hacer click en la Pestaña Modify → Panel Shape Editing → Add Split Line  
3. Seleccionar un vértice, borde, cara o punto en cualquier parte de la losa estructural 

para comenzar la línea de división. 
Nota: Los puntos de inicio y los puntos finales se pueden agregar en cualquier 
parte de la superficie de la losa. 

4. Seleccionar otro vértice, borde, cara o punto en cualquier parte de la losa para 
finalizar la línea dividida. 

 

 
 
Para definir líneas de división por trabes de soporte en una Losa de Concreto: 
 
Se puede usar la herramienta Seleccionar soportes (Pick Supports) para seleccionar 
trabes y con ellas definir líneas división 
 

1. Seleccionar la losa a modificar. 

2. Hacer click en la Pestaña Modify → Panel Shape Editing → Pick Supports  
3. Seleccionar una trabe existente. 
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Consideraciones y recomendaciones de Losas Estructurales 
 
Consideraciones: 
 

• Configurar una convención de nomenclatura estructurada para una fácil 
identificación. 

• Los arquitectos e ingenieros estructurales deben coordinar y acordar 
continuamente quién creará / mantendrá las losas en un proyecto. 

• Es posible que el Arquitecto sea dueño de la porción de acabado de una losa 
dentro del modelo Arquitectónico y que el Ingeniero Estructural sea dueño de la 
porción estructural de la losa dentro del modelo Estructural. 

• Las propiedades estructurales se pueden exportar a la mayoría de los programas 
de análisis estructural. 

 
Recomendaciones: 
 

• Para losas compuestas: no agregar capas no estructurales entre los límites del 
núcleo. Los muros reaccionan a los límites centrales. El uso incorrecto puede 
provocar conexiones defectuosas entre estos elementos. 
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Capítulo 9 
 

Losas de Techo  
 
El techo se puede definir como una o más capas de material y reglas que definen los 
comportamientos. Los techos se alojan en niveles y, por lo general, se modelan para que 
la cara inferior del techo esté en el nivel. Ningún elemento estructural forma parte del 
techo y puede modelarse por separado. 
 
 

 
Edición y Colocación de Losas de Techo 
 
Edición de una Losa de Techo 
 
Tipo de Familia: Familia de Sistema 
 

1. Buscar en el Navegador de Proyectos, en el apartado de familias, la categoría 

Roofs y desplegar las familias y tipos con click en el ícono . 
2. Dar Click derecho en el tipo y seleccionar la opción Type Properties... 
3. En el cuadro de diálogo Propiedades de Tipo Duplicar el tipo y nombrar. 
4. Una vez Duplicado el tipo, modificar las propiedades: 

• Structure: Especifica la composición de una losa, muro o techo; para 
agregar, editar o eliminar alguna de las capas que la componen, hacer click 
en Edit para abrir el cuadro de diálogo Edit Assembly. 

• Coarse Scale Fill Pattern: Especifica un patrón de relleno para un 
elemento en corte por la vista, con un Nivel de Detalle Coarse. 

• Coarse Scale Fill Color: Especifica el color de un patrón de relleno para 
un elemento en corte por la vista, con un Nivel de Detalle Coarse. 

 
Colocación de una Losa de Techo 
 
Las losas de techo se crean mediante bocetos. Se puede crear un boceto de líneas para 
los bordes de la losa seleccionando los muros o utilizando las herramientas de líneas. 
 
Para colocar una Losa de Techo por boceto: 
 

1. Dirigirse a Pestaña Architecture →  Panel Build → Roof By Footprint  
2. Especificar un tipo de losa del Selector de Tipo. 
3. Dirigirse a Pestaña Modify | Create Roof Footprint → Panel Draw → Boundary Line 

. 
 

a. Elegir entre cualquiera de las líneas de boceto para definir el contorno del 
techo. 

b. Elegir Pick Walls  para seleccionar los muros de su modelo. 
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• En la barra de opciones, activar la casilla Extend into wall (to core) 

 si desea que el borde del techo se coloque 
al núcleo del muro. 

 

• En la barra de opciones, especificar un voladizo respecto a la cara 
del muro donde se desea colocar el borde del techo. 

 

 
 

 
4. Definir pendiente bajo cualquiera de los siguientes métodos: 

 
a. Slope Arrow: Cuando dibuja una flecha de pendiente, puede ingresar 

valores para especificar la altura en su cabeza y cola, o un valor de 
pendiente, al modificar sus parámetros en la Paleta de Propiedades 

b. Defines Slope: En el modo de boceto, seleccionar una sola línea de boceto 

y activar la casilla Defines Slope en la Barra de Opciones . 
Una vez activada la casilla definir los siguientes parámetros en la Paleta de 
Propiedades: 

 

5. Hacer click en Finish  para confirmar su colocación. 
 
Nota: Es posible modificar los subelementos de las losas de techo como la categoría de 
losas. 
 

 
 
Para colocar una Losa de Techo por extrusión: 
 
Para colocar una Losa de Techo por extrusión es necesario tener activa una vista en 
elevación 3d o sección. Si la vista activa es una vista en planta, aparece el cuadro de 
diálogo “Go To View”, que solicita seleccionar una vista de elevación, 3D o sección 
adecuada. 
 

1. Dirigirse a Pestaña Architecture →  Panel Build → Roof By Extrusion  
2. Especificar plano de trabajo. 
3. En el cuadro de diálogo Roof Reference Level and Offset, seleccione un valor de 

Nivel de referencia. 
4. Especificar un valor de Offset para subir o bajar el techo desde el nivel de 

referencia. 
5. Dibujar el perfil del techo. 
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6. Hacer click en Finish  para confirmar su colocación. 
 

 
 
Consideraciones y recomendaciones de Losas de Techo 
 
Consideraciones: 
 

• Establecer una nomenclatura estructurada para identificar fácilmente el tipo de 
techo. 

• Modelar los techos según las técnicas de construcción de la vida real. 
 
Recomendaciones: 
 

• Definir nombres claros para diferentes tipos de techos para ayudar a los miembros 
del proyecto a comprender qué tipo de techo se está utilizando. 

• Revisar y coordinar las capas de otros elementos de Revit (Muros, Losas, 
Columnas, etc.) para que cualquier unión entre elementos funcione como se 
espera. 
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Capítulo 10 
 

Escaleras 
 
La escalera consta de diferentes partes que representan la escalera. Las partes se 
colocan de acuerdo con la configuración de la familia. Los componentes de la escalera se 
pueden convertir en cualquier punto en una representación basada en bocetos. 
 
Una escalera puede ser conformada de los siguientes elementos: 
 

• Tramos: Rectos, Espirales, en L, en U o Boceto de tramo personalizado. 
 

 
 

• Descansos: Creados automáticamente entre tramos, mediante el modelado de 
dos tramos separados o mediante la creación de un boceto de descanso 
personalizado. 
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• Soportes (laterales y centrales): Creados automáticamente con los tramos o 
mediante la selección de un borde de tramo o descanso. 

 

 
 

• Barandales: Generados automáticamente durante la creación de la escalera o 
rampa, o colocados posteriormente. 

 

 
 
Tipos de Escaleras: 
 
Existen tres familias predefinidas de escaleras: Escalera moldeada en sitio (Cast-In-
Place), Escalera prefabricada (Precast) y Escalera ensamblada (Assembled). Las 
diferencias entre las tres familias se indican a continuación: 
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Edición y Colocación de Escaleras 
 
Tipo de Familia: Familia de Sistema 
 
Al crear una escalera, se puede modificar los componentes individuales de la escalera, 
incluidos los tramos, los descansos y los soportes. También puede realizar modificaciones 
en toda la escalera, como cambiar el tipo de escalera o cambiar la ubicación. 
 
Las modificaciones a un componente pueden afectar directamente a otros componentes 
en la escalera para mantener la intención del diseño y la integridad del conjunto de la 
escalera. 
 
Edición de una Escalera 
 

1. Buscar en el Navegador de Proyectos, en el apartado de familias, la categoría 

Stairs y desplegar las familias y tipos con click en el ícono . 
2. Dar Click derecho en el tipo de la escalera (Assembled Stair, Cast-In-Place Stair y 

Precast Stair) que se desea editar y seleccionar la opción Type Properties... 
3. En el cuadro de diálogo Propiedades de Tipo Duplicar el tipo y nombrar. 
4. Una vez Duplicado el tipo, modificar las propiedades: 

 
➢ Grupo de Parámetros Calculation Rules 

 

• Maximum Riser Height: Especifica la altura que no excederán los 
escalones cuando se cree el tramo de escalera. Establecer la altura 
máxima del escalón ayuda a cumplir con los requisitos del proyecto y la 
normatividad de construcción. 

 

 
 

• Minimum Tread Depth: Especifica la profundidad de huella más pequeña 
a usar cuando se cree el tramo de escalera. Establecer la profundidad 
mínima de la huella ayuda a cumplir con los requisitos del proyecto y la 
normatividad de construcción 
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➢ Grupo de Parámetros Construction 

 

• Run Type: Determina el tipo de tramo para de la escalera. 
 

Para modificar las propiedades del tramo: 
 

I. Hacer click en el botón de examinar  que se muestra del lado 
derecho del campo para modificar sus propiedades. 

II. En el cuadro de diálogo Propiedades de Tipo definir cual familia de 
tramo se usará (Monolítico / No- Monolítico) y, duplicar el tipo y 
nombrar. 

 

 
III. Editar dentro del Grupo de Parámetros Construction (Solo disponible 

en tramo Monolítico): 
 

• Underside Surface:  Especifica el estilo de la superficie 
inferior del tramo. 

 

 
 

• Structural Depth: Especifica la profundidad de la superficie 
inferior. 
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IV. Editar los siguientes parámetros: 
 

 
 
 

• Monolithic Material (Solo disponible en tramos 
monolíticos): Define el material de la superficie inferior del 
tramo. 

• Tread Material (Disponible si la casilla de Tread está 
activa): Define el material de la capa sobre la huella. 

• Riser Material (Disponible si la casilla de Riser está 
activa): Define el material de la capa sobre la cara vertical 
del escalón. 

• Tread: Activar casilla para incluir una capa de material sobre 
las huellas. 

• Tread Thickness: Especifica el grosor de la capa de 
material sobre las huellas. 

• Tread Profile: Especifica la forma de la capa de material 
sobre las huellas. El valor predeterminado es rectangular, 
aunque se podría usar un perfil para crear una superficie en 
ángulo. 

• Nosing Length: Especifica la longitud de la huella que 
sobresale de la siguiente huella. 

• Nosing Profile: Especifica el perfil para un barrido agregado 
al frente o los lados de las huellas. 

• Apply Nosing Profile: Especifica en cuales bordes de la 
huella se aplica el perfil de nariz. 

• Riser: Activar casilla para incluir una capa de material sobre 
la cara vertical de los escalones. 

• Slanted: Activar casilla para aplicar una inclinación. 
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• Riser Thickness: Especifica el grosor de la capa de material 
sobre la cara vertical de los escalones. 

• Riser Profile: Especifica la forma de la capa de material 
sobre la cara vertical de los escalones El valor 
predeterminado es rectangular. 

• Riser to Tread Connection: Especifica la conexión entre 
ambas capas de material agregadas, en las huellas y la cara 
vertical de los escalones. 

 

 
 

V. Hacer click en Aplicar y Ok para confirmar los cambios en las 
propiedades de los tramos y regresar la configuración general. 

 

• Landing Type: Determina el tipo de descanso para de la escalera. 
 

Para modificar las propiedades del descanso: 
 

I. Hacer click en el botón de examinar  que se muestra del lado 
derecho del campo para modificar sus propiedades. 

II. En el cuadro de diálogo Propiedades de Tipo definir qué familia de 
descanso se usará (Monolítico / No- Monolítico) y, duplicar el tipo y 
nombrar. 
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III. Editar dentro del Grupo de Parámetros Construction (Solo disponible 
en descanso Monolítico): 

 

• Monolithic Thickness:  Especifica el grosor del 
descanso. 

 
IV. Editar los siguientes parámetros: 

 

• Monolithic Material (Solo disponible en tramos 
monolíticos): Define el material del descanso. 

• Tread Material (Disponible si la casilla Same as Run está 
desactivada y la casilla Tread activa): Define el material 
de la capa sobre el descanso de forma independiente a la 
configuración hecha en el tramo. 

• Same as Run: Activar esta casilla para usar las mismas 
propiedades de la capa superior de las huellas especificadas 
en la configuración de los tramos en la capa superior del 
descanso, o desactivar si se desea especificar las 
propiedades de forma independiente. 

• Tread: Activar casilla para incluir una capa de material sobre 
los descansos. 

• Tread Thickness: Especifica el grosor de la capa de 
material sobre los descansos. 

• Nosing Length: Especifica la longitud del descanso que 
sobresale de la siguiente huella. 

• Nosing Profile: Especifica el perfil para un barrido agregado 
al frente o los lados de los descansos. 

• Apply Nosing Profile: Especifica en cuales bordes del 
descanso se aplica el perfil de nariz. 

 
V. Hacer click en Aplicar y Ok para confirmar los cambios en las 

propiedades de los descansos y regresar la configuración general. 
 



134 
 

 
➢ Grupo de Parámetros End Connection (Solo disponible en escaleras 

prefabricadas) 
 

• Connection Method: Define el estilo de unión entre un tramo y un 
descanso. 

 

 
 

Nota: Los tramos deben comenzar y finalizar con una huella para usar el 
método de conexión de muesca (Notch). 

 

• Notch Extension: Especifica la longitud horizontal de la pestaña de unión. 
 

 
 

• Notch Thickness: Especifica la longitud vertical de la pestaña de unión 
desde la parte superior. 

 

 
 

• Horizontal Gap Distance: Especifica la altura del espacio horizontal entre 
el tramo y el descanso. 
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• Vertical Gap Distance: Especifica el ancho del espacio vertical entre el 
tramo y el descanso. 

 

 
 

➢ Grupo de Parámetros Supports 
 

Se pueden especificar dos tipos de soporte a cada lado de la escalera: 
 

 
 

Stringer (Closed): Encierra las huellas con un larguero. 
Carriage (Open): Expone las huellas con un larguero debajo de ellas. 

 
 

• Rigth Support: Especifica si se crea un soporte derecho. 

• Right Support Type: Define el tipo de soporte derecho utilizado en la 
escalera. 

 
Para modificar las propiedades del soporte: 

 

I. Hacer click en el botón de examinar  que se muestra del 
lado derecho del campo para modificar sus propiedades. 

II. En el cuadro de diálogo Propiedades de Tipo duplicar el tipo 
y nombrar. 
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III. Editar los siguientes parámetros: 

 

 
 

• Material: Define el material del soporte. 

• Section Profile (Solo disponible en soportes del tipo 
Stringer): Especifica el perfil para el soporte. El valor 
predeterminado es Rectángulo. 

• Flip Section Profile (Solo disponible en soportes del tipo 
Stringer): Seleccionar esta opción para voltear la forma del 
perfil para el soporte. Esta opción es útil si está utilizando 
una forma de perfil de sección como un canal C y se 
necesita cambiar la dirección del perfil. 

• Structural Depth on Run: Especifica la profundidad del 
soporte en los tramos. (Ver diagrama superior) 

• Structural Depth on Landing:  Especifica la distancia 
entre la superficie inferior del descanso y la superficie 
inferior del soporte. 

• Total Depth: Especifica la profundidad total del soporte. (ver 
diagrama superior) 

• Width: Especifica el ancho o grosor del soporte. 
 

IV. Hacer click en Aplicar y Ok para confirmar los cambios en las 
propiedades de los soportes y regresar la configuración 
general. 

 
 

• Rigth Lateral Offset (Disponible para soportes Carriage): Especifica un 
valor para desplazar el soporte derecho desde el borde del tramo en 
dirección horizontal. 
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• Left Support: Especifica si se crea un soporte izquierdo. 

• Left Support Type: Define el tipo de soporte izquierdo utilizado en la 

escalera. Hacer click en el botón de examinar  que se muestra del lado 
derecho del campo para modificar sus propiedades. 

• Left Lateral Offset (Disponible para soportes Carriage): Especifica un 
valor para desplazar el soporte izquierdo desde el borde del tramo en 
dirección horizontal. 

• Middle Support: Activar si se requieren soportes intermedios en la 
escalera. 

• Middle Support Type: Define el tipo de soporte intermedio utilizado en la 

escalera. Hacer click en el botón de examinar  que se muestra del lado 
derecho del campo para modificar sus propiedades. 

• Middle Support Number: Define el número de soportes intermedios 
utilizados en la escalera. 

 
5. Una vez configuradas las propiedades de la escalera en los distintos grupos de 

parámetros mencionados hacer click en Aplicar y Ok para confirmar los cambios. 
 
Colocación de una Escalera 
 
Se pueden crear escaleras a partir de componentes individuales como tramos, descansos 
y soportes, o por boceto. 
 
Escaleras por componentes 
 
Para colocar una Escalera por componentes: 
 

1. Dirigirse a la Pestaña Architecture →  Panel Circulation → Stair  
2. Especificar un tipo de escalera del Selector de Tipo. 
3. Especificar en la Paleta de Propiedades: 

 

• Base Level:  Especifica el nivel para la base de las escaleras. 

• Base Offset: Establece un desplazamiento de las escaleras desde el nivel 
base. 

• Top Level: Establece el nivel para la parte superior de las escaleras. 

• Top Offset: Establece el desplazamiento de las escaleras desde el nivel 
superior. 

• Desired Stair Height: Especifica la altura de la escalera. (Solo disponible 
para modificar si el valor del nivel superior no está conectado, es decir el 
valor de Top Level sea “None”. 

• Desired Number of Risers: El número de escalones se calcula en función 
de la altura entre niveles, puede modificarse y en caso de sobrepasar los 
límites especificados en la configuración mandará una alerta. 

• Actual Number of Risers: Muestra el número de escalones creados. (Solo 
lectura) 

• Actual Riser Height: Muestra la altura de los escalones. (Solo lectura) 

• Actual Tread Depth: Se puede establecer otro valor para cambiar la 
profundidad de la huella sin tener que crear un nuevo tipo de escalera 
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• Tread/Riser Start Number: Especifica el número inicial para la anotación 
de numeración de escalones. 

 
4. Dirigirse a la Pestaña Modify | Create Stair → Panel Components → Seleccionar 

componente a colocar: tramos, descansos o soportes. 
 

 
 

5. Elegir entre cualquiera de los tipos de tramos de escalera. 
 

•  Recto 

•  Espiral únicamente con escalones 

•  Espiral 

•  Forma en “L” 

•  Forma en “U” 
 

6. Definir en la Barra de Opciones: 
 

 
 

• Location Line: Indica la línea de referencia a partir de la cual se creará el 
tramo: 
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• Offset: Opcionalmente, ingresar una distancia para especificar qué tan 
lejos se desplazará la línea de ubicación de la escalera desde la posición 
del cursor. 

• Actual Run Width: Especifica un valor para el ancho del tramo sin incluir 
soportes. 

• Automatic Landing: La casilla está activa de forma predeterminada. Si se 
crean 2 tramos separados para alcanzar el siguiente nivel, Revit crea 
automáticamente un descanso entre los 2 tramos. Desactivar esta opción si 
no se desea crear descansos automáticamente. 

 
7. Opcionalmente definir las propiedades de instancia del tramo desplegando en la 

Paleta de Propiedades el filtro de propiedades y seleccionando la opción “New 
Stair: Runs” como se muestra a continuación: 

 

 
 

Definir las siguientes propiedades: 
 

• Extend Below Base: Especifica una distancia para extender el tramo por 
debajo del nivel base de la escalera. Esto es útil en los casos en que el 
tramo se adhiere a la cara de una abertura del piso en lugar de descansar 
sobre la superficie del piso. Para extender el tramo debajo del piso se 
ingresa un número negativo. 

 

 
 

• Begin with Riser: Especifica si el tramo inicia con un escalón. 

• End with Riser: Especifica si el tramo termina con un escalón. 
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8. Opcionalmente definir el tipo de Barandal que se colocará de forma automática y 

su posición en la Pestaña Modify | Create Stair → Panel Tools → Railing  
9. En el área de dibujo hacer el primer click para definir el inicio del tramo. 
10. Desplazar el cursor en la dirección deseada del tramo. 

 

 
 

11. Hacer el segundo click para definir el término del tramo. 
 

 
 

12. Hacer click en Finish  para confirmar su colocación. 
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Escalera por Boceto. 
 
Cuando se crean componentes mediante bocetos, no se establece de forma automática la 
relación entre los elementos, tal y como sucede cuando estos se crean con las 
herramientas de componentes comunes. 
 
Este método proporciona una alternativa a la creación de tramos o descansos utilizando 
las herramientas estándar. 
 

 
 
Nota: Puede dibujar tramos y descansos en una vista en planta o en una vista 3D. 
 
Para colocar una Escalera por Boceto. 
 

1. Dirigirse a la Pestaña Architecture →  Panel Circulation → Stair  
2. Especificar un tipo de escalera del Selector de Tipo. 
3. Dirigirse a la Pestaña Modify | Create Stair → Panel Components → Seleccionar 

componente de tramo → Elegir la herramienta Create Sketch. 
 

 
 

4. Dirigirse a la Pestaña Modify | Create Stair > Sketch Run → Panel Draw → 
Seleccionar tipo de línea de “Boundary” → Elegir cualquier tipo de línea de boceto 
para dibujar el borde izquierdo y derecho. 
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5. Dirigirse a la Pestaña Modify | Create Stair > Sketch Run → Panel Draw → 

Seleccionar tipo de línea de “Riser” → Elegir cualquier tipo de línea de boceto para 
dibujar los escalones. 

 

 
 

6. Dirigirse a la Pestaña Modify | Create Stair > Sketch Run → Panel Draw → 
Seleccionar tipo de línea de “Stair Path” → Elegir cualquier tipo de línea de boceto 
para dibujar la ruta de la escalera. 

 

 
 

Nota: 
 

• Las líneas de borde (Boundary) son las líneas que corren a lo largo de los 
lados de los escalones y descansos. Las líneas de borde no se colocan en 
la parte superior e inferior de las escaleras. Las líneas de límite siempre se 
muestran en verde. 

• Las líneas de escalón (Riser) son las líneas que representan a los 
escalones, estas se deben extender entre las 2 líneas de borde y cerrar el 
boceto al inicio y fin de los bordes. Las líneas de escalón siempre se 
muestran en negro. 

• La línea de ruta (Stair Path) debe pasar a través de todas las líneas de 
escalón, conectando la primer y última línea. La línea de ruta siempre se 
muestra en azul. 
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7. Hacer click en Finish  para salir del modo boceto. 
 

 
 

8. Hacer click en Finish  para confirmar la colocación. 
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Herramientas de ajuste de Escaleras 
 
Modificación de componentes de escalera mediante controles de manipulación directa. 
 
Después de seleccionar la escalera para editar y seleccionar un componente de la 
escalera, los controles de modificación están disponibles para la manipulación directa del 
componente. 
 
Para modificar los componentes de las Escaleras: 
 

1. Seleccionar la escalera y dirigirse a la Pestaña Modify | Stairs→ Panel Edit → Edit 

Stairs  
2. Seleccionar el componente a modificar. (Presionar Tab para resaltar un 

componente) 
3. Usar los componentes de manipulación directa numerados a continuación. 

 

 
 

1) Control de flecha: Control en el extremo del tramo de la escalera que 
sirve para agregar o quitar escalones. La modificación del control de 
flecha mantiene la altura de la escalera. 

2) Control de punto: Control en el extremo abierto del tramo de la 
escalera que sirve para agregar o quitar escalones. No se pude agregar 
escalones debajo del nivel base de la escalera. 

3) Control de flecha al borde: Control ubicado en los bordes del tramo 
que sirve para cambiar el ancho de este. 

4) Control de flecha de descanso: Control ubicado en los bordes del 
descanso que sirve para cambiar el tamaño de este. 

 

4. Hacer click en Finish  para confirmar la edición. 
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Modificación de dirección de Escalera. 
 
En una vista en planta, alzado, sección o 3D, se puede voltear la dirección de una 
escalera. Esta función mantiene el diseño de la escalera, pero invierte la dirección 
original. 
 
Para modificar la dirección de las Escaleras: 
 

1. Seleccionar la escalera y dirigirse a la Pestaña Modify | Stairs → Panel Edit → Edit 

Stairs  
2. Hacer click en la Pestaña Modify | Create Stair → Panel Tools → Flip 

3. Hacer click en Finish  para confirmar la edición. 
 

 
 
Convertir un componente de Escalera en un boceto. 
 
Después de convertir el componente, se puede usar las herramientas de boceto para 
modificar el diseño según sea necesario. Después de convertir un componente común a 
un componente basado en sketch, no puede volver a convertirse. 
 
Para convertir un componente de Escalera en un boceto. 
 

1. Seleccionar la escalera y dirigirse a la Pestaña Modify | Stairs → Panel Edit → Edit 

Stairs  
2. Seleccionar el tramo o descanso y hacer click en la Pestaña Modify | Create Stair 

→ Panel Tools → Convert  
3. Seleccionar el tramo o descanso y hacer click en la Pestaña Modify | Create Stair 

→ Panel Tools → Edit Sketch  

4. Hacer click en Finish  para confirmar la edición del boceto. 

5. Hacer click en Finish  para confirmar la edición general. 
 
Nota: Cuando se convierte un componente en un boceto, ya no conserva la relación 
automática con otros componentes. Por ejemplo, si se convierte un descanso en un 
boceto, luego cambia el ancho del tramo, la forma del descanso no cambiará 
automáticamente. Los componentes por boceto deben actualizarse manualmente. 
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Consideraciones de Escaleras 
 

• Configurar una convención de nomenclatura estructurada para una fácil 
identificación. 

• Usar escaleras basadas en componentes como el método predeterminado para 
crear escaleras. El uso de escaleras basadas en boceto puede causar anomalías 
de modelado con las partes de los componentes. Se puede alternar una escalera 
basada en componentes para convertirse en una escalera basada en croquis. Solo 
tener en cuenta que una vez que una escalera de componentes se convierta en 
boceto, no se podrá volver atrás. 

• Tener cuidado de copiar una escalera, ya que las escaleras están basadas en 
reglas, y puede haber consecuencias imprevistas. Al copiar una escalera para ser 
idéntica, copiar no debería ser un problema. Sin embargo, si se copia una escalera 
con la intención de hacer modificaciones menores a las reglas, siempre hay que 
validar la integridad de la geometría. 

• Las escaleras se pueden modificar de muchas maneras, no solo en 3D sino 
también a través de líneas 2D que representan la escalera en los dibujos. 

• Recordar definir el barandal dentro del comando Stair. 

• Utilizar el parámetro de función de la escalera, un parámetro de tipo con las 
opciones predeterminadas 'interior' o 'exterior' y también puede ser definido por el 
usuario. Esto permitirá filtrar en tablas. 
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Capítulo 11 
 

Huecos 
 
Se pueden usar las herramientas en el panel de Opening para crear huecos en muros, 
losas, plafones, losas de techo, trabes, contraventeos y columnas estructurales, con las 
siguientes herramientas. 
 

 
 
Colocación de Huecos 
 
Tipo de Familia: Familia de Sistema 
 
Colocación de huecos con las opciones “Vertical Opening” y “Opening By Face” 
 
Se utilizan las herramientas de Vertical Opening y Opening By Face para cortar una 
hueco vertical o perpendicular en una losa techo, losa o plafón (por ejemplo, para 
acomodar una chimenea). Se utiliza la herramienta “By Face” cuando se requiere un 
hueco perpendicular a la cara del elemento seleccionado; y la herramienta “Vertical” para 
crear huecos perpendiculares a un nivel, como se muestra a continuación: 
 
 
 

 
 
Para colocar huecos con la opción “By Face”: 
 

1. Dirigirse a Pestaña Structure →  Panel Opening → By Face  
2. Seleccionar la cara de una losa, plafón, losa de techo, trabe o columna del modelo. 

Al colocar el puntero sobre cualquiera de los elementos antes mencionados se 
puede visualizar el plano de trabajo, como se muestra a continuación: 
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4. Dirigirse a Pestaña Modify | Create Opening Boundary → Panel Draw → Elegir 
entre cualquiera de las líneas de boceto para definir el perímetro del hueco en el 
elemento. 

 

 
 

5. Hacer click en Finish  para confirmar su colocación. 
 
 
Para colocar huecos con la opción “Vertical”: 
 

1. Dirigirse a Pestaña Structure → Panel Opening → Vertical  
2. Seleccionar una losa, plafón o losa de techo del modelo. 
3. Dirigirse a Pestaña Modify | Create Opening Boundary → Panel Draw → Elegir 

entre cualquiera de las líneas de boceto para definir el perímetro del hueco en el 
elemento. 

4. Hacer click en Finish  para confirmar su colocación. 
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Colocación de huecos con la opción “Shaft Opening” 
 
Se utiliza la herramienta “Shaft Opening” para colocar un hueco que se extiende por toda 
la altura de un edificio (o por niveles seleccionados), cortando las caras de plafones, losas 
o losas de techo simultáneamente. 
 
Para colocar huecos con la opción “Shaft”: 
 

1. Dirigirse a Pestaña Structure → Panel Opening → Shaft  
2. Dirigirse a Pestaña Modify | Create Shaft Opening Sketch → Panel Draw → 

Boundary Line . 
3. Elegir entre cualquiera de las líneas de boceto para definir el perímetro del hueco. 
4. Definir los siguientes parámetros en la Paleta de Propiedades: 

 

• Base Constraint: Define una restricción a un nivel en la base del hueco. 

• Base Offset: Define un desplazamiento del hueco desde el nivel base. Este 
parámetro se habilita solo cuando la restricción base (Base Constraint) se 
establece en un nivel. 

• Top Constraint: Define una restricción a un nivel en la parte superior del 
hueco. Si la restricción superior no está definida, la altura del hueco se 
extiende al valor especificado en el parámetro “Unconnected Height”. 

• Top Offset:  Define un desplazamiento del hueco desde la parte superior. 
Este parámetro se habilita solo cuando la restricción superior (Top 
Constraint) se establece en un nivel. 

• Unconnected Height: Define la altura del hueco que se usa si no se define 
una restricción superior, la medida va en dirección hacia arriba desde la 
base del hueco. 

 
5. Dirigirse a Pestaña Modify | Create Shaft Opening Sketch → Panel Draw → 

Symbolic Line . 
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6. Elegir entre cualquiera de las líneas de boceto para dibujar líneas de simbología 
como se muestra a continuación: 

 

 
 

7. Hacer click en Finish  para confirmar su colocación. 
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Colocación de huecos con la opción “Wall Opening” 
 
Se utiliza la herramienta Wall Opening para colocar un hueco en un muro del modelo de 
forma rápida y eficiente.  
 
Para colocar huecos con la opción “Wall”: 
 

1. Dirigirse a Pestaña Structure → Panel Opening → Wall  
2. Seleccionar un muro del modelo. 
3. Dibujar el hueco rectangular. 
4. Se ser necesario ajustar los parámetros en la Paleta de Propiedades. 

 

 
 
Colocación de huecos con la opción “Dormer Opening” 
 
Para crear una buhardilla (Dormer) se colocan primero los muros y la losa de techo, 
después se pueden usar estos elementos para cortar el hueco en la losa de techo. 
 
Para colocar huecos con la opción “Dormer”: 
 

1. Crear los muros y losas de techo como se muestra a continuación para poder crear 
la buhardilla. 

 

 
 
Nota: Se debe utilizar la herramienta “Join Roof” para para unir el techo abuhardillado al 
techo principal, de lo contrario se puede encontrar un error al crear el hueco. 
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2. Dirigirse a Pestaña Structure → Panel Opening → Dormer  
3. Seleccionar la losa de techo donde se creará el hueco. 
4. Seleccionar la losa de techo abuhardillada y las caras interiores de los tres muros, 

para dibujar el contorno del hueco. 

5. Hacer click en Finish  para confirmar su colocación. 
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Capítulo 12 
 

Acero de Refuerzo 
 
Se pueden usar las herramientas en el panel de Reinforcement para crear el acero de 
refuerzo en elementos anfitriones (hosts) válidos como pueden ser cimentaciones, muros, 
losas estructurales, trabes, contraventeos y columnas estructurales, de concreto, con las 
siguientes herramientas. 
 

 
 
Cuando un elemento anfitrión válido es seleccionado, las herramientas del panel 
Reinforcement estarán disponibles. 
 
Un elemento anfitrión válido consiste en una familia válida con un valor igual a “Concrete”, 
“Precast Concrete” u “Other” en el parámetro “Material for Model Behavior”. Las losas y 
muros deben tener activada la propiedad “Structural” en la Paleta de Propiedades. 
 
Los anfitriones válidos incluyen las siguientes categorías: 
 

• Structural Framing 

• Structural Columns 

• Structural Foundations 

• Structural Connections 

• Floors 

• Walls 

• Foundation Slab 

• Wall Foundation 

• Slab Edge 
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Nota: Se puede habilitar en el editor de familias a los elementos creados desde la plantilla 
Generic Model para alojar varillas, al activar la casilla “Can host rebar” en la Paleta de 
Propiedades y cargándola al proyecto. 
 
Configuración general del Acero de Refuerzo 
 
Para entrar a la configuración general del acero de refuerzo: 
 

1. Dirigirse a Pestaña Structure →Panel Reinforcement → Reinforcement  Settings  
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General 
 

En la Sección General → Apartado General Reinforcement Settings habilitar las 
siguientes opciones: 

 

 
 

• Host Structural Rebar within Area and Path Reinforcement: Permite alojar 
las varillas creadas como área de refuerzo (Area Reinforcement) o con base a 
una trayectoria (Path) dentro de los elementos anfitriones, de forma 
independiente. 

 
Esta opción también permite: 

 
o Cambiar la visibilidad de las varillas contenidas en las áreas y 

trayectorias de refuerzo: 
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o Cuantificar cada varilla en el proyecto. Las varillas alojadas dentro de 
elementos anfitriones que coincidan en longitud se agrupan en Sets de 
varillas. 

o Remover el sistema de área o trayectoria de refuerzo dejando solo las 
varillas o sets de varillas en el lugar donde se colocaron. 

 
Nota: La disponibilidad de esta opción depende del archivo que se utilice: 

 
-Un archivo nuevo: La opción está activada de forma predeterminada y puede 
desactivarse. Después de crear un área de refuerzo o un refuerzo con base en 
una trayectoria no podrá cambiar su configuración. 
-Un archivo existente con refuerzo modelado: Se deberá eliminar las áreas y 
trayectorias de refuerzo previamente creadas para cambiar su configuración. 

 

• Include Hooks in Rebar Shape definition: Permite mantener o quitar la 
relación entre la identidad de “Rebar Shape” y los dobleces (hooks) 
predeterminados a los extremos, es decir:  

 
Véase: Creación de una Forma de Varilla 

o Configuración Activada: 

 
 

o Configuración Desactivada 
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• Include End Treatments in Rebar Shape definition: Permite mantener o 
quitar la relación entre la identidad de “Rebar Shape” y los tratamientos finales 
asignados al colocarles un acoplador a los extremos, es decir:  

 
Véase: End Treatment 

o Configuración Activada: 

 
 

o Configuración Desactivada: 

 
 

Nota: No se permite agregar acopladodes en extremos de varillas con ganchos. 
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Reinforcement Rounding 
 
En la Sección Reinforcement Rounding configurar lo siguiente: 
 

 
 

• Use reinforcement rounding: Permite el redondeo numérico de las longitudes 
de las varillas y mallas de refuerzo para simplificar la organización y 
documentación al etiquetar, filtrar o crear tablas de cuantificación. 
 
Cuando está activada, las longitudes de varillas calculadas, las longitudes de 
segmento de varillas y las dimensiones de mallas de refuerzo se redondean. 
Cuando está desactivada, las longitudes de varillas calculadas, las longitudes 
de segmento de varillas y las dimensiones de mallas de refuerzo muestran sus 
valores exactos. 
 

• Rounding method: Especifica la dirección para el redondeo de los números. 
 

o Nearest: Redondea al valor más cercano (arriba o abajo) y toma como 
referencia un valor de 0.5 para incrementar. Por ejemplo: 

 
3.72 → Se convierte en 4 
3.42 → Se convierte en 3 

 
o Up: Redondea al siguiente número. Por ejemplo: 

 
3.72 y 3.42 → Se convierten en 4 

 
o Down: Redondea al número previo. Por ejemplo: 

 
3.72 y 3.42 → Se convierten en 3 
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• Rounding increment: Especifica un intervalo de redondeo. A continuación, se 
muestra como disminuyen o aumentan los valores según su incremento y 
método de redondeo. 
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Nota: La configuración de la sección “Reinfocement rounding” sobrescribe el 
redondeo dado en las unidades del proyecto. Una vez activa esta opción, la Paleta 
de Propiedades mostrará un formato dual, con el valor exacto de longitud y la 
longitud redondeada en paréntesis. 

 

 
 

2. En la Sección Reinforcement presentation → Apartado Bar presentation in Rebar 
Set configurar lo siguiente: 

 

 
 

Esta sección nos permite especificar la presentación de las varillas en las vistas de 
planta y sección. 
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Nota: La documentación de las varillas fue agregada solo como referencia. Las 
etiquetas de varillas deben agregarse por separado. 

 
Area / Path Reinfocement 
 
En las Secciones Area / Path Reinfocement configurar lo siguiente: 
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Esta sección permite especificar las abreviaturas de las etiquetas para el refuerzo 
creado como área de refuerzo (Area Reinforcement) o con base a una trayectoria 
(Path Reinforcement). 

 
 Area Reinforcement 
 

 
 
 Path Reinforcement 
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Varying Rebar Set 
 
En la Sección Varying Rebar Set → Apartado Numbering Method Settings configurar lo 
siguiente: 
 

 
 

Esta sección permite especificar la numeración de las varillas colocadas con la 

herramienta Varying Rebar Set  utilizada para crear sets de varillas en anfitriones 
que tienen caras inclinadas o sesgadas. 

 

• Number bars individually: A cada varilla del set se le asignará un número. A 
las varillas similares se le asignará el mismo número a lo largo del proyecto. 
Ej. Se creó un set de 20 varillas en la losa irregular y a cada una se le asignó 
un número en el parámetro “Rebar Number” como se muestra en la tabla de 
cuantificación. 
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• Number bars as a whole: A todas las varillas del set se le asignará el mismo 
número y cada varilla se diferenciará por un sufijo especificado. 
Ej. Se creó un set de 20 varillas en la losa irregular y a todas le fueron 
asignadas el mismo número en el parámetro “Rebar Number”, así mismo, le 
fueron agregados una sucesión de valores a partir del sufijo dado en la 
configuración en el parámetro “Rebar Number Suffix” como se muestra en la 
tabla de cuantificación. 
 
(En el ejemplo, el valor dado en sufijo fue ”1”) 

 

 
 
Configuración general del Recubrimiento para el Acero de Refuerzo 
 
Lo primero que se debe hacer antes de colocar un solo elemento de refuerzo en el 
proyecto es agregar y asignar los recubrimientos para el acero de refuerzo. La 
configuración de los recubrimientos es un cuadro de diálogo simple donde se puede 
agregar todos los recubrimientos que se necesitan en el proyecto. Es importante tenerlos 
correctos ya que, el refuerzo modelado será sujeto a ellos. Esta configuración se puede 
cambiar en cualquier momento, pero la experiencia muestra que esto puede dañar la 
precisión del modelado y con ello las tablas de cuantificación. 
 
Para entrar a la configuración general del recubrimiento para el acero de refuerzo: 
 

1. Dirigirse a Pestaña Structure →Panel Reinforcement → Rebar Cover Settings  
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2. Agregar o seleccionar un tipo de recubrimiento existente en el cuadro de diálogo. 
3. Ajustar la descripción y medida del tipo de recubrimiento. Se puede agregar, 

duplicar y eliminar recubrimientos desde este cuadro de diálogo según sea 
necesario. 

 
Edición y Colocación de Varillas 
 
Las varillas se pueden dividir en dos: varillas que obtienen su geometría de una familia de 
forma “Rebar Shape”, llamadas “Shape Driven Rebar”, y varillas de forma libre “Free Form 
Rebar”, que pueden tener cualquier geometría y no requieren de una familia de forma. 
También podemos ver y modificar los parámetros que definen las propiedades de las 
varillas. 
 
Las varillas se definen a partir de tres familias de sistema y una familia de componente 
(Cargable): 
 

• Structural Rebar 
o Structural Rebar (Sistema) 
o Rebar Hook (Sistema) 
o Rebar Shape (Cargable) 
o End Treatment (Sisema) 

 
Edición de Varillas (Structural Rebar) 
 
Tipo de Familia: Familia de Sistema 
 

1. Buscar en el Navegador de Proyectos, en el apartado de familias, la categoría 
Structural Rebar y desplegar las familias y tipos de “Rebar Bar” con click en el 

ícono . 
2. Dar Click derecho en el tipo y seleccionar la opción Type Properties... 
3. En el cuadro de diálogo Propiedades de Tipo Duplicar el tipo y nombrar. 
4. Una vez Duplicado el tipo, modificar las propiedades: 
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• Deformation: Especifica el parámetro de deformación para el tipo de varilla 
seleccionado. Existen dos tipos por defecto: “Deformed” para varillas se acero 
corrugado y “Plain” para varillas de acero liso. Este parámetro se tiene en 
cuenta en el análisis. 

• Rounding Overrides:  Especifica los parámetros de redondeo para el tipo de 
varilla seleccionado. 

 
Nota: Este parámetro está disponible solo si se activó el redondeo del acero de 
refuerzo en el proyecto. 

 

• Subcategory: Se usa para proporcionar características gráficas de varillas por 
subcategoría. Para crear una nueva subcategoría, hacer click en la Pestaña 
Manage → Panel Settings → Object Styles. En la categoría Structural Rebar 
agregar nuevas subcategorías. 

• Material: Especifica el material de la varilla. 

• Bar Diameter: Especifica el diámetro de la varilla seleccionada. (Ver tabla de 
longitudes en ganchos) 

• Standard Bend Diameter: Especifica el diámetro de los dobleces (no 
ganchos) para el tipo de varilla seleccionado. 

• Standard Hook Bend Diameter: Especifica el diámetro de los dobleces en los 
ganchos para el tipo de varilla seleccionado. (Ver tabla de longitudes en 
ganchos) 

• Stirrup/tie Bend Diameter: Especifica el diámetro de los dobleces en un 
estribo para el tipo de varilla seleccionado. 

• Maximun Ben Radius: Especifica el radio máximo en un doblez. Su propósito 
es asistir a las varillas dobladas en el campo con diámetros de curvatura más 
grandes. Este parámetro cumple el único fin de documentación. 

• Hook Lengths: Especifica las medidas de los ganchos en función de un tipo 
de varilla. Hacer click en Edit para abrir el cuadro de diálogo “Rebar Hook 
Lengths. (Ver tabla de longitudes en ganchos) 
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• Rebar Hook Type: Esta es una lista completa de ganchos válidos para el tipo 
de varilla. Al activar la casilla de verificación, se indica que el tipo de gancho 
será visible en los parámetros “Hook At Start” y “Hook At End” de la varilla en la 
Paleta de Propiedades. 

• Autocalculation: Al desactivar la casilla se anula el cálculo automático de las 
longitudes del gancho correspondiente. 

• Hook Length: Muestra la longitud del tipo de gancho. 

• Tangent Length: Muestra la longitud tangente del tipo de gancho. 

• Offset Length: Muestra la longitud de desplazamiento del tipo de gancho. El 
uso de este parámetro es opcional principalmente para la programación. 

 
TABLA DE LONGITUDES DE GANCHOS 
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Edición de Ganchos para Varillas (Rebar Hook) 
 
Tipo de Familia: Familia de Sistema 
 

1. Buscar en el Navegador de Proyectos, en el apartado de familias, la categoría 
Structural Rebar y desplegar las familias y tipos de “Rebar Hook” con click en el 

ícono . 
2. Dar Click derecho en el tipo y seleccionar la opción Type Properties... 
3. En el cuadro de diálogo Propiedades de Tipo Duplicar el tipo y nombrar. 
4. Una vez Duplicado el tipo, modificar las propiedades: 

 

• Style: Especifica cuál de los dos radios de dobleces se utilizará para doblar el 
gancho seleccionado, ya sea una varilla estándar (Standard) o de estribo 
(Stirrup/Tie). 

• Hook Angle: Especifica el ángulo (0°-180°) del gancho para el tipo de gancho 
seleccionado. 

• Extension Multiplier: Asiste al cálculo automático de la longitud del gancho de 
las varillas, multiplicando su factor por el diámetro de la varilla. 
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Extension Multiplier * Bar diameter = Extension Length 

 
12  X 15.9      =      190.8 

 

 
 
Creación de una Forma de Varilla (Rebar Shape) 
 
Tipo de Familia: Familia de Componente (Cargable). 
 
La forma de varilla (Rebar Shape) es la única familia de las tres que constituyen a la 
varilla que es cargable. También es de vital importancia tenerlas disponibles y modeladas 
correctamente para obtener buenos resultados en el modelado del refuerzo. 
 
Las familias de forma de varilla son en su mayoría familias 2D, no muy diferentes de la 
familia “Profile”, exceptuando, que es posible hacer formas multiplanares, es decir una 
forma que se doble en dos planos. Las familias de formas se modelan con líneas y se 
parametrizan solo con Parámetros Compartidos, esto significa que se tiene que configurar 
un archivo compartido de parámetros para agregar cualquier parámetro personalizado a 
una familia de forma o utilizar los parámetros compartidos cargados en la plantilla (A, B, 
C, D, E…). 
 
En una familia de forma de varilla, cada segmento de línea de varilla tiene dos referencias 
(al inicio y fin del segmento) con los cuales se crea una relación con los parámetros de 
longitud por medio de una cota, estos parámetros controlan el tamaño del segmento de 
varilla. 
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Una de las líneas de varilla también debe definirse como el segmento mayor. Esta 
normalmente será el segmento que se use al colocar la varilla. 
Ej. En la forma de varilla mostrada anteriormente se seleccionó el segmento mayor en la 
línea inferior, por lo que al colocarla en el modelo se tomará ese tramo de varilla como 
referencia para su colocación. 
 

 
 
Para crear una forma de varilla: 
 

1. Hacer Click en la Pestaña File → Opción New → Family 
2. Elegir la plantilla con el nombre “Metric Rebar Shape Template” y hacer click en 

Open. 
3. Definir la ubicación del punto de inserción en planta. 
4. Configurar los parámetros que controlan la familia en la Pestaña Create → Panel 

Properties → Family Types . 
 

Los parámetros de las formas de varillas poseen limitaciones como: 
 

➢ La varilla no se flexiona cuando se ajustan los valores de sus parámetros. 
➢ La varilla no se mueve en el editor de familias como lo hace en el editor del 

proyecto. 
➢ La varilla solo tiene un solo nivel de detalle. Cambiar entre los niveles de 

detalle Bajo, Medio o Fino no tiene ningún efecto en su apariencia. 
 

• Top Finishing Turns: (Solo para varillas Espirales) Especifica el número 
de espirales para cerrar la parte superior de la varilla. 
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• Style: Especifica el tipo de varilla a usar para asignar los diámetros de los 
dobleces. Seleccionar “Standard” para usar el valor especificado en el 
parámetro “Bend Diameter” o seleccionar “Stirrup/Tie” para usar el valor 
especificado en el parámetro “Stirrup/Tie Bend Diameter”. Ambos 
parámetros de diámetro pertenecen al tipo de la varilla. 

• Stirrup/Tie Attachment: (Solo para varillas de estribo “Stirrup/Tie style”) 
Especifica si la varilla de estribo queda en el interior (predeterminado) o en 
el lado exterior del recubrimiento del elemento. 

 

 
 

• Start Tangent Hook Length: Especifica la distancia perpendicular entre el 
centro del doblez del gancho hasta el final del gancho, al inicio de la forma 
de la varilla. 

 

 
 

• Start Hook Offset Length: Especifica una longitud de desfase entre el 
doblez del gancho hasta el final del gancho, al inicio de la forma de la 
varilla. 

 

 
 

Nota: Este valor se usa en el editor de familias al crear la forma de la 
varilla. Cuando la forma se carga en un archivo de proyecto, los valores 
reales se toman de las definiciones en el tipo de varilla. 
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• Start Hook Length: Especifica la longitud del gancho al inicio de la forma 
de varilla. 

 

 
 

Nota: Este valor se usa en el editor de familias al crear la forma de varilla. 
Cuando la forma se carga en un archivo de proyecto, los valores reales se 
toman de las definiciones en el tipo de varilla. 

 

• Shape Image: Especifica una imagen para asociar con el tipo de forma de 
varilla. Para crear una tabla de cuantificación de varillas con las imágenes 
asociadas, se debe incluir este parámetro. 

• Pitch: (Solo para varillas Espirales) Especifica la distancia entre las 
espirales de la varilla. 

 

 
 

• Hook at Start: Especifica el tipo de gancho para el inicio de la forma de 
varilla de acuerdo con el estilo de varilla (Standard o Stirrup/Tie). 
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• Hook at End: Especifica el tipo de gancho para el final de la forma de 
varilla de acuerdo con el estilo de varilla (Standard o Stirrup/Tie). 

 

 
 

• Height: (Solo para varillas Espirales) Muestra la altura total de la varilla en 
espiral. Si se utiliza el redondeo en el proyecto, esta dimensión se muestra 
en un formato dual: exacto y redondeado entre paréntesis. 

 

 
 

• End treatment at Start: Especifica el tipo de tratamiento final aplicado al 
comienzo de la varilla. Esto lo especifica el conector de varilla conectado 
en ese extremo. (Véase Creación de un Tratamiento Final) 

• End treatment at End: Especifica el tipo de tratamiento final aplicado al 
final de la varilla. Esto lo especifica el conector de varilla conectado en ese 
extremo. (Véase Creación de un Tratamiento Final) 

• End Tangent Hook Length: Especifica la distancia perpendicular entre el 
centro del doblez del gancho hasta el final del gancho, al final de la forma 
de la varilla. 
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• End Hook Offset Length: Especifica una longitud de desfase entre el 
doblez del gancho hasta el final del gancho, al final de la forma de la varilla. 

 

 
 

Nota: Este valor se usa en el editor de familias al crear la forma de la 
varilla. Cuando la forma se carga en un archivo de proyecto, los valores 
reales se toman de las definiciones en el tipo de varilla. 

 

• End Hook Length: Especifica la longitud del gancho al final de la forma de 
varilla. 

 

 
 

Nota: Este valor se usa en el editor de familias al crear la forma de varilla. 
Cuando la forma se carga en un archivo de proyecto, los valores reales se 
toman de las definiciones en el tipo de varilla. 

 

• Bend Diameter: Especifica el diámetro de los dobleces (no ganchos) para el 
tipo de varilla. 

 

 
 

• Base Finishing Turns: (Solo para varillas Espirales) Especifica el número de 
espirales para cerrar la parte inferior de la varilla. 
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• Bar Diameter: Especifica el diámetro de la varilla. 
 

 
 

• A, B, C..: Especifica longitudes variables cuyas cantidades y fórmulas definen 
la forma. 

 

5. Dirigirse a Pestaña Create → Panel Draw → Rebar  y elegir entre 
cualquiera de las líneas de boceto para definir los tramos de varilla. 

6. Dirigirse a Pestaña Create → Panel Draw → Major Segment  y elegir el 
segemento mayor entre los tramos de varilla. 

 

 
 

7. Crear una relación entre los parámetros y los planos de referencia por medio de 
una cota: 
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8. Dirigirse a Pestaña Create → Panel Rebar Types → Allowable Bar Types  y 
elegir los tipos de varilla válidos para el tipo de forma, activar la casilla en la 
columna “Allowed” correspondiente al tipo de varilla deseado. 

 

 
 

9. De forma opcional, dirigirse a Pestaña Create → Panel Family Editor → Multi-

planar  para trabajar la forma en dos planos. 
 

Al activar la herramienta la forma de origen se duplicará unida a la original por un 
segmento de varilla y la vista de edición cambia a una vista 3D. 

 

 
 

Nota: Se debe proporcionar un parámetro (A, B, C ...) al segmento que conecta la 
forma original a su espejo antes de que la familia pueda cargarse en un proyecto, 
como se muestra en la imagen de la derecha. 
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Nota 2: Los cambios realizados en la forma de origen se reflejarán en la copia 
duplicada. 

 

 
 
 
Creación de un Tratamiento Final (End Treatment) 

 
El tratamiento final (End Treatment) representa el tipo de conexión cuando se colocan 
conectores para varilla (Rebar Couplers). Los tratamientos finales se representan como 
un parámetro para uso de documentación, este se puede editar desde la familia de 
conector, por defecto hay dos tratamientos disponibles: Soldado (Welded) y Roscado 
(Threaded). De ser necesario se pueden crear otros tratamientos finales en el proyecto o 
en la misma familia de conector en el editor de familias: 
 
Tipo de Familia: Familia de Sistema 
 
Para crear tratamientos finales desde el proyecto: 
 

1. Buscar en el Navegador de Proyectos, en el apartado de familias, la categoría 
Structural Rebar y desplegar las familias y tipos de “End Treatment” con click en el 

ícono . 
2. Dar Click derecho en el tipo y seleccionar la opción Type Properties... 
3. En el cuadro de diálogo Propiedades de Tipo Duplicar el tipo y nombrar. 
4. Una vez Duplicado el tipo, ingresar un nuevo tratamiento final en el parámetro 

“End Treatment” en el grupo de parámetros “Construction”. 
 

Para crear tratamientos finales desde la familia de conector: 
 

1. Buscar en el Navegador de Proyectos de la familia Structural Rebar Coupler, en el 
apartado de familias, la categoría Structural Rebar y desplegar las familias y tipos 

de “End Treatment” con click en el ícono . 
2. Dar Click derecho en el tipo y seleccionar la opción Type Properties... 
3. En el cuadro de diálogo Propiedades de Tipo Duplicar el tipo y nombrar. 
4. Una vez Duplicado el tipo, ingresar un nuevo tratamiento final en el parámetro 

“End Treatment” en el grupo de parámetros “Construction”. 
5. Una vez creado el nuevo tipo de tratamiento dirigirse a la Pestaña File → Panel 

Properties → Family Types  y asignarlo dentro de los parámetros “End 
Treatment 1” y “End Treatment 2”. 

6.  y c 
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Nota: La disponibilidad de estas opciones en la configuración general del Acero de 
Refuerzo “Include hooks in Rebar Shape definition” e “Include end treatments in Rebar 
Shape definition” depende del archivo que se utilice: 

 
-Un archivo nuevo: La opción está disponible para poder activarse o desactivarse. 
Después de crear una varilla no podrá cambiar su configuración. 
-Un archivo existente con varillas modeladas: Se deberán eliminar las varillas 
previamente creadas para cambiar su configuración. 

 
 
Colocación de Varillas (Structural Rebar) 
 
La categoría Structural Rebar es la herramienta principal para detallar el refuerzo en 
Revit. Se puede acceder a ella desde la Pestaña Structure o la Pestaña Modify después 
de seleccionar un objeto válido. Se pueden agregar varillas a un elemento de formas 
diferentes, ya sea con la herramienta Structural Rebar, Structural Area Reinforcement o 
Structural Path Reinfocement. 
 
Varillas con la herramienta Structural Rebar 
 
Para colocar varillas con la herramienta Structural Rebar: 
 

1. Dirigirse a la Pestaña Structure →  Panel Reinfocement → Rebar   
2. Especificar un plano de colocación en la Pestaña Modify | Place Rebar → Panel 

Placement Plane 
 

 
 

• Current Work Plane: Coloca las varillas en el plano de trabajo activo en la 
vista del anfitrión. El elemento colocado será una varilla con las propiedades 
del tipo y la forma que se seleccione. Respetará el recubrimiento cuando se 
coloque. 
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• Near Cover Reference: Coloca las varillas tomando como referencia el 
recubrimiento de la cara más cercana, de forma paralela a la vista del anfitrión. 
El elemento colocado será una varilla con las propiedades del tipo y la forma 
que seleccione. Respetará el recubrimiento cuando se coloque. 

 

 
 

• Far Cover Reference: Coloca las varillas tomando como referencia el 
recubrimiento de la cara más lejana, de forma paralela a la vista del anfitrión. 
El elemento colocado será una varilla con las propiedades del tipo y la forma 
que seleccione. Respetará el recubrimiento cuando se coloque. 

 

 
 

3. Especificar una orientación de colocación en la Pestaña Modify | Place Rebar → 
Panel Placement Orientation 

 

 
 

• Parallel to Work Plane: Coloca las varillas de forma paralela al recubrimiento 
de la cara más cercana del cursor y paralela al plano de trabajo actual. 
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• Parallel to Cover (Place Perpendicular to Work Plane and Parallel to 
Nearest Cover Reference): Coloca las varillas de forma paralela al 
recubrimiento de la cara más cercana del cursor y perpendicular al plano de 
trabajo. 

 
 

• Perpendicular to Cover (Place Perpendicular to Work Plane and 
Perpendicular to Nearest Cover Referece): Coloca las varillas de forma 
perpendicular al recubrimiento de la cara más cercana del cursor y 
perpendicular al plano de trabajo. 

 

 
 

Nota: En caso de colocar una varilla con una forma basada en dos planos (Multi-
Planar) las herramientas de colocación cambian por el siguiente menú. 

 

 
 

La herramienta ilustra los planos de trabajo de un elemento, la varilla será 
colocada de forma paralela al plano de trabajo seleccionado.  
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4. Si se desea agregar un set de varillas lineales, especificar un número de varillas 

y/o espaciado entre ellas en el panel Rebar Set 
 

 
 

• Layout: Es especifica el tipo de distribución entre varillas. 
 

o Single: Seleccionada de forma predeterminada, permite colocar una 
varilla. 

o Fixed Number: El espacio entre las varillas es ajustable, pero el 
número de varillas es constante. 

o Maximum Spacing: Especifica la distancia máxima entre las varillas, 
pero el número de varillas cambia, con relación a la distancia entre la 
primer y última varilla. 

o Number with Spacing: Especifica valores constantes para la cantidad 
y el espaciado entre varillas. 

o Minimum Clear Spacing: Especifica la distancia mínima entre las 
varillas, pero el número de varillas cambia, con relación a la distancia 
entre la primer y última varilla. 

 

• Quantity / Spacing: Basado en la selección del tipo de distribución asignar un 
valor de cantidad / espaciamiento. 

 

5. Opcionalmente, activar o desactivar la herramienta Contrained Placement  en el 
Panel Rebar Constraints para colocar una varilla adyacente a otra y restringir su 
ubicación junto a ella, aun cuando se mueve, arrastra o copia y pega ambas 
varillas. 

 

6. Opcionalmente, activar o desactivar la herramienta Varying Rebar Set  en el 
Panel Rebar Set Type para colocar un set de varillas dentro de anfitriones con 
caras inclinadas y así garantizar su armado completo. 

 

 



182 
 

 
7. Definir en la barra de opciones el tipo de forma que tendrá la varilla desplegando el 

menú o seleccionándolo desde el Rebar Shape Browser . 
 

 
 
8. Colocar el cursor sobre la cara del elemento anfitrión para ver una previsualización 

del armado. 
 

 
 

9. Hacer click para confirmar su colocación. 
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Colocación de Varillas por Sketch (Sketch Rebar) 
 
 
 
El uso de la herramienta de boceto (Sketch Rebar) es común para la colocación y diseño 
manual de las formas de las varillas dentro de un host válido. 
 
Los bocetos de varilla se asignarán a una forma existente cuando compartan los 
siguientes atributos: 
 

• Número de segmentos de línea. 

• La forma creada por los segmentos de línea. 

• El número de ganchos. 

• La dirección de los ganchos. 

• Las dimensiones de doblez de los ganchos. 

• Tipo de forma: Estándar o Estribo 
 
De lo contrario una forma de varilla nueva se creará en el Rebar Shape Browser. 
 
Para colocar Varillas por Sketch: 
 

1. Dirigirse a la Pestaña Structure →  Panel Reinfocement → Rebar   
2. Dirigirse a la Pestaña Modify | Place Rebar → Panel Placement Methods → Sketch 

Rebar  
3. Seleccionar el elemento que alojará el armado. 
4. Dirigirse a Pestaña Modify | Create Rebar Sketch → Panel Draw y elegir entre 

cualquiera de las líneas de boceto para definir la forma de la varilla. 
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5. De forma opcional, dirigirse a la Pestaña Modify | Create Rebar Sketch → Panel 

Reinforcement → Multiplanar  para trabajar el boceto en dos planos. La mejor 
forma de trabajar el boceto es en una vista 3D 

 

 
 

Nota: Solo está disponible para varillas con la geometría definida como una forma 
común “Shape Driven” en la Paleta de Propiedades. 
 
Al activar la herramienta el boceto se duplicará unido al original por un segmento 
de varilla. Se pueden activar las casillas para elegir en cual extremo se unirá la 
varilla y también para desactivar el duplicado: 

 

 
 
 

6. En la Paleta de Propiedades definir los siguientes parámetros: 
 

• Geometry: Especifica si la geometría de la varilla se define como una 
forma de varilla común o como una varilla de forma libre 

 
o Shape Driven: La varilla se define como cualquier forma de varilla. 
o Free Form: La varilla se define como una geometría de forma libre y 

esta buscará relacionarse con las familias de formas existentes que 
correspondan. De lo contrario, crea su propia forma. 
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• Workshop Instructions: (Solo para varillas con geometría de forma libre 
“Free Form”) Especifica como se fabricará la varilla. 

 
o Keep Straight: La varilla se entrega como una varilla recta al sitio. 

El código de forma es la primera forma de varilla recta cargada en el 
proyecto (Forma de varilla: 00). 

o Bend: La varilla se doblará y se le asignará una forma de varilla 
existente. Si no existe una coincidencia, se crea una nueva forma 
de varilla. 

 

• Style: Especifica el tipo de varilla a usar para asignar los diámetros de los 
dobleces. Seleccionar “Standard” para usar el valor especificado en el 
parámetro “Bend Diameter” o seleccionar “Stirrup/Tie” para usar el valor 
especificado en el parámetro “Stirrup/Tie Bend Diameter”. Ambos 
parámetros de diámetro pertenecen al tipo de la varilla. 

• Stirrup/Tie Attachment: (Solo para varillas de estribo “Stirrup/Tie style”) 
Especifica si la varilla de estribo queda en el interior (predeterminado) o en 
el lado exterior del recubrimiento del elemento. 

 

 
 

• Hook at Start: Especifica el tipo de gancho para el inicio de la forma de 
varilla de acuerdo con el estilo de varilla (Standard o Stirrup/Tie). 

• Hook at End: Especifica el tipo de gancho para el final de la forma de 
varilla de acuerdo con el estilo de varilla (Standard o Stirrup/Tie). 
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• Hook Orientation at Start: Especifica la rotación del gancho al comienzo 
de la varilla. Especifica los grados de rotación de 0° a 360°. 

 

 
 

• Hook Orientation at End: Especifica la rotación del gancho al término de 
la varilla. Especifica los grados de rotación de 0° a 360°. 

 

 
 
 
 

7. Hacer click en Finish  para confirmar su colocación. 
 
Geometría que no está permitida en Varillas por Sketch. 
 

 
 

1) Terminación en forma de arco. 
2) Arcos consecutivos. 
3) Arcos que no sean tangentes a los segmentos contiguos. 
4) Arcos mayores a 180° entre los segmentos contiguos. 
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Colocación de Varillas en elementos geométricos complejos (Free Form Rebar) 
 
La herramienta Free Form Rebar asiste en el armado de geometría con forma irregular. El 
armado se coloca especificando las superficies de referencia a lo largo del elemento 
anfitrión, y existen algunas diferencias entre las varillas de forma libre (Free Form Rebar) 
y las varillas basadas en una forma (Shape Driven Rebar). Las varillas de forma libre se 
comportan de manera diferente en ciertas situaciones para mantener la fidelidad 
paramétrica y la geometría del modelo. 
 
Las varillas de forma libre son parte de la categoría de Structural Rebar y posee todas las 
propiedades asociadas, y se pueden alojar en cualquier elemento de Revit que pueda 
alojar elementos de refuerzo. 
 
Existen dos tipos de distribución de varillas para este método de colocación:  
 

➢ Surface Distribution: Distribuye las varillas a lo largo de la(s) superficie(s) 
elegida(s). Las varillas se crean entre la primera y la última varilla del set, de forma 
paralela a las caras seleccionadas. 

➢ Aligned Distribution: Distribuye las varillas a lo largo de una trayectoria sobre la(s) 
superficie(s) seleccionada(s). Las varillas se crean de forma perpendicular a la 
trayectoria. 

 
Con este método de colocación las varillas respetan el recubrimiento asignado a los 
elementos. Los elementos que cuenten con diferente recubrimiento en cada cara 
seleccionada, se respetará el recubrimiento mayor para todas ellas como se muestra en la 
imagen. 
 

 
 
Para colocar Varillas de forma libre por Surface Distribution: 
 

1. Dirigirse a la Pestaña Structure →  Panel Reinfocement → Rebar   
2. Dirigirse a la Pestaña Modify | Place Rebar → Panel Placement Methods → Free 

Form Rebar  
3. Elegir en la Pestaña Modify | Place Free From Rebar → Panel Distribution Type → 

Surface  
4. Establecer la disposición de las varillas en el Panel Rebar Set. 
5. En la Paleta de Propiedades seleccionar el tipo de varilla desde el Selector de 

Tipos y modificar sus parámetros de instancia. 
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6. En el área de dibujo, seleccionar las caras del elemento que alojarán las varillas de 

forma libre. 
 

 
 

7. Elegir en la Pestaña Modify | Place Free From Rebar → Panel Next → Start 

Surface . Seleccionar las caras desde donde comenzará el set set de varillas. 
 

 
 

8. Elegir en la Pestaña Modify | Place Free From Rebar → Panel Next → End Surface 

. Seleccionar las caras donde terminará el set set de varillas. 
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9. Hacer click en Finish  para confirmar su colocación. 
 

 
 
Para colocar Varillas de forma libre por Aligned Distribution: 
 

1. Dirigirse a la Pestaña Structure →  Panel Reinfocement → Rebar   
2. Dirigirse a la Pestaña Modify | Place Rebar → Panel Placement Methods → Free 

Form Rebar  
3. Elegir en la Pestaña Modify | Place Free From Rebar → Panel Distribution Type → 

Aligned  
4. Establecer la disposición de las varillas en el Panel Rebar Set. 
5. En la Paleta de Propiedades seleccionar el tipo de varilla desde el Selector de 

Tipos y modificar sus parámetros de instancia. 
6. En el área de dibujo, seleccionar las caras del elemento que alojarán las varillas de 

forma libre. 
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7. Elegir en la Pestaña Modify | Place Free From Rebar → Panel Next → Path . 
Seleccionar un borde del elemento, el borde servirá como una trayectoria para 
colocar las varillas de forma perpendicular. 

 

 
 

8. Hacer click en Finish  para confirmar su colocación. 
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Herramientas de Visualización, Presentación, Ajuste y Restricción de Varillas 
 
Herramientas de Visualización 
 
Las varillas y sus conectores en un modelo están contenidos dentro de los elementos 
anfitriones. En una vista de línea oculta (Hidden Line), el anfitrión los oculta. Se puede 
cambiar esta visualización para cada vista en un proyecto, así el diseño del armado puede 
documentarse. 
 
También se puede cambiar la representación de las varillas y mostrar su volumen 
geométrico cuando el nivel de detalle de la vista se establece en fino. Los conectores 
siempre se ven como sólido sen las vistas 3D. 
 
Para cambiar la visualización de las Varillas y Conectores: 
 

1. Seleccionar las varillas que requieren cambiar su visualización. 
2. Dirigirse a la Paleta de Propiedades → Grupo de parámetros Graphics → View 

Visibility States → Edit 
 

 
 

3. Activar la casilla en la columna “View unobscured” correspondiente a la vista que 
hará el cambio de visualización, para ver las varillas sin obstrucciones, 
independientemente del estilo visual de la vista. 
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4. Activar la casilla en la columna “View as solid” correspondiente a la vista que hará 

el cambio de visualización, para ver las varillas con su representación volumétrica 
cuando el nivel de detalle de la vista se establece en fino. 

 

 
 

5. Hacer click en “OK” para confirmar el cambio. 
 
Herramientas de Presentación 
 
Especifican cómo se muestran los sets de varillas en una vista. Los esquemas de 
presentación de varillas simplifican la vista al tiempo que mantienen una huella 
identificable en la que se coloca el set de varillas. 
 
Para cambiar la Presentación de las Varilla: 
 

1. Seleccionar el set de varillas que requieren cambiar su presentación. 
2. Dirigirse a la Pestaña Modify → Panel Presentation y elegir entre cualquiera de las 

siguientes opciones. 
 

 
 

• Show All: Muestra todas las varillas del set. 
 

 
 

• Show First and Last: Muestra la varilla inicial y final del set. 
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• Show Middle: Muestra la varilla de en medio del set 
 

 
 

• Select: Muestra las varillas seleccionadas y ocultará las demás. 
 

 
 

Nota: Si se aplicó anteriormente una anotación de múltiples varillas, ésta se 
ajustará a las varillas visibles del set, como se muestra en el ejemplo. 

 
Herramientas de Ajuste 
 
Las herramientas de ajuste establecen y bloquean la geometría de cada varilla con 
respecto a un elemento anfitrión. Las varillas se flexionan a dimensiones arbitrarias. Su 
posición y geometría se configuran automáticamente considerando la geometría de su 
anfitrión, así como la presencia de otras varillas. Una vez que se establece la geometría, 
las restricciones asignadas se mueven y flexionan en respuesta a los cambios en el 
elemento anfitrión y su recubrimiento. 
 
La varilla que toca una referencia de recubrimiento se ajustará y se adjuntará a esa 
referencia, excepto si la varilla una vez colocada se mueve o se copia. 
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Las varillas se pueden ajustar de diversas formas dentro de un gancho de esta manera se 
puede evitar interferencias y colisiones con otras varillas. 
 

Gancho de 90 grados: 
 

 
 

Gancho de 135 grados: 
 

 
 
Los parámetros de recubrimiento afectan la varilla adjunta y las varillas que están unidas 
a esas varillas. Cambiar la configuración del recubrimiento no compensará otras varillas 
que haya colocado dentro del anfitrión. 
 

Véase: Herramientas de Restricción 
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Se puede ajustar manualmente la orientación y ubicación de los lados y ganchos de una 
varilla. 
 
Con las herramientas de ajuste de flecha se puede cambiar la ubicación de los lados: 
 

 
 
Con la barra espaciadora se puede girar la varilla y con ello cambiar la orientación del 
gancho: 
 

 
 
Para invertir la orientación de un gancho es necesario seleccionar la varilla a editar y 
dirigirse a la Pestaña Modify | Structural Rebar → Panel Mode → Edit Sketch 
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Dentro del sketch hacer click en  para invertir la orientación del gancho.y hacer click en 

Finish  para confirmar el cambio. 
 
 

 
 

Para invertir los ganchos en los extremos de una varilla es necesario hacer click en 

dentro del sketch y hacer click en Finish para confirmar el cambio. 
 

 
 
Se puede mover y suprimir la primera y última varilla de un set; al seleccionar el set de 
varillas las casillas de verificación y ajustes de flecha se muestran en ambos extremos. 
 

 
 
Desactivar una casilla de verificación ocultará la varilla respectiva. 
 

 
 
Mover las flechas de ajuste modificará la distribución del set de varillas. 
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Herramientas de Restricción 
 
Se pueden ajustar las dimensiones de las varillas, las distancias a los elementos u otras 

varillas y establecer relaciones entre varillas mediante el comando Edit Constraints . 
 
Una vez seleccionada la varilla a editar y activado el comando de Edit Constraints se 
pueden identificar las siguientes opciones: 
 

1. Restricción a cara o recubrimiento: 
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2. Restricción entre varillas: 

 

 
 
Para restringir una distancia de varilla a varilla, se debe seleccionar la varilla que se desea 
restringir y elegir el comando Edit Constraints, una vez activa la herramienta se debe 
seleccionar la varilla a la cual se restringirá. 
 

 
 
 
 

 
 
 

3. Restricción Bidireccional / Unidireccional: 
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Cuando está habilitada la opción bidireccional  se asegura que al mover o arrastrar 
cualquiera de los dos elementos, tanto la varilla restringida como el objetivo al cual se 
restringió, se muevan juntos. 
 

Mientras que la opción unidireccional  esté activa, solo la varilla restringida seguirá el 
objetivo y no al revés. 
 
Colocación de Áreas de Refuerzo (Area Reinforcement) 
 
Las áreas de refuerzo permiten armar muros y losas con cuatro capas de varillas, dos 
capas perpendiculares correspondientes a las caras Superior/Exterior y dos capas 
perpendiculares correspondientes a las caras Inferior/Interior. 
 
A las áreas de refuerzo se les puede definir el tamaño, espacio entre varillas, tipo de 
varilla y ganchos de cada capa. 
 

 
 
Para colocar un Área de Refuerzo: 
 

1. Dirigirse a la Pestaña Structure →  Panel Reinfocement → Area  
2. Seleccionar el elemento que alojará el armado. 
3. Dirigirse a Pestaña Modify | Create Reinforcement Boundary → Panel Draw → 

Rebar Line . 
4. Elegir entre cualquiera de las líneas de boceto para definir el perímetro del área. 
5. Dirigirse a Pestaña Modify | Create Reinforcement Boundary → Panel Draw → 

Major Direction . 
6. Elegir entre cualquiera de las líneas de boceto para definir la dirección principal del 

armado. 
7. Especificar en la Paleta de Propiedades: 

 

• Layout Rule: Especifica el tipo de distribución de varillas. 

• Additional Top Cover Offset: Especifica un recubrimiento adicional desde 
la cara superior / exterior del armado. 

• Additional Botom Cover Offset: Especifica un recubrimiento adicional 
desde la cara inferior / interior del armado. 

• View Visibility States: Accede a los estados de visibilidad de la vista del 
armado. 

• Top/Bottom Major/Minor Direction: Crea las varillas para la capa 
correspondiente. 

• Top/Bottom Major/Minor Bar Type: Especifica el tipo de varilla colocada 
en la dirección correspondiente. 

• Top/Bottom Major/Minor Hook Type: Especifica el tipo de gancho para la 
varilla colocada en la dirección correspondiente. 
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• Top/Bottom Major/Minor Hook Orientation: Especifica la orientación del 
gancho para la varilla colocada en la dirección correspondiente. 

• Top/Bottom Major/Minor Spacing: Especifica el espaciamiento entre 
varillas colocadas en la dirección correspondiente. 

• Top/Bottom Major/Minor Number of Lines: Especifica el número de 
varillas colocadas en la dirección correspondiente. 

 

8. Hacer click en Finish  para confirmar su colocación. 
 

 
 
Colocación de Refuerzo con base a una trayectoria (Path Reinforcement) 
 
Se puede usar la herramienta Path Reinforcement para crear armado perpendicular a lo 
largo de una ruta, en muros y losas. La ruta debe ser un contorno abierto, pero puede 
estar formado por diferentes líneas y arcos. También tiene la opción de alternar varillas 
con diferentes formas. 
 

 
 
Para colocar Refuerzo con base a una trayectoria: 
 

1. Dirigirse a la Pestaña Structure →  Panel Reinfocement → Path  
2. Seleccionar el elemento que alojará el armado. 
3. Dirigirse a Pestaña Modify | Create Reinforcement Path → Panel Draw y elegir 

entre cualquiera de las líneas de boceto para definir la trayectoria. 

4. Si es necesario, hacer click en la herramienta Flip Control , para que el armado 
se extienda al lado opuesto de la trayectoria. 
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5. Especificar en la Paleta de Propiedades: 

 

• Layout Rule: Especifica el tipo de distribución de varillas. 

• Additional Offset: Especifica un recubrimiento adicional desde la cara 
superior / exterior del armado. 

• View Visibility States: Accede a los estados de visibilidad de la vista del 
armado. 

• Face: Especifica la cara donde se colocará el armado. 

• Bar Spacing: Especifica el espaciamiento entre varillas, disponible solo si 
el tipo de distribución corresponde a “Maximum Spacing”. 

• Number of Bars: Especifica el número de varillas colocadas, disponible 
solo si el tipo de distribución corresponde a “Fixed Number”. 

• Primary / Alternating Bar – Type: Especifica el tipo de varilla colocada. 

• Primary / Alternating Bar – Length: Especifica la longitud de varilla 
colocada. 

• Primary / Alternating Bar – Shape: Especifica la forma de varilla 
colocada. 

• Primary / Alternating Bar – Start Hook Type: Especifica el tipo de gancho 
al inicio para la varilla colocada. 

• Primary / Alternating Bar – End Hook Type: Especifica el tipo de gancho 
al final para la varilla colocada. 

• Primary / Alternating Bar – Hook Orientation: Especifica la orientación 
del gancho para la varilla colocada. 

• Alternating Bars: Al habilitar esta casilla se agrega una varilla alternativa 
dentro de la distribución, con sus propiedades independientes a la varilla 
primaria. 

 

6. Hacer click en Finish  para confirmar su colocación. 
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Edición y Colocación de Mallas de Refuerzo 
 
Se pueden colocar Mallas de Refuerzo traslapadas en losas, muros y losas de 
cimentación. También se pueden crear mallas de refuerzo dobladas en una dirección, 
utilizando el boceto de curva “Bend Sketch” durante la colocación. 
 
Las Mallas de Refuerzo se definen a partir de dos familias de sistema: 
 

• Structural Fabric Reinforcement 
o Fabric Sheet (Sistema) 
o Fabric Wire (Sistema) 

 
Edición de una Malla de Refuerzo (Fabric Sheet) 
 
Tipo de Familia: Familia de Sistema 
 

1. Buscar en el Navegador de Proyectos, en el apartado de familias, la categoría 
Structural Fabric Reinforcement y desplegar las familias y tipos de “Fabric Sheet” 

con click en el ícono . 
2. Dar Click derecho en el tipo y seleccionar la opción Type Properties... 
3. En el cuadro de diálogo Propiedades de Tipo Duplicar el tipo y nombrar. 
4. Una vez Duplicado el tipo, modificar las propiedades: 

 

• Default Major / Minor Lap Splice Length: Especifica la longitud de traslape 
en la dirección correspondiente. 

• Major / Minor Direction Wire Type: Especifica el tipo de alambre en la 
dirección correspondiente. 

• Rounding Overrides: Especifica los parámetros de redondeo para el tipo de 
malla en edición.  
 
Nota: Este parámetro está disponible solo si se activó el redondeo del acero de 
refuerzo en el proyecto. 
 

• Material: Especifica el material de la malla de refuerzo. 

• Overall Length: Especifica la longitud total de la malla de refuerzo. 

• Length: Muestra la distancia entre el primer y último alambre. (Parámetro de 
lectura) 

• Major / Minor Start Overhang: Especifica la distancia desde el borde de la 
malla al primer alambre en la dirección correspondiente. 

• Major / Minor End Overhang: Especifica la distancia desde el borde de la 
malla al último alambre en la dirección correspondiente. 

• Major / Minor Layout Pattern: Especifica el tipo de distribución de los 
alambres en la dirección correspondiente: 

 
o Fixed Number: Especifica el número de alambres distribuidos 

uniformemente. 
o Maximum Spacing: Especifica una distancia máxima entre alambres, 

El número de alambres se ajusta para estar dentro de este parámetro. 
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o Number with Spacing: Especifica el número y distancia entre 

alambres. La distancia entre el borde y el último alambre se calcula de 
forma automática. 

o Actual Spacing: Especifica la distancia entre alambres. Se especifica 
la distancia entre el borde y el primer alambre, y la distancia entre el 
último alambre y el borde se calcula de forma automática. 

 

• Major / Minor Number of Wires: Especifica el número de alambres utilizados 
en la dirección correspondiente. 

• Overall Width: Especifica el ancho total de la malla de refuerzo. 

• Major / Minor Spacing: Especifica la distancia entre alambres. 
 

5. Una vez configuradas las propiedades de la malla de refuerzo hacer click en 
Aplicar y Ok para confirmar los cambios. 

 
Edición de un Alambre (Fabric Wire) 
 
Tipo de Familia: Familia de Sistema 
 

1. Buscar en el Navegador de Proyectos, en el apartado de familias, la categoría 
Structural Fabric Reinforcement y desplegar las familias y tipos de “Fabric Wire” 

con click en el ícono . 
2. Dar Click derecho en el tipo y seleccionar la opción Type Properties... 
3. En el cuadro de diálogo Propiedades de Tipo Duplicar el tipo y nombrar. 
4. Una vez Duplicado el tipo, modificar las propiedades: 

 

• Nominal Diameter: Especifica el diámetro del alambre. 

• Bend Diameter: Especifica el diámetro de doblez para el alambre. 
 

5. Una vez configuradas las propiedades del alambre hacer click en Aplicar y Ok para 
confirmar los cambios. 

 
Colocación de una Malla de Refuerzo (Fabric Sheet) 
 
La herramienta Fabric Sheet crea una malla de refuerzo en el elemento anfitrión. Cuando 
se coloca, la malla se aplica en la parte superior o inferior para losas y losas de 
cimentación, o interna o externa para muros. 
 
Para colocar una Malla de Refuerzo: 
 

1. Dirigirse a la Pestaña Structure →  Panel Reinfocement → Fabric Sheet  
2. En el área de dibujo posicionar el cursor sobre la superficie donde se colocará la 

malla. Cuando se coloca una malla de refuerzo se puede forzar el cursor a los 
siguientes puntos: 

 

• Recubrimiento del elemento anfitrión. 

• Bordes de otras mallas de refuerzo. 

• Posiciones de traslape de otras mallas de refuerzo. 

• Punto medio de otras mallas de refuerzo. 
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3. Especificar en la Paleta de Propiedades: 

 

• Location: Especifica la ubicación de la malla de refuerzo en el elemento 
anfitrión. (Superior o Inferior para losas y losas de cimentación; Interna o 
Externa para muros) 

• Additional Cover Offset: Muestra un recubrimiento adicional al del elemento 
anfitrión. 

• Cut by Host Cover: Activar la casilla para recortar la malla de refuerzo con el 
recubrimiento del elemento anfitrión. Esto incluye aberturas en el elemento. 
Desactivar la casilla si se desea que la malla se extienda más allá del 
recubrimiento y los bordes del elemento. 

• Rounding Overrides: Especifica los parámetros de redondeo para la malla 
seleccionada. 

 
Nota: Este parámetro está disponible solo si se activó el redondeo del acero de 
refuerzo en el proyecto. 
 

 
4. Hacer click para colocar la malla de refuerzo. 

 

 
 

5. Opcionalmente, ajustar el punto de origen de la malla de refuerzo; el punto de 
origen define el punto de colocación de la malla; se puede restringir a los bordes, 
puntos de traslape, puntos medios y líneas de referencia de la malla. Por defecto, 
el punto se encuentra en la esquina inferior izquierda. El punto se muestra con 
coordenadas X y del sistema de coordenadas local de la malla. 
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Para colocar una Malla de Refuerzo con doblez: 
 

1. Dirigirse a la Pestaña Structure →  Panel Reinfocement → Fabric Sheet  

2. Dirigirse a Pestaña Modify | Place Fabric Sheet → Panel Mode → Bend Sketch . 
3. Especificar un tipo de malla de refuerzo del Selector de Tipo. 
4. Seleccionar el elemento que alojará la malla de refuerzo. 
5. Elegir entre cualquiera de las líneas de boceto para definir el perfil a seguir para la 

malla. 
 

 
 

6. Especificar en la Paleta de Propiedades: 
 

• Bend Direction: Especifica el borde de la malla de refuerzo que se está 
dibujando (Major / Minor). 

• Longitudinal Cut Length: La longitud de la malla se cortará a la longitud 
especificada. Ej: 

 

 
 

 
 

7. Hacer click en Finish  para confirmar su colocación. 
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Colocación de Áreas de Malla de Refuerzo (Structural Fabric Area) 
 
Para colocar un Área de Malla de Refuerzo: 
 

1. Dirigirse a la Pestaña Structure →  Panel Reinfocement → Fabric Area  
2. En el área de dibujo seleccionar la losa, muro o losa de cimentación donde se 

colocará el área de malla de refuerzo. 
3. Dirigirse a Pestaña Modify | Create Fabric Boundary → Panel Draw → Boundary 

Line  y elegir entre cualquiera de las líneas de boceto para definir 
el contorno del área de malla de refuerzo. 

4. Especificar la dirección de la malla de refuerzo con la herramienta Major Direction 

. 
5. Seleccionar los controles de los bordes para determinar la alineación de la malla 

de refuerzo. Se debe seleccionar al menos dos controles contiguos para crear un 
diseño de distribución correcto. El diseño del área ajusta las mallas al límite del 
contorno, La malla se corta por el controno del boceto y aberturas en el elemento 
anfitrión. 

 

 
 

6. Especificar en la Paleta de Propiedades: 
 

• Fabric Sheet: Indica el tipo de malla de refuerzo. 

• Location: Especifica la cara donde se colocará el área de malla de 
refuerzo (Superior / Inferior para losas y losas de cimentación; Interna o 
Externa para muros). 
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• Lap Splice Position: especifica la posición de los empalmes en sentido 
mayor y menor del área de malla de refuerzo. 

 
o Aligned: Las mallas de refuerzo se distribuyen en filas y columnas. 

Todos los traslapes en ambas direcciones se encuentran alineados. 
 

 
 

o Major Half-way Stragger: Las mallas de refuerzo se distribuyen en 
filas, la fila subsecuente se desplaza a la mitad de la longitud de la 
malla de la fila anterior. 
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o Major Passing Stragger: Las mallas de refuerzo se distribuyen en 

filas, cada fila comienza con una malla de refuerzo completa en el 
lado izquierdo y derecho alternativamente, la última malla de 
refuerzo en cada extremo se corta al borde del contorno. 

 

 
 

o Minor Half-way Stagger: Las mallas de refuerzo se distribuyen en 
columnas, cada columna se desplaza a la mitad de la longitud de la 
malla de la columna anterior. 
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o Minor Passing Stagger: Las mallas de refuerzo se distribuyen en 

columnas, cada columna comienza con una malla de refuerzo 
completa en el lado superior e inferior alternativamente, la última 
malla de refuerzo en cada extremo se corta al borde del contorno. 

 

 
 

• Additional Cover Offset: Especifica un desplazamiento adicional al 
recubrimiento a la cara exterior de la malla de refuerzo. 

• Major /Minor Lap Splice Length: Especifica la distancia de traslape en el 
sentido correspondiente. La disponibilidad del parámetro depende de la 
alineación de las mallas de refuerzo dada por los controles de borde. 

 

7. Hacer click en Finish  para confirmar su colocación. 
 

 



210 
 

 
Consideraciones de las Herramientas de Refuerzo 
 

• Para la mayoría de los detalles de armado, establecer los recubrimientos debería 
ser uno de los primeros pasos. Mucho sobre cómo actúa y reacciona el armado a 
los cambios del modelo se basa principalmente en cómo el armado interactúa con 
el recubrimiento. 

• Es importante mencionar que el modelado del armado implica un trabajo 
estrechamente ligado con el área de ingeniería para poder generar un modelo con 
la capacidad de generar cronogramas para la construcción y planos para la 
colocación. 

• El modelado de armado en Revit proporciona una visión real sobre la colocación 
de este, por lo que requiere del conocimiento de los procesos constructivos. 

 

 

 


